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Introduction

It is a pleasure to present to you this new publication, which is a product of Project EENAT, and to have an opportunity to place the development of this publication into the overall perspective of this regional technology network which has developed and grown over the past five years.

Over the past decade it has become increasingly clear to all of us that developments in the field of information technology have, and will continue to have, profound impacts on the way we live and learn. For blind and visually impaired people, who have long struggled with the issue of "access to information,” these developments represent both new challenges and new opportunities.

In 1996, the Eastern European Network on Access Technology (Project EENAT) was created to address these challenges and to take advantage of new opportunities for blind and visually impaired persons within East and Central Europe and the Baltics.

For the countries of East and Central Europe and the Baltics, keeping pace with these new developments was, and continues to be, particularly important as the critical transition to a new "open market economy" is made. It is no secret that this market transition has had a particularly profound effect on blind and visually impaired persons as traditional employment options have closed. Therefore, it was obvious that if blind and visually impaired persons were going to compete in open market employment, new developments in information technology needed to be integrated into ongoing education, rehabilitation and employment training programs.

As these developments became more apparent to education and rehabilitation personnel, each country began in its own way to make efforts to take advantage of the power of technology. However, there was little or no communication or co-ordination between these individual efforts. As a result, in 1996 it was common to find in one location that individuals had grappled with and solved a technical problem, while just a short distance away others were struggling with the same issue. We knew that if somehow people facing common challenges and shared goals could be brought together, collectively they could achieve a great deal more.

This challenge coincided with the Overbrook School for the Blind's (Philadelphia, PA, USA) desire to build upon a network of individuals from East and Central Europe who had studied access technology at Overbrook's International Program and had returned to their countries with new ideas and an enthusiasm to share with others the liberating power of new technologies.

We were most fortunate at this same time to discover that The Open Society Institute (Soros Foundation) was concerned about the needs of disabled persons in East and Central Europe and the Baltics. Two persons in particular, Elizabeth Lorant and Noah Simmons, had the foresight to see how technology could improve education and employment opportunities for blind and visually impaired persons and were willing to commit resources to develop a program through which The Open Society Institute and the Overbrook School for the Blind would reach out to the countries of East and Central Europe and the Baltics to create what has become the Eastern European Network on Access Technology for Blind and Visually Impaired Persons (Project EENAT).

The goals of Project EENAT were quite simple and straightforward. We wanted to exploit the power of new technologies for the blind and visually impaired to expand education and employment opportunities in the region. The program was launched in 1996 and initially included the Czech Republic, Hungary, Lithuania, Poland and the Slovak Republic. The program was guided by a Project Advisory Group consisting of two representatives from each of the five countries involved, along with representatives of the Overbrook School for the Blind.

After collecting baseline data on the situation in each country the PAG established initial priorities, which included:

1. Increasing training opportunities at all levels,

2. Developing a mechanism to objectively assess existing technologies, and

3. Developing a system for sharing ideas and information among the five countries in the region.

Initially a great deal of attention was placed on national-level training programs. As the impact of these programs was felt there was increasing awareness of the need to focus more attention on regional-level training-of-trainer programs and on the development of appropriate training and public education materials. 

While the outcomes of the work of Project EENAT are the collective accomplishment of many individuals and organizations, the leadership roles assumed by Dr. Branislav Mamojka (Slovak Republic) in the area of training and evaluation and Mrs. Krisztina Kovacs (Hungary) in the area of materials development are truly exceptional.

In 1999, Project EENAT was expanded to include Estonia, Latvia and Romania and has become a vital network of individuals and organizations who share a common vision and common goals in finding ways to use access technology to improve the quality of life of blind and visually impaired children and adults.

This Publication grew out of a series of discussions within the Project Advisory Group. As the use of technology within the region expanded, it became clear that a practical handbook available in all local languages and designed to meet the needs of both teachers and parents was needed. This publication has been developed to meet the needs of teachers and parents who may have little or no experience in the use of access technology with blind children and adults. We have made a serious effort to make this publication as simple and practical as possible, and we hope that you will find it a valuable resource as you strive to help blind children and adults reach new levels of independence and to gain equal access to the wonders of the new Information Age.

We are deeply grateful to the contributing authors of this EENAT publication. The time, effort and commitment they have made to develop this resource very much exemplify the spirit of EENAT. By working together and sharing ideas and information freely we can all be more effective in our individual efforts to prepare blind children and adults with whom we work for the new education and employment opportunities of the 21st Century.

One final note with regard to exercises in Chapter 3a in this Handbook: some of the exercises are not available to the readers who did not participate in one of our regional training courses.  However, the content is still important and informative and I hope you will find it useful.

One final note with regard to exercises in Chapter 3a in this Handbook: some of the exercises are not available to the readers who did not participate in one of our regional training courses.  However, the content is still important and informative and I hope you will find it useful.

Lawrence F. Campbell

Project Director

Overbrook School for the Blind




        Preface
Dear Readers,

This book was born to help your child or student who is blind or visually impaired to learn, work and gain information more independently with the use of access technology. There are several questions which may arise when reading so many special expressions and terminology. Here, as a teacher of visually impaired and blind children, I would like to highlight the educational aspects of vision impairment and blindness with some general and basic explanations.

Definitions and Special Terminology

There are many expressions the authors have used in this book describing the population who have vision problems or referring to different kinds of visual functions.

Vision Impairment

Although there is some difference in the meaning of vision impairment in Europe and the U.S.A., we will use this term for those individuals who have some remaining vision, from light perception through the ability to recognize large objects, identify forms or read large print.

Blindness

Total blindness means no vision at all. In this case other senses, like hearing, touch, smell or taste, are used for accessing information. The main learning channel is the so-called audio-tactile or audio-haptic perception.

Low Vision

This expression is practically equivalent to visual impairment. Low vision has profound, severe and moderate forms. We use profound low vision if a person has light perception. He will use the techniques of blind people in learning but can use light sources as visual information in orientation and mobility.

Severe low vision means limited but measurable visual acuity which can be expressed by numbers. In this case the person has less than 0.1 visual acuity, which is 10 % of normal sight. Here we can see a variety of visual as well as audio-tactile techniques in learning. In many cases, people use a CCTV, large print, enlargement software, magnifiers or other optical aids for accessing written information.

Someone has moderate low vision if his visual acuity is better than 0.1 up to 0.3; thus he can see 10-30% of what those who have unimpaired vision can see.

Partial Sight

This term refers to moderate low vision.

Visual Acuity (vision, abbreviated by V)

This is the ability to tell particulars of objects, pictures and graphical symbols, like letters or numbers. The smaller the recognized object, and the larger the distance of recognition, the more perfect is visual acuity, and conversely. This means that someone with severe low vision can only see details of an object or different symbols from a rather short distance depending on the size of the object. Almost all kinds of vision impairment are caused by reduced visual acuity either for far distance or for short distance and sometimes for both (refractive errors like myopia, hypermetropia or astigmatism, aphakia, optic nerve atrophy and retinal degeneration, like degeneration of the macula).

Contrast Sensitivity

The greater the difference in colours that an object has compared to its surroundings, the sharper the image that can be seen. A light grey letter on a white paper has a low contrast, while a black one has a high contrast. Sometimes a better contrast can be developed when the surrounding is dark coloured (black, dark green or dark blue) and the symbol is light (white or yellow). Many eye diseases are accompanied by decreased contrast sensitivity (such as cataracts, opacities in different eye structures, optic nerve atrophy and retinal degeneration).

Visual Field

Normal visual field means that a person can see the objects in the surroundings at about 180 degrees vertically and horizontally with the periphery of both eyes. This function allows us to identify visual stimuli which are not focused directly and prevents us from falling into obstacles. If someone has peripheral visual field defects he will probably have problems in orientation and mobility. A high degree of visual field loss is called tunnel vision and can be understood as if someone were to look through a small hole. While tunnel vision is accompanied by a few eye diseases (such as retinitis pigmentosa), other field defects may be more common in visual impairment (such as glaucoma, optic nerve atrophy, partial retina detachment, retinopathy of prematurity, coloboma in the periphery of the retina). The quality of the central visual field is also very important in accomplishing closer visual tasks like reading. The central visual field can be defected by scotomas or blind spots. In this case some parts of a picture or a written word cannot be seen and the eye develops compensatory skills like excentric fixation and scanning. The different kinds of macular degenerations are the most common causes of central field loss.

Sensitivity to Light

The receptors of the retina can only work in light. In most cases a person with visual impairment needs higher luminance level than the average person, especially when accomplishing closer vision tasks. Better lighting conditions are also necessary for safe orientation and mobility, both inside and outside. There are causes of vision impairment which lead to hypersensitivity against too much light (glaucoma, inoperable central cataract, albinism, aniridia and some retina degenerations). In these cases the high illumination of the television, CCTV or computer monitor disturbs vision even as much as when the person is wearing photochromatic, absorptive or filter lenses cannot use the screen.

Colour Vision

If a person cannot identify colours properly or has problems differentiating only certain colours, he may have colour confusion or total colour blindness. This kind of impairment may affect the recognition of certain pictures or the reading text on a coloured surface.

How Do People with Visual Impairment and Blindness Access Information?

The method of accessing information depends on visual functioning. If a person can gain no information through vision (total blindness), he uses an audio-tactile method. With light perception and profound low vision he uses mainly audio-tactile and sometimes audio-visual techniques. With severe and moderate low vision or partial sight he uses mainly visual and sometimes audio-tactile techniques.

Audio-Tactile Techniques

A person who cannot see depends on his remaining senses. It is often said that blind people have good musical skills due to well-practiced hearing and listening skills. It is obvious that everyone can develop a special skill if he is forced to train it every day. For a blind child sounds, noises, music and speech will have more meaning and  will help conceptualization. His listening skills, hearing attention and auditive memory develop more efficiently as he practices them every day. The most convenient way of learning for him will be through his ears. Good auditive skills are also necessary during school years when the student can use tapes of recorded textbooks or speech synthesizers attached to a computer to read out digitalized texts.

Using his touch, a blind child can learn the shape, texture, pattern, structure, temperature, size, weight, and number of objects. Using his hands allows the blind child to compare different, similar and identical features of his surroundings. In this way, not only the sense of touch, but mental capacity as well, will develop. Reaching school age, a blind child is able to use his fingertips to touch small units. This is the way Braille dots are felt. Braille is the most common reading media for blind people. The Braille system consists of six small raised dots standing in two columns, two to a row. The different letters are represented by the combination of the dots.

Braille material can be produced by using a Braille table and stylus, a mechanical Braillewriter machine, an electrical Braillewriter machine or a computer with Braille embosser for printing or a Braille line as an output device substituting the monitor.
Combination of Audio-Tactile and Visual Techniques

A person who has light perception is able to use his remaining vision in orientation and mobility and will use audio-tactile techniques in reading and writing. If he has more but limited residual vision, a combination of both methods can be used for information access. In many cases, the person can differentiate shapes, forms or colours but cannot see details. He can use his vision in mathematics or geometry but cannot read letters or numbers, thus using Braille or recorded learning material. The computer will need to be equipped with either Braille line or speech output, or under ideal circumstances, with both.

Special Visual Techniques

If a person has useful vision but not enough for accomplishing visual tasks designed for full sight, then he has to learn special techniques to make maximum use of his vision and to compensate for his vision loss with other senses when needed. Generally, some profound, many severe, and most moderate low vision people are taught to read printed text and to write with the help of special lighting condition, including high contrast and magnification. The simplest method is when the text is magnified by optical aids (simple or more complex magnifiers or telescopic glasses) or by a photocopy machine using its enlarging feature. More sophisticated equipment is what is called a CCTV. This electrical reading machine has a monitor with optics and camera built in and a movable plate where the book should be placed. The camera with the optical lenses transfers the image (picture or text) to the monitor. The user can adjust the level of contrast, light and magnification (up to 36 times) according to his individual needs. The distance between the monitor and the plate allows the person to draw or write while checking his production, looking at the magnified image on the screen.

Access technology can also help people with low vision. There is special software to enlarge any image on the screen. After the text, picture, map or book is digitalized, it can be seen on the monitor in the desired size.

I hope you will find this publication useful either as a parent, a teacher or a consumer. We wanted to show that a person with visual impairment or blindness must not be restricted in accessing information, studying and working independently. The question is not focused on what a visually impaired child or adult should be learning, since we truly believe that they should be taught the same material as their sighted peers. All our success depends on how we teach and what technology we use to meet the individual needs of all people with visual impairment and blindness. Technology barriers can be overcome through the right training.

Krisztina Kovács

Co-ordinator of Project EENAT

ELTE University, Bárczi Gusztáv Faculty

of Special Education Budapest, Hungary

Module 1: General Information about the Use of Computers

(For: Parents and Teachers of Visually Impaired Pupils at Mainstream Schools)

(Annelies Feelders and Maria Noyons)

Introduction

It is hard to imagine modern society without computers. In schools they have almost become a part of daily life. For visually impaired pupils the computer is, if adapted in the right way, a great help in written communication and in access to information.

A visually impaired pupil who cannot read (his own) hand-written text might be able to read an enlarged type of letter on a computer screen. If a pupil learns to touchtype quickly, his typing may be quicker than the writing of others. A blind pupil, for whom the tests always have to be translated into Braille, now can read (hear) his test on the computer and correct his mistakes.

If a visually handicapped person is skillful in using the computer, this will benefit him all his life. During his studies, during his work, the computer can always be a very suitable means for independent (written) communication and for obtaining information. 

To teach a visually handicapped pupil to use the computer is an important task. It becomes a basis for success in his future. This module is intended to give parents and teachers a helping hand in supporting this learning process. 

The following topics will be described in this module:

1. Basic principles in using the computer: What is important when you place a computer in your classroom? What is the right position when working with the computer?

2. What can you expect when a visually impaired pupil is working with the computer? What do you see?

3. What does the visually impaired pupil need?

4. Simple solutions

5. Examples of special devices

General advice: “Parents and teachers: keep your hands on your back!”

Supporting and teaching visually handicapped pupils is a special skill. Best support is given with the hands on the back, that is, without the teacher touching the keyboard or mouse! This means that the pupil holds on to the “wheel” (i.e., the mouse and keyboard) and steers it according to instructions, or better: according to the teacher’s questions. This is an important starting-point, because a visually impaired pupil lacks an overview of the computer screen. He has to achieve this after instructions of the teacher. Always help the pupil verbally and let him execute the actions. Avoid the statement “ I will do it for you quickly,” but teach the pupil to get insight and to act adequately. It is important that the pupil always:

Gets an overview of the whole screen, because the overview always gets lost when using devices

Gets insight into cause and effect

Gets insight into his personal needs, such as “I need a dark background, a big mouse arrow, and no light reflecting onto the screen.”

1. Basic Principles and Ergonomics
In this chapter you will find a description of the optimal position of the computer and the person working with it. The important aspects are: light, height and repetitive strain of joints.

How Do You Place a Computer?

Keyboard, mouse, speakers and a screen are usually placed on a table. The screen should be placed at the height of the eye, so often you will find it on a stand or a swivel arm.

Reflections of Light on the Screen Should Be Avoided. 

You can see this best when the screen is turned off. If you see light from outside or from a lamp, then there is reflection. In this case there is less contrast and the screen gets dimmer and, consequently, less readable. So be aware of light from outside as well as from inside. Sometimes you can simply remove one neon lamp which is above the screen without putting the whole classroom in the dark. Or you can turn the screen a quarter turn or use curtains.

The computer usually stands on the table, next to the screen or the speakers. This way, you can easily reach the On/Off button, the disk drive and the CD-ROM player.

The printer and scanner are usually found at a short distance and are sometimes being shared by other computers.

From the computer several electrical wires go to the screen, keyboard, mouse, printer, scanner and electric point. Safety is first: see that no one is going to stumble over them. 

Which Is a Good Position to Work with the Computer?

A good position is when the back is straight and supported by a backrest. The shoulders are relaxed and the upper arms are hanging alongside the body. The angle between upper and lower arm is approximately 90°. The wrists should be suspended in a neutral position or be supported by a special soft wrist support. Usually the sitting height is adapted to the height of the table (if you can change the height of the chair). The angle between upper-and lower leg is 90°. A footstool is needed in many cases and can be easily improvised.

Distance from the screen should be 35-50-cm. The mouse is on the right (or on the left, for left-handed people) on a mouse mat which is usually square and corresponds to the dimensions of the screen. 

The ball of the thumb rests on the back of the mouse and three fingers (index, middle and third) are placed loosely on the mouse buttons. The mouse is held by the thumb and little finger, and is  moved on the mat.

It would be very good if the chair in front of the table has adjustable height.

All these indications can be used to consciously consider a good working position, see picture below.
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Which Discomforts Can Arise When You Get Overburdened by Repetitive Strain?

One can easily work too long with the computer. This is the pitfall for chronic pain to the joints. These symptoms can arise due to a tensed position and repetitive movements like: clicking with the mouse or typing for several consecutive hours. In general the advice is to interrupt working with the computer regularly by taking short breaks or doing other kinds of work. There are several small programmes that can warn you in time.

Exercise

See if the computer you are working with is in a position as described above.
What about the incidence of light? What about safety? Can you adjust the height of your chair? Is the screen at the height of your eye?

Take a position that suits you best.

2. Visually Impaired and Blind Pupils
2.1 Visually Impaired Pupils

A good working position is extremely important for visually impaired pupils.

As already mentioned, reflecting light can influence the readability of the screen. 

Because of their visual impairments, visually impaired pupils have the tendency to sit bent over at a very short distance from the screen This position creates tension in neck and shoulders and, in the end, problems in the joints.

When we ask for a good working position there are two necessary conditions: the screen should be adapted and the pupil should know touchtyping. If this is not the case, we cannot ask a pupil to keep the right distance from the screen. It is logical that the pupil will stay at a very short distance if he cannot read the screen or the letters on the keyboard. 

A good observation and interpretation of what you see will give you indications for your lessons. In this section we assist you in what you can expect to happen and how you can meet the needs of the pupil.

How are your visually impaired pupils seated behind the computer? You can keep in mind any pupil and check how the situation is, according to the basic principles as described in the Appendix. 

Distance from  the Screen

Your distance from the screen should be between 35 and 50-cm. This distance can be influenced by several factors, of which the most important are:

Type and size of font. You can choose different types and sizes. In general a font without serif, like Univers or Arial, is best. You can get the idea of a good font for an individual pupil by having him read any text in several types and sizes.

Influence of glasses. Another aspect which is often underestimated is the effect of glasses on the reading distance. Reading glasses usually are adjusted to a reading distance of 25-cm. This is a normal distance for reading a book or magazine. Other distances give a less sharp image. A pupil who constantly keeps a 25-cm distance could be wearing reading glasses for that distance. The size of the font does not have any major effect on the distance to the screen. Sometimes there is a better result without the glasses or with glasses especially adapted for the computer screen, depending on individual needs. 

If the pupil is reading “with his nose on the screen” or reading very slowly, it can mean several things. It could mean that he is used to working in this position, even if he should be at a greater distance. It might be advisable to get a consultation at your local advice centre for special devices for visually impaired pupils or from the itinerant teacher. These special devices offer many possibilities to work with the computer with less strain.

Typing Skills

The better a pupil can touchtype, the better his working position can get.

Maybe a pupil has learned touchtyping on a mechanical or electric typewriter and switched afterwards to the computer keyboard. This switch does not have too many consequences for typing letters and digits. Simply typing usually gives no problems. The pupil only has to learn the extra computer keys.

Touchtyping is the basis for all computer work; even though it is not very interesting to practice, it is extremely important and there should be a big emphasis on this practice.

Using Mouse or Keyboard?

With the introduction of Windows the use of the mouse has increased enormously.

On the screen you find icons with text to which you can point with the mouse and click to perform an action. But using the mouse is not the only way. You can also use the keyboard.

For most visually impaired pupils it is advisable to learn to use the keyboard, because it is a very sure way to get where you want and to perform all actions. If you have learned touchtyping, it is also quicker than working with the mouse.

Reference to the List of Keyboard Commands

The speed of the movements of the mouse and the size of the mouse cursor are often reasons to reduce the use of the mouse by visually impaired persons, though through the software of the mouse some adaptations can be made. The mouse can be adjusted in some cases to make large movements on the screen, though this should be seen as a way for orientation on the screen.

The teacher almost never uses the mouse during instruction. To understand this you should first get insight into the general use of the mouse. You see an icon on the screen and keep looking at it. Then you move the mouse into your visual field to the icon at which you are still looking. Once icon and mouse are together, you click. Since you have to wait for the action to be performed, you take away the mouse, away from your visual field, and you overlook the changing of the screen.

But as a spectator, the  pupil looks in a different way. He will try to follow the mouse action until it stops. However, when the mouse seems to be still, there already has been a click, the mouse is moved again and the screen changes. Somewhere out of the blue the mouse appears and the spectator wonders what he has seen. That is why one should avoid using the mouse during instruction and support every action very carefully with verbal information. (i.e., now go to the upper tool bar and the icon of the printer, point to the printer and click with the left mouse button, the dialogue box has appeared now on the screen, etc.)

Light and Reflection

In the section on basic principles and ergonomics we talked about incidence of light and reflection of light onto the screen. You will have to adapt these basic principles in creating a working place for your pupils. There is more to it. Light plays an important role in visibility, and not always the same role: where one pupil asks for more, the other might want a lot less.

The light (brightness and contrast) of the screen itself can also be problematic. Usually there is a solution by making adjustments with the buttons on the screen itself.

It is important for the teacher to realize that the needs of the pupils are very individually defined. Sometime a pupil is not aware of the circumstances in which he sees best. The teacher can support him in getting this insight. For some eye diseases there are general guidelines (no laws!) for enlargement and light. You will find examples at the end of this module.

REFERENCE:

Combining the Reading of Printed/Written Text and Working with the Computer

Often pupils have to read text from books and use the computer at the same time to do their exercises. If possible put the books at the same height as the computer screen, so the pupil does not have to bend over all the time to read. Usually the distance cannot be the same, because the printed letters are smaller than the letters on the screen. Sometimes a pupil will need a reading lamp for reading the printed text. In this case, see that the light does not reflect onto the computer screen. 
If a pupil needs a CCTV, the two screens can be combined into one by using the computer screen for the CCTV as well, at the same time (“split screen”) or alternating. 
This system also has some disadvantages, such as: 
If you combine the two systems you lose even more overview than you did already by using a CCTV
The camera of this type of CCTV does not provide the quality of the black and white contrast (needed for reading text) that a separate CCTV does (at the moment of writing this module). 
Please inform your local information centre or itinerant teacher.
2.2 Blind pupils

The working position of a blind pupil with the computer often is better and more relaxed than that of a visually impaired pupil, because there is no need to bend over the screen or keyboard. 

When looking at blind pupils who are working with an adapted computer (speech) you might notice that they “look with their ears”: often their head is bent or turned over. A good observation of the position of the blind pupil will indicate the place of the speech synthesizer. When the desk or table is cramped, you can try to put the synthesizer in a different place.

Typing skills are as important for the blind pupil as for visually impaired pupils.

The blind pupil does not use the screen, but it is very useful for the teacher when giving instruction. With blind pupils it is even more important that the teacher “keeps his hands on his back” and only gives verbal instruction.
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3. Computer
If you are thinking of buying a computer it is advisable to take into consideration the following:

Your pupil’s present or future needs might have an effect on the kind of video card, sound card, and number of free slots the computer must contain. For example, some enlargement programmes require a specific video card.

Any exact advice given at this place will be outdated the moment you read this, so you may turn to your local professional organization for up-to-date information.

For a visually impaired pupil the quality of the monitor is very important, because a good monitor can save a lot of energy! So it might be worth investing in a good screen.

Important aspects to consider concerning the monitor:

- Size: 15, 17 or even larger. But if the pupil has a restricted field of vision, larger does not automatically mean better!

- Radiation: Since the visually impaired pupils tend to sit close to the screen, it is good to note that all monitors you can buy now meet the highest standards for safety.

- Frequency: The higher the frequency (Hertz), the more stable and still the image on the screen. This means that looking at the screen is less tiring at a 100-Hertz screen than at a 50-Hertz. This can be very important, especially for those who have difficulties focusing. 

- Possibile means to adjust the contrast and brightness. These must be extensive. It is important to take time to try all of this out!

Of course the screen is not important for a blind pupil. The screen is only used by the teacher, so a black and white one will do. You can save on that and spend the extra money, for instance, on  a better soundcard. 

Now you will find a list of tips to adapt the appearance of the screen, the mouse pointer and the fonts of texts, which you can make in Windows 95 and higher:

Adaptation of the colours. In Windows 95, 98 and 2000 you can change the appearance of the screen completely for every pupil. This is one of the first and most important things to do.
Go to: startbutton ( settings ( screen setting ( display ( appearance ( scheme: for example, you set the text at high contrast, Windows standard large. Here you can change colours, foreground and background, fonts, size of the menu bars, icons and many more items. You can save the scheme for every pupil individually. Every individual will have his own preferences; this becomes logical when you think of the fact that in general yellow/blue gives a bright contrast, but for someone with a certain type of colour-blindness this combination is very poor. Instead, he might need black/white!
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Adaptation of the font in the text.  In programmes like Word it is easy to change the font. Go to layout ( fonts and choose a font sanserif, like Univers or Arial, and choose the desired size. Teach the pupil how to do this independently and how to adapt texts which are written in another size or font. (control-a to select the whole text, and change the font.) A very quick way to enlarge the font of an already written text is to select the text (control-a for the whole text; 1 x F8 for one sentence, 2 x F8 for one paragraph, 3 x F8 for the whole text) and enlarge the font by pressing Control-> (which means Control-Shift- . )

this is Arial 12 
 this is Arial 16
Adaptation of the appearance of the program you’re working with to achieve as much room for the text as possible. Tidy up the screen!

- Always maximize for maximum size

- When you use keystrokes you don’t need a toolbar with icons or a layout toolbar

- Most of the time you do not use the ruler so you can remove it

- Use normal image (no page or oversight)

- Use the zoom function

This is the image of the screen when a number of toolbars are ON and there has been no adaptation of the appearance, and the document is not maximized:
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And this is an example of how you can adapt the screen:
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Adaptation of the mouse pointer. Usually the software of the mouse contains options to choose the size and contrast of the mouse pointer. Go to startbutton ( settings ( screen setting ( mouse ( cursor/pointer and choose a large size and contrast.

Accessibility: In Windows a special program for disabled people can be found. For visually impaired pupils some parts can be useful, like the high contrast scheme and (limited) enlargement possibilities.

[image: image6.wmf]
Using keystrokes instead of the mouse: practically everything can be done using the keyboard: starting and closing programmes and documents, changing settings, and layout of texts. For most visually impaired persons this method is a lot quicker and more secure. Keystrokes can be found in every handbook concerning computer programmes. Reference to the list

4. Special Devices
As you will know, nothing changes as quickly as the world of computers and computer programmes. This is also true for special devices for visually impaired and blind persons that are being developed, although the devices are always somewhat behind.

We can distinguish several categories of devices:

Enlargement programmes: These programmes work with all other programmes. They all have different features, but they all enlarge the image from 2 - 30 times. This means that you will lose the overview, because you no longer see the whole content of the screen. When using 2x enlargement you only see ¼ of the screen.

Enlargement programmes combined with synthesized speech: When using a big enlargement it can be very tiring to read long texts, and using Windows can be confusing. Being supported by speech can be very helpful. When using 6x enlargement you see only 1/64 part of the screen.

Speech: When reading is impossible or too tiring there are products called screen reader programmes that, in combination with a synthesizer, read everything that is to be seen on the screen. It speaks when you use the keyboard, it reads the menu, the content of a dialogue-box, the text you typed and it can echo when you’re typing. The synthesizer can be hardware (see picture) or software (soundcard) and adapted to all languages.
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Braille display and speech. With this device you can read in Braille the contents of the screen, while at the same time the speech can help you in navigating on the screen or reading long texts. With this characteristic of Braille you can read and correct precisely, while the speech gives you general and quick information. In Windows this combination is important for those who use Braille. Unfortunately it is the most expensive solution.
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A flatbed scanner can also be a useful device. It makes typed or printed text electronically available. Texts can be sent immediately into a programme like Word. Then they can be read by using appropriate devices or be printed in the correct font. Special OCR (optical character recognition) is not always needed, because usually you can choose the type of output you want. Therefore you can choose the option “text only” for the blind, or the “graphics” as well for the visually impaired pupil.


[image: image9.wmf]
Appendix 1: Eye Diseases, Main Characteristics, and the Effect on Using the Computer

Here you will find a list of eye diseases which occur quite frequently and the effect they have when using the computer. Does a pupil need more light or less? Is it likely that he needs enlargement or not? Of course this list cannot be used as a recipe;  consider it as just a guideline.

Every child has his own personal needs, and every child, even when suffering from the same eye disease, needs individual assessment.

Ablatio retinae 
What is it?


The retina tears loose

Symptoms:
Loss of visual fields, loss of visual acuity, metamorphopsia

Practical Consequences:

Enlargement:

+

Contrast: 


++

Illumination:

Moderate

Achromatopsia

What is it?


Congenital colour-blindness

Symptoms:
Impairment of colour discrimination, loss of visual acuity, nystagmus, photophobia

Practical Consequences:

Enlargement:

+

Contrast:


++

Illumination:

--

Albinism
What is it?


Absence of pigment 

Symptoms:


Loss of visual acuity, nystagmus, photophobia

Practical Consequences:

Enlargement:

+/-

Contrast:


+

Illumination:

--

Aniridia

What is it?


Whole or part absence of the iris

Symptoms:
Loss of visual acuity, nystagmus, photophobia, visual fields can be affected, myopia

Practical Consequences:

Enlargement:

+

Contrast:


+

Illumination:

-

Cataract
What is it?


Turbidity of the lens

Symptoms:


Blurred image, scattered light

Practical Consequences:

Enlargement:

+

Contrast:


++

Illumination:

No direct light

Diabetic Retinopathia

What is it?


Local widening or bleeding of capillaries in the retina,

Symptoms


Restriction of visual acuity and visual field (scotoma),




metamorphopsia, possible frequent changes in vision
Practical Consequences:

Enlargement:

+

Contrast:


+

Illumination:

Evenly spread

Glaucoma

What is it?


Raised intra-ocular pressure

Symptoms:


Restriction of visual field and visual acuity, sensitive to light

Practical Consequences:

Enlargement:

+

Contrast:


+

Illumination:

-

Macular Degeneration

What is it?


Degeneration  of the macula lutea
Symptoms:


Restriction of visual acuity and central visual field, 




impairment of colour discrimination

Practical Consequences:

Enlargement:

+

Contrast:


+

Illumination:

Evenly spread

Nervus Opticus Atrophia
What is it?


Degeneration of the optic nerve

Symptoms:


See macular degeneration

Practical Consequences:


Enlargement:

+

Contrast:


+

Illumination:

Evenly spread

Nystagmus
What is it?


Constant involuntary movement of the eye

Symptoms:


Movements of the eyes with difficulty focusing

Practical Consequences:

Enlargement:

+/-

Contrast:


+/-

Illumination:

No direct light

Myopia gravior
What is it?


Extreme short-sightedness with retinal complications


Symptoms:


Loss of visual acuity, short looking distance

Practical Consequences:

Enlargement:

+

Contrast:


+

Illumination:

+

Retinitis pigmentosa

What is it?


Degeneration of several layers of the retina, usually starting 




at the outside of the retina

Symptoms:


Progressive loss of visual field, night-blindness, photophobia

Practical Consequences:

Enlargement:

+/-

Contrast:


+

Illumination:

Evenly spread, soft

Appendix 2: Case Study of a Visually Impaired Child

Situation
Jan was born with albinism in 1990. From 1990 - 1992 his parents are in contact with the regional centre for early intervention; they receive advice and support. From 1992 - 1994 Jan frequents a rehabilitation-playschool, where they work on social and motor development and daily living skills. Jan shows no retardation, but for him it is important to learn to feel safe in a group of children and to undergo lots of visual stimulation. Since 1994 he has attended a mainstream kindergarten and primary school.

Visual Functioning

Vision  ODS 1/12, nystagmus, photophobia, iris diaphania.

Jan wears glasses +6,5 and cylinder, he uses a reading glass with 16 dpt (3-4x enlargement)

Despite photophobia, Jan reads best with 700 lux. 

School

At school he uses a lamp which is attached to his table. His table can be placed on a slant, so when he reads at a short distance his working position is better than with a normal table. 

When Jan began writing, it appeared that his writing was too slow and that he had difficulty reading his own handwriting. It was all too tiring for him.

In 1998 it was decided that Jan should start to learn touchtyping, as preparation for future use of the computer. In the future Jan would need to write and read more and more at school and at home, doing his homework. If he could use a computer, being able to touchtype quickly, and being able to read the screen, many of his problems would be solved. Jan is very interested in working and playing with the computer.

Jan went with the itinerant teacher to a regional centre for assessment. The conclusion was that he would have to work at school and at home with a computer with 17- inch monitor and an enlargement programme. Jan can read an Arial 20 letter in texts. For reading menus and dialog boxes he needs 3 x enlargement by a special programme on a 17-inch screen. On a 15-inch screen he needs 4 x enlargement, which means even more loss of overview. A 21- inch screen is too large for him.

Current Situation(1999)

At school and at home there is a computer, as described above, which Jan uses for doing his written exercises. The computer is placed in a small room which is attached to the classroom. His books are enlarged by photocopying and he puts them on a reading standard. He is able to touchtype quickly. He can read what he has written without too much strain.

In class he sits close to the blackboard and he walks to the blackboard if he cannot read it.

Jan does not mind being an exception in his class. He likes working with the computer.

His problems with reading and writing have been resolved.

Appendix 3
T_KeyCom.txt

T. Keyboard Commands

This is a compilation of the keyboard commands described in the Guide. Please note that although every effort has gone into ensuring the accuracy of these commands, there may be some inconsistencies, especially with later releases of Windows 95. There are general Windows commands, but different Windows applications (e.g. Word) often have their own shortcut commands, and it is worth investigating the shortcuts in your favourite applications.

Commands written as, for example, Ctrl + Esc, indicate that you press the keys together. Commands with a comma between terms indicate that you must choose these commands or menu items one after the other. Exceptions to these rules are described where relevant.

The commands are grouped into main headings with an indication of where the topic is described in the Guide:

T 1: Desktop,

T 2: Menus,

T 3: Control Menu,

T 4: Context Menu,

T 5: Taskbar, 

T 6: The Start Menu,

T 7: Application Windows,

T 8: Changing to Another Running Application,

T 9: Document Windows,

T 10: Dialog Boxes,

T 11: My Computer and Explorer,

T 12: Recycle Bin,

T 13: Running DOS From Windows 95,

T 14: Running DOS From Outside Windows 95,

T 15: Control Panel,

T 16: Accessibility Options,

T 17: Help,

T 18: Clipboard.

T 1: Desktop (see Section D 4)

Find Shortcut Icon on Desktop:

Ctrl + Esc to open Start menu, Esc to cancel it, leaving focus on Start button. Shift + Tab to move focus backwards to icons on Desktop. Arrow keys move highlight around these icons in order of location on the screen, or press initial of item required to toggle between items starting with this letter. Pressing the first two letters of the item quickly takes the highlight directly to that item.

Create a Shortcut Icon on Desktop:

First find the item to shortcut to, then Shift + F10 to open its Context menu, then S for Create Shortcut. Choose Y for Yes when asked if you want to create it on the Desktop.

Rename a Shortcut Icon on Desktop:

Highlight icon, press F2 to activate insertion point at end of highlighted filename, press Return to save in a new name. Or highlight icon and press Shift + F10 to open its Context menu, then M for Rename. Then type new name and press Return to save new name.

Assign Shortcut Key to Shortcut on Desktop:

Find and highlight the shortcut icon. Alt + Enter to get Properties Sheet. Ctrl + Tab for Shortcut section. Alt + K or Tab twice to Shortcut Key editfield. Press the keys you desire for shortcut and press Return for OK. Must use Ctrl or Alt or both, and can use Shift too, but must also have one letter. If you just press a letter, you will get the default shortcut using that letter with Ctrl + Alt. Use Delete or Backspace to delete contents of editfield or to delete a shortcut key.

Delete a Shortcut Icon on Desktop:

Highlight icon, then press Delete key. Answer Y for Yes to send to Recycle Bin. You may also start from icon's Context menu (Shift + F10), and press D for Delete. Note that you cannot delete certain shortcut icons on the Desktop, such as the Recycle Bin, and My Computer.

T 2: Menus (see Section E)

Accessing Menu Bar:

Alt key, or F10 brings focus (highlight) to first menu bar item. Or use the item's shortcut key (e.g. Alt + F for File) which opens its pull-down menu immediately.

Moving Along Menu Bar:

Left and right arrow keys or shortcut keys to move highlight along menu bar.

Opening Pull-Down Menu:

Down arrow key, or Return when menu bar item is highlighted. Or, use shortcut key (e.g. Alt + H for Help) which opens the pull-down menu immediately.

Selecting an Item from a Pull-Down Menu:

Down and Up arrow keys to move highlight in pull-down menu, then Return to select item, or Return or right arrow to open cascading menu.

Cascading Menus:

Right arrow key or Return to open, left arrow key or Esc to cancel the cascading menu level.

Cancelling Menu Activation:

Esc to cancel each level of menu activation, Alt to cancel all menu activation.

T 3: Control Menu (see Section E 7)

Opening Control Menu of Application Window:

Alt + Spacebar.

Opening Control Menu of Document Window:

Alt + Hyphen.

Selecting an Item from Control Menu:

Use arrow keys and Return or shortcut key.

T 4: Context Menu (see Section E 8)

Opening Context Menu of an Object:

Shift + F10 when item has focus. Options specific to the object. On the 104 key keyboard, the Context Menu key is the third key to the right of the spacebar.

Selecting an Item from the Context Menu:

Pull-down menu, use arrow keys and return, or shortcuts.

T 5: Taskbar (see Section F)

Bring Focus to Taskbar:

Ctrl + Esc to open Start Menu, Esc to close it, leaving focus on Start button, then Tab to move focus to application buttons on Taskbar.

Switching to Another Application:

First find application button you want, using left and right arrow keys to move focus between application buttons on Taskbar. Press Spacebar or Return to switch to that application. See also Switch To, and Task Cycle, Section T 8.

Control Menu of Taskbar:

Alt + Spacebar. Once Taskbar has focus, you can change size, position, etc. of Taskbar.

Context Menu of Taskbar:

Shift + F10. Once Taskbar has focus, you can change time and date, cascading and tiling windows on the screen, minimising all windows, and altering Taskbar properties.

Minimise all Windows to Their Buttons on Taskbar:
Alt + M, once Taskbar has focus, or from the Taskbar's Context Menu and choose M for Minimise All Windows.

Application Buttons on Taskbar:

Ctrl + Esc to open Start Menu, Esc to cancel, Tab focus to application buttons, then arrow keys to each application button in turn. Press Spacebar or Return to activate the application window.

T 6: The Start Menu (see Section G)

Open Start Menu from Any Application:

Ctrl + Esc, or on the 104 key keyboard use the Windows key, the second key to the right of the spacebar.

Select Items in Start Menu:

Up and Down arrow cursor keys move highlight up and down menu items, then Return to select, or right arrow key to open cascading menu from an item. Or use shortcut letters: P = Programs, D = Document, S = Settings, F = Find, H = Help, R = Run, U = Shutdown, which selects/opens cascading immediately.

Add Shortcut to Start Menu:

Start, Settings, Taskbar, Start Menu Programs, Add. A more advanced way to do this is to open the Start Menu (Ctrl + Esc), close it with Esc, then open its Context Menu with Shift + F10. Press O for Open, and then choose Alt + F for File, New, Shortcut. Then choose Add and continue as normal.

Assign Shortcut Key to Shortcut on Start Menu:

Use Explorer and highlight the shortcut icon. Alt + Enter to get Properties Sheet. Ctrl + Tab for Shortcut section. Alt + K or Tab twice to Shortcut Key editfield. Press keys you desire for shortcut and press Return for OK. Must use Ctrl or Alt or both, and can use Shift too, but must also have one letter. Delete contents of editfield to delete shortcut key.

Remove Shortcut from Start Menu:

Start, Settings, Taskbar, Start Menu Programs, Remove.

Close Start Menu:

Esc leaves focus on Start button. Tab to move focus onto application buttons on Taskbar.

T 7: Application Windows (see Section H 6)

Application Window Control Menu:

Alt + Spacebar, for maximising (X), minimising (N), restoring (R), moving (M), sizing (S) and closing (C) the application window.

Select All:

Ctrl + A.

Close the Application Window:

Alt + F4, or Close from Control menu.

Close an Application Which Has Crashed:

Ctrl + Alt + Delete. Opens list of running applications, use up and down arrow keys and Return to select the application to close. Leaves all other applications running.

T 8: Changing To Another Running Application (see Section H 6.1)

Switch To Command:

Alt + Tab, hold Alt down and press Tab to view each application you have running in turn. Release both keys to make the application active.

Task Cycle Command:

Alt + Esc switches between the currently running applications with each command press, making each one active with each command press.

Application Buttons on Taskbar:

Ctrl + Esc to open Start Menu, Esc to cancel, Tab focus to application buttons, then arrow keys to each application button in turn. Press Spacebar or Return to activate the application window.

T 9: Document Windows (see Section H 7)

Document Window Control Menu:

Alt + Hyphen, for maximising (X), minimising (N), restoring (R), moving (M), sizing (S) and closing (C) the document window.

Select All:

Ctrl + A.

Change to Another Document Window in the Same Application:

Ctrl + F6, or use the Window listing in the application (often Alt + W).

Closing the Document Window:

Ctrl + F4, or Close from Control menu.

T 10: Dialog Boxes (see Section I)

General Use:

Tab to move from current Tab section divider, through elements in box. Shift + Tab to go backwards. Ctrl + Tab changes the Tab section divider. OK (Return) applies all your changes and closes the box (unless in a directory listbox, where Return changes the directory). Cancel (Esc) ignores your changes and closes the box. Apply executes your changes, keeping the box open. Shortcuts like Alt + S take the focus to the element, or make changes to the element.

Properties Dialog Box:

Open using shortcut Alt + Enter when object has focus. Or from the object's Context Menu (Shift + F10), then R for Properties.

Query Icon:
F1 when element has focus, or from the element's Context Menu (Shift + F10, and choose 'What's This?'). Esc to clear the description box.

Pushbuttons:
Return or Spacebar when it has focus. Or shortcuts: OK = Return, Cancel = Esc, Help = Alt + H, Apply = Alt + A.

Checkboxes:

Spacebar to toggle on or off, when it has focus. Or Shortcuts to toggle immediately.

Radiobuttons:

When the group of radiobuttons has focus, use the up and down arrow keys to move selection from one to the other. Or use the shortcut which changes the selection immediately.

Editfields:

Highlighted text can be overwritten when the editfield has the focus. Move insertion point with arrow cursor keys. Home, End, PgUp etc. used in large editfields.

Highlighting / Selecting Text in Editfields:

Select text by holding shift and moving over text with arrow keys. Release Shift key when you reach the end of your text and it will be highlighted. Or use Shift + Home, or End to highlight all text. Add Ctrl to these combinations (Ctrl + Shift + Home, or Ctrl + Shift + End) to highlight whole documents, or many lines of text in an editfield in dialog box.

Listboxes:

Up and down arrow cursor keys or press initial letter (or letters) to move highlight in list when has it has focus, then leave highlighted. To change directory, press Return. In other lists, use Shift + arrows or Home, End, Page Up and Down to select blocks of items. In other listboxes hold Ctrl key down, use arrow keys to move focus, then Spacebar to select multiple items.

Comboboxes:

As listboxes and editfields when in focus. Tab to move between them.

Sliders:

For horizontal sliders, use left and right arrow cursor keys when in focus. For vertical sliders, use up and down arrow cursor keys.

Spinners:

Tab to parts of the setting (e.g. hour, minute, and seconds of time). Use up and down arrow keys to increase and decrease each value or just type in the desired value.

T 11: My Computer and Explorer (see Section J)

Move Focus to Other Areas of Window:

Tab or F6.

Open Listbox of Drives and Folders:

F4.

Move between List of Items:

Up and Down arrow keys, or press initial of desired item, or type first few letters of item very quickly.

Expand to View Sub-Folder:

Right arrow key.

Contract to Hide Sub-Folders:

Left arrow key.

View Contents of Folder:
Return.

Refresh Window Contents:

F5.

Move Up a Level to the Parent Folder:

Backspace.

Rename an Item:

F2 to edit the name of the selected folder or file. Also possible using Alt + F for File, then R for Rename.

View Properties of Item:

Alt + F to open the File menu, then R for Properties.

Delete an Item:

Delete sends item to Recycle Bin. Shift + Delete deletes permanently.

Making Shortcuts:

Copy desired item (Ctrl + C), find desired destination, and Paste Shortcut, Alt + E for Edit, then S for Paste Shortcut.

T 12: Recycle Bin (see Section K)

Move Focus to Other Areas of Window:

Tab or F6.

Move between List of Items:

Up and Down arrow keys.

Restore an Item:

Alt + F for File menu, then E for Restore.

Empty Recycle Bin:

Alt + F for File menu, then B for Empty Bin. 

T 13: Running DOS from Windows 95 (see Section L)

Opening a DOS-Prompt:

From Start menu (Ctrl + Esc), then P for Programs, and choose MS-DOS Prompt.

Toggle Full-Screen and Smaller Window:

Alt + Enter.

Quit DOS to Return to Windows 95:

Type exit and press Return at the prompt.

To Switch between DOS and Other Running Applications:

Switch To command (hold Alt and press Tab), or Task Cycle command (Alt + Esc), or use application buttons on Taskbar.

T 14: Running DOS from outside Windows 95 (see Section M)

Open Set-up Menu during Boot-Up:

F8 just after computer checks floppy drive and beeps. Or set up MSDOS.SYS to contain the line Bootmenu=1.

Different Options on Set-up Menu and Their Shortcuts:

F5: loads Windows 95 with its most generic default settings; that is, it does not load peripherals or network drivers.

Alt + F5 starts the Command Prompt Only - starts DOS 7 (the Windows 95 version of DOS) without its GUI. This mode loads all the drivers and peripherals. If you type WIN at this prompt you will load Windows 95. This mode is the same as the option 'Restart in MS-DOS Mode' on the Windows 95 Shut Down Menu.

Safe Mode Only Command Prompt loads DOS 7 without the GUI and with only the most generic default settings; that is, it does not load peripherals or network drivers.

F4 loads Previous Version of MS-DOS. This option is only available if you have (1) saved DOS 7 into a separate directory from your previous version of DOS, and (2) your previous version of DOS is Version 5.0 or higher, and (3) you have dual-boot enabled (in MSDOS.SYS insert the line Bootmulti=1). Typing WIN at this prompt will load your previous version of Windows.

T 15: Control Panel (see Section N)

General Use:

Ctrl + Esc for Start menu, then S for Settings, and C for the Control Panel application. Tab into the content area of the window, use the arrow cursor keys or initials to move between items, and Return to open the Properties Sheet dialog box for the option you want. The Accessibility Options are found in Control Panel. See separate section.

T 16: Accessibility Options (see Section O)

General Use of Accessibility Properties Dialog Box:

As in standard dialog boxes, Tab to move focus between current Tab section divider and all elements in section. Ctrl + Tab changes Tabs. Operate individual elements as in standard dialog boxes.

To Use Shortcuts from Any Application:

The checkbox called 'Use Shortcut' must be checked from the dialog box in order for the shortcuts to work from any application. In the relevant section, choose the Settings button (Alt + S), then check the box called 'Use Shortcut' (Alt + U).

Shortcuts for Accessibility Options:

StickyKeys = Press either Shift 5 times.

FilterKeys = Hold Right down for 8 seconds.

ToggleKeys = Hold NumLock down for 5 seconds.

MouseKeys = Press Left Alt + Left Shift + NumLock.

High Contrast Display = Press Left Alt + Left Shift + Print Screen.

T 17: Help (see Section P)

Getting to Help:

From Start menu, Ctrl + Esc, and H for Help. Or F1 when focus is on Desktop area. Or Alt + H for the Help pushbutton in some dialog boxes. Application-specific Help activated by F1 or Alt + H for Help when in the application.

Moving in Help Windows:

Tab moves focus from one area to another, including current Tab section divider, and annotation markers. Ctrl + Tab to change Tab section dividers; when current section divider has focus, use left and right arrow keys. In lists, use up and down arrow keys, then the right arrow key to view sub-folders, and the left arrow key to hide sub-folders. Close each Help Window with the Cancel pushbutton or Esc.

Making Annotations in Help:

Choose Alt + O for the Options pushbutton in some Help windows, then A for Annotate. Type in your annotation, and choose the Save pushbutton (Alt + S) to save and close the window.

Viewing Annotations in Help:

Tab to the annotation marker (a paperclip), and press Return to view annotation in a separate Window. Press Esc to close the annotation.

Deleting Annotations in Help:

View the annotation, then choose the Delete pushbutton with Alt + D. This closes the annotation box and removes the annotation marker.

T 18: Clipboard (see Section Q)

Cut, Copy, Paste:

In most applications, Cut = Ctrl + X, Copy = Ctrl + C, Paste = Ctrl + V (Pastes at position of insertion point, or into the folder which has the focus). All from the Edit menu (Alt + E).

Module 2: Getting Started with the Computer

(Wanda Gonzurova)

Visually Impaired Individuals and the Computer

Human beings receive most of their information through eyesight. Consequently, loss of sight leads to a vital information deficit. Since the computer is precisely a device designed to work with all kinds of information, it is no wonder that the idea to use it for visually impaired persons as a very efficient compensation aid came quickly. Many people have realized that computers can become a real breakthrough in bridging this information deficit, if adapted properly to the needs of the visually impaired users. This adaptation, usually called access technology, has been developed extensively over a period of many years. Thanks to the technology, it is now very difficult to imagine visually impaired persons playing, studying, and working without a computer.

In our current situation, some knowledge of computer use is important for all of us. But visually impaired people in particular are those for whom this knowledge can lead to a new and better life. It is very clear, then, that all visually impaired persons should sooner or later start using a computer. 

DOS or Windows

Once a visually impaired individual has decided to take up the computer, there are several important factors to consider. Some of them should be: what will the computer be used for? what kind of computer to start with? what configuration, which software, which access technology will be needed for what you are going to do? and last, but not least, which operating system to use? Fundamentally, there are two commonly used operating systems to choose from: DOS and Windows. DOS or Windows---it sounds almost like Hamlet's question. Its solution is also quite difficult, since it depends on many complex and closely related factors. A few years ago many people thought that Windows was going to edge out DOS completely, and that visually impaired people would be left behind as almost the only users of this operating system. The reason is clear. When Windows arrived, the DOS-based access technology was good enough for visually impaired computer users to be able to work quite independently, but only under DOS. Although Windows is the most commercially successful PC operating system today, DOS is not gone, as many people had predicted. Though all of the development efforts in access technology are now being concentrated on Windows, fortunately both systems can be accessed and used by visually impaired users relatively well today. In order for us to understand their problems more fully, first we must ask about the advantages and disadvantages which these systems can bring to visually impaired users.

The DOS operating system provides very simple user interface. The simplicity of the DOS user interface has made it possible to develop access technology that is relatively easy to use and understand. The basic advantage of this interface is also its command line. The command line serves as the central and the only point of input for all the commands to the system. In DOS working environment the computer is waiting for the user to type a command at the command line. This command tells the system exactly what to do. It is the user who plays the active role in driving the operating system, and hence the computer. All communication is done at a single location which is easy to find. However, the problem here is that the user has to know the commands in order to get the computer to do anything. This makes DOS less attractive to some people. But this aspect of DOS provides to those visually impaired users who have mastered its commands and logic a level of speed and efficiency at their work that Windows in general can hardly offer. Moreover, due to its very simple structure DOS appears much more stable and is incomparably less confusing to visually impaired users than Windows. The most significant disadvantage of DOS is certainly the fact that DOS is a single-user single-task operating system. This means that, in fact, no two programs can be run simultaneously. For this reason almost all access software has some part implemented as a so-called “resident program.” Unfortunately, resident programs under DOS are often a bit difficult to configure and to use because they might conflict with other applications or with each other. Since DOS offers very low user comfort to sighted people and is much less suitable for complex graphical and publishing tasks than Windows, DOS has been almost completely replaced by Windows in the majority of business and office applications. Actually, new software is no longer being developed for the DOS platform; all current software packages are written for Windows.  Although this sounds very pessimistic, there are still a few DOS-based applications which are largely popular for their simplicity, quality, and beauty--- and they are not only for the visually impaired. As DOS can still offer to the visually impaired computer users much of what Windows can offer, DOS will certainly be used by many visually impaired people (at least for those tasks which are easier in DOS than in Windows). 

While we can say that DOS offers compact user interface to visually impaired users, Windows is strongly oriented to the sighted. A typical Windows user does not need to know any specific commands. Windows are driven via graphical intuitive user interface. This means that the entire working environment is very visual, good looking, with plenty of self-descriptive icons--- pictograms. Because the icons are used in place of typing commands, communication with the system can take place almost anywhere on the screen. For the visually impaired user it may be difficult to find the location of this current communication. Contrary to DOS, in the Windows communication scheme, the system more or less tells the user what to do, and the user only accepts, rejects, or alters the offered actions. The entire Windows communication scheme is very well designed for sighted persons, but for the visually impaired it presents a significant challenge. There is no doubt, however, that Windows is a modern multi-tasking multi-user system whose capabilities are in general much greater than those of DOS. Although visually impaired users may find Windows to be difficult to manage, they can also surely benefit much from the system's modern features, like multimedia, Internet, etc. 

So it seems that a good visually impaired computer user should be able to work in both systems. Based on our many long-standing experiences, we find that DOS is more suitable to start with than Windows, although using DOS may seem to be more difficult at first. We have to realize that the intuitive graphical environment which helps sighted persons so much becomes very unfriendly and confusing to people who cannot see. In fact, the visually impaired Windows user has to know by heart several steps that sighted people are automatically directed to by the system without using much active knowledge. Beginning with DOS requires a more active learning approach from the beginners, and because of this, visually impaired users acquire a very clear understanding of the basic logic of the computer, which comes in very handy when they later use Windows.

DOS for Beginners

One of the most fundamental prerequisites for proper use of the computer is to have good keyboard skills. It is useful to understand that blind people can operate the keyboard in exactly the same way as sighted users (a good typist is not watching the keyboard when typing). So the methodology of teaching the visually impaired is very similar to the common practice. It is useful to replace the typewriter keyboard with the computer keyboard and to use special programs developed for teaching keyboard skills. This way the student is not so aware that he is working on the computer, but is focused instead on developing the keyboard skills themselves. After acquiring keyboard skill, the student can start with the computer. Based on our experiences, an excellent way to begin with DOS is to learn its basic commands. The present  text should not be considered as a textbook or reference guide to DOS. Instead, we would like to state which terms and commands are necessary for a well-informed beginner. 

The basic concepts which the user must know are:

- HARDWARE: what it is; optimal selection of computer hardware; adequate and useful configuration of compensation aids (scanner, Braille display, speech output, etc.);

- SOFTWARE: what it is; operating system as basic program for communication with computer; application software;

- FILE: what it is for; DOS file naming conventions; emphasize the meaning and usage of the file extensions and how useful they can be for identification of type of file; types of files and typical methods of their creation (.com, .exe, .bat, general data);

- DISK DRIVES and their indication as letter with a colon; changing drives;

- DIRECTORY: what it is for; the difference between files and directories; emphasize that the directory-naming conventions are practically the same as file-naming conventions; current directory; subdirectory; parent directory; root directory; tree structure;

- PATH: path as the specification of the location of a file or directory within the directory tree; different methods of specifying paths, namely downwards paths starting with the subdirectory name, upwards paths starting with the parent directory indicated as ".." or root directory indicated as "\"; using drive letters in paths; 

- MEMORY: memory as the working area of the computer; main memory and external memory; RAM and ROM.

First Steps to Computer Use in Practice

To be able to work effectively in DOS the user has to know some basic commands. While mastering the commands the user should become well acquainted with the general command structure, which is very useful to know. The structure is: command name, space, parameters that identify the object to act on; space and switches which modify the action if needed.

The most important activities for all beginners are operations with files and directories.

Which commands are necessary for the beginner?

For better orientation on the screen we recommend the command

- CLS to clear the screen, which always places the command line to the top of the screen

Working with directories

- DIR command, without parameters, which lists the contents of the current directory; and later on, DIR followed by path and directory name lists the contents of a directory which is not the current directory; using switch "/p" for reading long listings; DIR followed by name of file to view details about a given file; using "/s" switch to search for a file of known filename but of unknown location;

- TREE command, without parameters, for viewing the directory structure beginning in current directory; tree followed by the path and directory name lists the directory structure beginning from the given directory; using the "/f" switch causes the TREE command to also include filenames in the listing, not just directories;

- MD followed by directory name as a parameter to create subdirectory in current directory; later MD followed by a path to create a directory anywhere;

- CD followed by directory name to change into subdirectory; CD command with path to change into any directory; reminder of the concept of current directory;

- RD followed by directory name (or path if needed) to remove (delete) an empty directory; emphasize that current and parent directories cannot be removed;

- DELTREE followed by directory name or path to remove whole directory structure including files and subdirectories;

Working with files

- COPY for copying file from the current directory to another directory, or from another directory to the current directory (it is not necessary to write out the name of the current directory); between two directories none of which is current; copying a file with file name change; copying files within current directory (it is necessary to choose a different file name as a destination file); using wild cards to copy a group of files;

- XCOPY, "eXtended COPY," for copying whole directory structures

- DEL for deleting files in current directory, with path to delete a file in any directory; using wildcards to delete a group of files; the wildcards should be used with extreme care especially in the root directory of hard disks;

- MOVE for moving files from current directory to another directory or from another directory to the current directory (when the current directory is also the destination, we can use symbol "." instead of its name); moving between two directories, none of which is current; moving a file with file name change; moving groups of files using wildcards;

- REN for renaming files; renamed files have to stay in the same directory;

Some of the commands mentioned above sometimes produce very long listings. It is then very helpful to know that it is possible to split these long listings into separate screens when at the end of the command  “more" is appended.

For a complete list of DOS commands, see any MS-DOS User’s Guide.

WORD PROCESSORS UNDER DOS

As most of DOS access technology can operate only in text oriented user interface, so the word processors also should meet this very basic condition. Additionally, the selection of the word processor depends on its behaviour (stability) during interaction with other resident programs in general, and particularly with the specific access technology. For example, this criterion almost completely rules out DOS 6.22 edit program. The selection also depends on the country where the prospective user lives. To balance all these factors is certainly a very difficult job. To help with this we can say that in several European countries, and in America as well, many visually impaired people have found that WordPerfect is a program which matches almost all their needs, including professional requirements.

There are basically two versions of WordPerfect for DOS available at present: WordPerfect 5.1 and WordPerfect 6.0. Although WordPerfect 6.0 provides more user-friendly design, much better font and graphics management, and offers overall better output document quality, most people continue to use WordPerfect 5.1. The serious difficulty with WordPerfect 6.0 is that the national version (with spell-checking or thesaurus) is missing, at least in our country. This is the reason why the following notes will be on WordPerfect 5.1, yet we strongly recommend all readers of this text to check the situation with the more modern 6.0 version in their countries.

As WordPerfect is a professional, yet also a complex product, we have decided to present some points which might be very useful for beginners to know.

National Environment Support

For WordPerfect to work correctly in a particular country, first of all the country's national environment has to be set in the DOS operating system (display and keyboard drivers). The drivers for the individual national environments are not part of the WordPerfect product itself, but they work with smoothly with WordPerfect. The correct code page, however, has to be set on the command line when starting the program.

Starting the Program

Basically, the WordPerfect program is started by running wp.exe file which is located in the directory where WordPerfect is installed (usually C:\WP51), followed by the switch for setting the correct national code page. (For example: C:\WP51\WP.EXE /CP=852 runs WordPerfect with Latin 2 code page.) To simplify the WordPerfect starting procedure, batch file can be used. An experienced user can set this up for the beginner.
Working Area

Having run WordPerfect for the first time you will find an almost empty screen. You can use this area to create and edit the text, except the last line, where status line is located. On the right of the status line there are: number of the current document, number of the current page, line position on the page, and cursor position on the line. On the status line there is also displayed information about the current activity of the program. The word processor can also be controlled from the pull-down menu. To access pull-down menu hold key "ALT" and press key "=". The working area can be reconfigured. Everything from the way of activating the pull-down menu to various colour settings can be adjusted according to the users' specific needs.

Useful Settings

In order to get optimal WordPerfect functionality you should certainly pay attention to the following settings:

- beep options - set all of them to YES

- choose correct language

- select correct printer

- select regular paper size with special attention to the correct setting of continuous or manual paper feed

- access mode to the menu can be changed from the "ALT =" to the ALT key only if it does not cause a conflict with access software.

All other settings depend on the user's needs and convenience.

Basic Skills

What is useful for the beginner to learn?

- moving cursor through the text using the cursor shortcuts

- deleting and undeleting text

- retrieving and saving documents

- managing text blocks

- searching string of characters; WARNING - for termination entry of searching string you have to press key F2 and NOT "ENTER KEY". The reason is that search procedure is able to search for control codes as well and so ENTER would be regarded as a part of the search string!

Help System

(Entered by pressing F3)

It must be pointed out that on the one hand WordPerfect is a very complicated program but, on the other hand, it has an excellent help system which is surely one of the best in the world. Not only is it fully context sensitive, but it also provides, among other features, the ability to just press a key combination, and the system will then tell you what it means. The help system is exited by pressing SPACE BAR.

Terminating the Program

To leave the word processor you can use FILE, EXIT from the pull-down menu, as with almost any other program. However it is very useful to learn to use the F7 key, as this key is used as a general "termination key" for many different operations in WordPerfect.

UTILITY PROGRAMS

There exist lots of programs, usually called utilities, for various tasks such as file management, virus protection, archiving, etc. Some of these utilities are very useful, even for beginners. 

File Management

There are many programs called managers that simplify working with files and directories in the operating system. These managers very often provide many more functions than just file management alone. They can also be used for viewing contents of the file, simple editing, printing, and so on. Norton Commander for DOS and Windows Commander for Windows are good examples of popular managers. Since the managers usually display a lot of information on the screen, it may sometimes be tricky to use them with a magnifier or other access technology. However, managers usually have the possibility of quickly locating a directory or a file within the current directory, which is much easier than reading a long list. For example, in Norton Commander, a file or directory can be quickly located by typing the first letter of the file name with ALT key pressed. There are situations when visually impaired users can benefit from such a manager, as certain operations like working with groups of files or searching for files may be much more effective with a manager.

Virus Protection

Computer viruses are small malicious programs nearly invisible to the users, created by certain individuals to damage data on hard disks or to simply annoy computer users in many different ways. The viruses can reproduce and attach themselves invisibly to various programs and data files so that they can still enter more and more computers. As we are becoming every day more dependent on computers, and data exchange is growing quickly, viruses can be potentially more and more damaging to us. That is why everyone must learn to use virus protection programs to scan the computer, to find, and to remove viruses. Continuous "on-the-run" protection is also available. Since viruses are changing and evolving so quickly that all antivirus software must be updated regularly.

Archiving

Naturally, one of the basic activities related to the computer is storing and preserving data. The way in which data is usually stored on disk is optimal for their use but not so optimal for their storage. Whole data structures, including files and directories, can be compressed (packed) effectively into a single file via an archiving program. The archived files are optimal for data storage, but data has to be extracted from such an archived file before it can be used. Determining which specific archiving program will be used is very much up to the user. There are plenty of them available of varying reliability, capabilities or user comfort. It is good to use a program widely used in the country where you live, since it will make your data exchange with others easier. A good number of archive utilities will display a brief explanation on how to use them if they are run with /? switch. Even beginners will soon find that they need to use an archive program to move their data around.

OCR

OCR (Optical Character Recognition) is the technology which converts standard ink-print materials into a form which can be processed within a word processor on the computer. This technology is very useful for the visually impaired, especially for the blind, because it enables them to work with ink-printed materials. For example, they can use this technology to scan a book and then let a speech synthesizer read the book or read it with a Braille display or screen magnifier. Yet it has to be understood that this technology, helpful as it may be, has some very definite limitations. If the material is going to be processed this way, it must not contain any complex graphical charts, drawings or mathematical formulas. OCR also cannot handle handwriting. Another important point is that the print quality of the text determines how many errors the OCR system will make during the recognition process. Poor quality of the original can result in practically unreadable output in the computer.

Why do these limitations exist? Every OCR system consists of two basic parts: a scanner and the OCR software. The scanner scans the graphical image of a printed page into the computer. The scanned page is, however, still just a "picture,” like a photo, and therefore cannot yet be directly handled by a word processor or reading device. A very specialized program called OCR software has to be used in order to recognize the text in that image and to convert it into the standard computer text form.

The Scanner is a standard piece of hardware which is not very difficult to set up and use. And once set up, it does not need to be reconfigured frequently. The OCR software is a bit more interesting part of the system. Certain training is required for blind people to master tips and tricks to using this software to make real use of it. Surely the most popular OCR software for visually impaired people, at least throughout Europe, are Hungarian products like Recognita or Fine.Reader. Recognita software has a large number of modifications both for DOS (the older ones) and for Windows. Several special versions for visually impaired people also existed in the past. Nowadays visually impaired people have a possibility to use a common, not specially adapted, software product like Fine Reader. Due to the country of its origin this software is well adapted to the diversity of language in Central and Eastern Europe.

While using these programmes, people do not need to bother much about any configuration. The system is very transparent. Still, there is certain information which can help new users. Although the system offers many output formats, including WordPerfect, the best results most suitable for further processing in Word, WordPerfect or any other advanced word processor are usually obtained when the "General Word Processor" format is selected. In a case when many characters are unrecognized or even all the text is refused by Recognita, a slight adjustment of the "brightness" parameter may sometimes fix the problem completely. The darker the scanned page itself, the higher value the "brightness" parameter must be set to, and vice versa. While scanning books, the original has to be pressed carefully but firmly enough against the scanner glass to keep all the printing of the page as close to the scanner glass as possible. Although it can certainly damage the bookbinding, it markedly improves the results of scanning and subsequent recognition.

SCREEN MAGNIFICATION SOFTWARE

The technical basics related to screen magnification are much less complicated than those related to Braille displays or speech output. Yet lots of software developers have already found that to create really good magnification software is an extremely challenging task, because many fine subtleties and issues which are very specific to the magnification software have to be considered. Perhaps that is why only a couple of products on the entire world market can be recommended for serious everyday use. The following basic summary on this topic is meant for those who plan to use screen magnification as a main tool to access the computer. It should help them enjoy everything this technology can offer, as well as avoid some unnecessary but frustrating problems.

· Even though all of our discussion about screen magnification concentrates on the screen magnification software, we must point out that there also exist hardware solutions, where specialized hardware and relatively simple software is used. These solutions usually have very good performance providing high user comfort, but the prices and mobility of such equipment have caused availability of this kind of screen magnification technology to be very limited.

· When the screen is being magnified, just a portion of that screen can be seen at any one time. Then, to see whole the screen, this portion (section) has to be moved around, which practically always means some additional manipulations with the keyboard or mouse. So the way in which users control the magnification software is very important and becomes one of the crucial factors for selecting convenient magnification software. Therefore, the bad logic and philosophy of the user interface (the way in which the users manipulate the software) can absolutely disqualify otherwise technically perfect products. We strongly recommend to users to try using a demo version for typical tasks, at least for a couple of days, in order to find out whether the product really satisfies the needs.

· Another very good reason to use demo versions is the fact that magnification software for both DOS and Windows are special applications interacting with other applications and hardware which may cause difficulties and various unexpected results. Whether the particular magnifier works with the particular hardware or applications may also be an important decision point.

· All the magnifiers, even the modern ones for Windows, are still to a certain degree depending on some properties of the video hardware of the computer. As this hardware is evolving very fast, some video cards, especially new or less widely used ones, are a typical source of trouble. So it is a very good idea to use a product which has acceptable technical support in the region where you live.

· Magnifiers for DOS are even more hardware dependent than those for Windows. Moreover, magnifiers for DOS are likely to need a special national version of some files called fonts to be able to display those national characters which are not used in the English alphabet. 

· Magnification of pictures and other graphics is technically more difficult, so not all DOS magnifiers offer this feature.

· Thorough reading of user documentation is not a waste of time, as some people think, because some features of magnification programs may look very strange without a good explanation of how to use them.

Some points to check when selecting magnification software:

· Since DOS and Windows 95, Windows 98 and higher versions are all different operating systems, you need different versions of magnification software: magnification software designed for DOS, if you run programs for DOS, and magnification software designed for Windows (95/98), if you run programs for Windows (95/98). Warning: Windows 3.11 and Windows for Workgroups are programs for which special magnification software dedicated for Windows 3.11 is needed. Be aware also that, in general, there is no rule which could guarantee that software, including magnification software, for Windows 95 will run under Windows 98 and vice versa. Even if many software companies offer their magnifiers in both versions, DOS and Windows, you may often find it useful to use DOS version from one company and Windows version from another company.

· Is it easy enough to operate the software?

· To avoid keyboard conflicts, make sure that the key combinations the magnification software uses for its own activities are not the same as those you frequently use in your favourite applications.

· User interface should be reconfigurable.

· Availability of the technical advice and support should be within reach.

· Colours should be adjustable from within the magnifier. Some people cannot see certain   colour combinations, so a good screen magnifier should offer the possibility to replace   colours in applications (colour mapping). 

· There should be a sufficient scale of magnification. 

· Magnified text should have smooth edges and all characters should be well distinguishable. 

· Some magnifiers have problems with zero and eight, for example. 

· In our opinion, a good screen magnifier for Windows should support all colour depths. It

· would be a pity if the user could not enjoy the high quality pictures and various multimedia

· applications because of his magnification program.

· There also exists software which offers the possibility to work simultaneously with Braille display, speech output and screen magnification. This possibility is available only under Windows 95/98. These software packages, like Zoomtext Xtra and Supernova, are getting more and more popular.

All the issues of screen magnification are quite complex and very subjective. What is an excellent feature for one user may mean trouble for the others. So we have decided not to discuss particular technicalities and user instructions of individual screen magnification packages. Not to mention the fact that the programs are developing so rapidly that at the moment of the release of this book much of that information would be outdated. All this information can be found on an excellent web page dedicated to the magnification software. The address of this page is http://www.magnifiers.org.  Besides miscellaneous useful hints, reviews etc., you can find current demo versions for the most of the magnification software used throughout Europe and America.

STARTING WITH WINDOWS

When we are starting with Windows we have to realize that its default settings are oriented to the sighted users, so our first step should be to re-set them. Our recommendations below could make Windows environment friendlier for visually impaired users and could make communication with the computer easier and faster. These recommendations are mainly for Windows 98, which is newer and currently distributed. We will also mention the differences in settings between Windows 95 and Windows 98.

· All toolbars of the taskbar including "Quick launch" should be disabled. This can be done via context menu of taskbar, which contains "Tool bars" submenu. All operations made through those toolbars can be done by use of menus and hotkey. This setting is necessary only in Windows 98, as Windows 95 does not use any toolbars on the taskbar.

· Application Windows are better to view as lists than as web pages. This can be done in "My Computer" or in "Windows Explorer" via main menu, submenu "View", disable view "As Web Page" and enable view "As List" or "Details". To make this setting active for all applications you choose in the same submenu "Folder Options...". In the dialogue box "Folder Options" choose tab "View" and then press button "As Current Folder" and in new dialogue press "YES". Windows 95 does not provide the "View as Web Page," although it is useful to change the view of Window. It can be done in the same way via main menu of every application: in submenu "View" choose "List" or "Details". This setting affects the current folder and all its subfolders. It should be done for each application, because there is no way to set this for all applications at the same time.

· For greater screen simplicity it is better to have all the folders opened consequently in one Window. This can be done via the above-mentioned "View" menu, in the dialogue box "Folder Options", on the tab "General" in "Active Desktop" check "Custom" and press button "Settings", and in tab "Custom Settings" check "Windows Classic Desktop" and "Open all folders in one window.” This setting is a bit simpler in Windows 95. It can be done in application "My Computer" via main menu, "View" submenu, "Options" and in tab "Folder" you choose "Open all folders in one window.”

· For easier access to files and folders it is better to make the following settings. In the above mentioned dialogue box "Folder Options" choose tab "View" and set:

 

"Display full path in the title bar" - "ON"

  

"Hide file extensions for known file types" - "OFF"

  

"Remember each folder's view settings" - "OFF"

  

"Show pop-up description for folder in desktop" - "OFF"

  

"Smooth edges of fonts" - "OFF"

Then press button "As Current Folder" and in new dialogue press "YES".  In Windows 95 in application "My Computer" via main menu, "View" submenu, "Options", in tab "View" set:

   
"Display full path in the title bar" - "ON"

   
"Hide file extensions for known file types" - "OFF"

· In Windows 98 it should be possible to customize the mouse pointer (size, shape, colour, trail, speed of movement) without any special enlarging software via "Start menu", "Settings", "Control panel", "Mouse".

· Even the partially sighted user can benefit from Windows' "Accessibility Options" where it is possible to set high contrast or to set special colour combinations. This can be done via "Start menu", "Settings", "Control Panel", "Accessibility Options.”

It is necessary to say that the last two adaptations may be good for one kind of visual impairment but could be bad for another.

After you have successfully set up your Windows, and before you start, we would like to offer you some tips and tricks for smoother use.

- It is necessary to understand in the first place that blind and severely visually impaired users cannot use the mouse at all, which is difficult for other Windows users even to imagine. For the users who cannot use the mouse, everything in Windows has to be done through the keyboard. This in fact means that one has to learn a couple of hotkeys and keyboard shortcuts. 

- Use hotkeys in the menus (those underlined letters) and the first letter of an item in lists. Press the first letter again if you need to locate the next item, the name of which begins with this letter.

- As the desktop is not very comfortable to browse with access software, it is helpful to use the "Start menu" for running all your applications by using the hotkeys and first letters of application names as described above.

- It is a very good idea to have all the Windows you are working with maximized. To maximize a Window you can use "ALT+Space" and then letter "x".

- When one Window is used for all folders use "Backspace" key to get to the parent folder. It is equivalent to clicking the icon on the toolbar, which is impossible to do through the keyboard.

- If you need to minimize all the Windows at once you can use "CTRL+ESC" followed by "ALT+ letter m" or "Windows key + letter m". 

- Use a rich sound scheme which can help to identify what happened on the screen by means of different sounds.

- For a blind internet user it is not necessary to have pictures displayed. Displaying pictures slows down communication.

TALKING AND BRAILLE NOTETAKERS (by Branislav Mamojka)
Blind and partially sighted people, like sighted people, have found various portable electronic devices to be very useful to store their notes, phone numbers, addresses etc. Those devices give them a new dimension of independence and readiness, wherever and whenever. The advantage of electronic note taking compared to Braille notes on paper is evident. It gives blind and partially sighted people similar performance and speed as that of sighted people when saving, sorting, editing, reading, and searching information. It is especially profitable for pupils, students and professionals who have to perform their activities in different places, who need to use a huge amount of actual information.

The devices in question can be roughly divided into two groups: voice memories which give back information as it was stored and real notetakers which also allow processing of stored information.

On the market there are a large number of voice recording devices – voice activated -- without visual display and produced for sighted users. Since they do not require visual control, blind persons can also use them. They serve well for immediate recording and replaying notes, phone numbers, appointments, etc. Some of them are also taking into account the special needs of visually impaired people. An example of this type of device is the popular Business Memo from the Polish Company Univex. It has handy browsing, reviewing and deleting functions.

The more powerful voice memories are also equipped with voice recognition. They recognize commands and requests spoken by human voice and perform requested information. Standard devices of this type are normally equipped with display which has to be followed by the user. Therefore they cannot be used by blind persons at all or only in limited ways. There are two exceptions known to us:

· The first is the voice diary called Parrot Plus from the French company Parrot (http://www.trimaran.fr/demo/parrot), which has all functions of highly sophisticated voice memory with visual display including speech recognition, notepad with possibility to recall record by keyword, diary, phone directory with automatic tone dialling, clock, calendar, alarm, calculator. It has voice menu which enables blind users to use all its functions by themselves.

· The second is Voice Diary from the Israeli company Voice Diary Ltd. (http://www.voicediary.com) which was especially designed for blind users. It has no display; all functions are controlled by voice and keypad. It features notepad, structured diary, structured phone directory with automatic tone dialling, clock, alarm, calculator and calendar. 

All of the above-mentioned systems allow storing and retrieving short records of actual information. They are not intended to record bulky data like notes of a lecture, to process data like editing and printing text, etc. For those purposes computer-based data processing systems are needed. We are not speaking about standard notebooks equipped with a large print program or a screen reader with synthetic speech or Braille display. We are speaking about specially designed portable and compact computer devices without visual display intended for blind users only. These systems use as input a Braille keyboard or a standard PC-like keyboard and synthetic speech and/or Braille display as an output.

As a representative of full-featured notetakers for the blind, the products Braille Speak, Braille Lite and Type Speak from Blazie Engineering (http://www.blazie.com) can be used. There exist a number of different language versions of this equipment and the producer is ready to work on additional language versions. The product line contains Braille 'n Speak - notetaker with Braille keyboard and speech output, Type ‘n Speak - notetaker with standard PC-like keyboard and voice output, and Braille Lite - notetaker with Braille keyboard and both Braille and voice output. All of these devices are based on the same technology; they are using nearly the same operating system with slight modifications corresponding to their mutual differences. This means that all devices can be localized for a given language at the same time and can be kept updated simultaneously.

The Braille Lite 2000 and the Braille Lite 40 have a programmable Braille table. Braille Lite 40 is a full-featured Braille display with cursor routing keys for PC combined with a powerful notetaker. In Braille mode only, it can be used for arbitrary language without any adaptation except for simple editing of the Braille table. This means that with the original English system each text could be entered and displayed correctly in the respective language, while only system prompts and messages would be displayed in English.

All notetakers include a powerful word processor with block operations, formatting and font functions, enabling writing in a standard (literary or contracted) Braille code, as well as in a computer Braille code and printing on both ink print and Braille printers. They have 768 KB of RAM memory and 2-MB flash memory to store a huge amount of information. Standard features are the calendar, watches, stop watches and timer, standard and scientific calculator, diary and phonebook. The speed, pitch, volume, and pronunciation of punctuation and numbers can be adjusted. Two languages can be installed in each model, including the possibility of immediate switching between the two by a simple keyboard command. All devices are equipped with serial ports enabling communication with computers, modems, printers and external disk drives. Type 'n Speak and both Braille Lite models also have parallel port, and for Braille ‘n Speak the serial to the parallel converter is available. Braille 'n Speak is perhaps the smallest and most popular representative in its category - its weight is only 450 grams. Braille Lite 40 is the most powerful and complete system of this family. Its flash memory is extended to 4 MB and it can be used as a fully functional Braille display for PC.

The great advantage of notetakers of this category is that no file saving procedure is needed when you finish working; simply switch your machine off and no data is lost. When you restart the machine, you are positioned at the same place where the machine was switched off, so you can immediately continue your work. This feature is extremely useful in particular for students when taking notes at lectures, meetings, and conferences.

In spite of great portability, powerful functions and the possibility of using downloadable external programs especially designed for those machines, they do not replace standard computers. As described above, they meet nearly all the needs of each blind person, but there are tasks like reading printed books by means of optical character recognition which are not available with them. For blind persons with extensive needs, a combination of both a notetaker and a computer is an ideal solution.

SEVERAL WORDS IN CONCLUSION

Sooner or later almost every visually impaired person will find out that the computer can become an extremely useful helper. Although it is not an easy task, I am sure efforts invested in learning how to use the technology will pay off many times in the future. To make all the efforts really effective it is absolutely necessary for visually impaired computer users to learn both systems, Windows as well as DOS.

Our present experiences show that DOS is preferred by most visually impaired people for at least some portion of their personal agenda. They use Windows at work, to communicate with others, and/or for entertainment. Regarding the public as a whole, Windows is the most preferred and used system. Naturally, Windows is becoming an essential part of basic computer education for all of us. Everyone, without exception, who wants to find almost any job has to know how to operate the Windows environment, as Windows has become a basic working tool in offices all around the world.

Module 3a: Windows Tutorial

(Ludmila Jašková, Zuzana Kubincová)

Introduction

It is a matter of fact that within the last few years the Windows operating system has become the most commonly used system by most offices, firms, companies and schools world-wide. It is also true that PC standard and DOS applications are still less used world-wide. For this reason it is very important to make Windows accessible to visually impaired people to open new educational and employment opportunities. Without access to Windows many blind and partially sighted people may soon lose their employment and their educational opportunity may be substantially decreased.

The transition to Windows is neccessary but it is not easy for blind people. For the blind user it is impossible to learn about Windows in regular courses or from usual text-books or manuals, because there are many instructions described in this manner: “If you want to ... click the button...”. However, there are special tutorials for blind users in which individual actions are described step by step. These tutorials are very useful, especially for independent study. Unfortunately there is still a lack of handbooks for the teachers of blind users. This is the reason why we decided to write this book – methodological material on how to teach the blind users to use Windows and other useful applications – MS Word and MS Excel.

During the last two years, we prepared and conducted several courses for the blind and for teachers of the blind. We would like to share our experience from these courses with mainstream teachers of computer literacy who have blind students integrated into their classrooms. This book could also be useful for instructors in special computer centres for visually impaired students, but it does not contain sufficient information for experts in special pedagogy who are not working with computers and do not know how to use the software mentioned above (Windows, Word, Excel).

This book is neither a user manual nor a tutorial. It is a teachers’ handbook. Here you can find information about how to design your course for blind students – curriculum and length of time required to complete the course, recommendations for special hardware and software, information about study materials, exercises, optimal environment settings, and known problems and how to avoid them. During our courses we used tutorials written by Sarah Morley [3], [4] tutorials from IOWA Department for the Blind [2] and from Henter-Joyce WWW page [1]. We recommend that you look at them because these are very good tutorials with detailed instructions and tactile pictures of important objects and situations on the screen. These pictures will help your students to understand the meaning and functionality of objects.

The most effective way of learning is active learning and we strongly recommend that you teach students while they are sitting at computers during the courses. Teaching blind computer users is impossible if there is one tutor in a classroom with many computers, because students may not be able to follow the teacher’s instruction to complete the explained procedure and the teacher may not be able to check whether the students are on track with others at the same time. The best way of teaching is to first give an explanation or description of the procedure and then let the users practice the described procedure. It is improbable that all students will work at the same pace, and very often some of them will get lost and some will be bored while they have to wait for others. The optimal situation would be 1 computer and 1 trainer for 1 student, but this is not always possible. However, there should not be more than 2 students with 1 tutor and 1 computer.

Blind users can use the computer if there is a Braille line or speech synthesizer/Sound Blaster with screen reading software connected to the computer. The Braille line is a rather expensive device but the Sound Blaster is already built into most computers. In our courses we used computers with Sound Blaster (or Apollo speech synthesizer) and JFW screen reader software that includes "Eloquence for JFW" software (speech synthesizer speaking in seven different languages) as well as the Microsoft text-to-speech engine. JFW means Jaws For Windows, a special program developed by Henter-Joyce, Inc. It supports all kinds of Windows applications (word processors, spread sheets, WWW browsers, e-mail clients, text recognition software,…) and also external speech synthesizers and Braille lines. You can find more information about this program on the Henter-Joyce WWW page http://www.hj.com. We used the JFW 3.3. version. There are also other screen readers, which you may find more suitable. You can find information about them in Module 3b of this book. If you are using a different screen reader, we recommend that you substitute all the JAWS keystrokes with the proper keystrokes of your screen reader. JAWS keystrokes are mostly combinations of Insert key with some other keys.

Here is what a young blind computer user told us about working in Windows: “I will start with a comparison of Windows and DOS. In my opinion, working in Windows is more comfortable, but on the other hand, each operation needs more time than it did in DOS. In DOS you could write commands with appropriate parameters, but in Windows you have to set most of the properties through the various menus. You can use hotkeys for many of them but not for everything. In some cases it can be problem with speech. For programs working in text mode like in DOS it was no problem. Most recently it has been necessary for me to use Windows because of the lack of useful and interesting programs working in DOS. And there is one more thing which I miss in DOS and I appreciate in Windows: multitasking.”

One more opinion:

“We cannot blame Windows for many shortcomings we are finding out about while using this operating system. The result of our work is determined by the screen reader, because you can use almost all the programs supported by your screen reader without problems.”

This module consists of 3 parts: “Windows 95 with JFW 3.3 for Windows,” “Word 97 with JFW 3.3 for Windows,” and “Excel 97 with JFW 3.3 for Windows.” In each part, you can find information about optimal environment settings for blind users, an explanation of basic concepts and actions, and many examples. Explanations are presented in the order which we used in our courses. At the end of each part we focus our attention on known problems and possible solutions. Be aware of the fact that some of our comments could be influenced by the version of screen reader, Windows applications and configuration of computers that we used, and therefore may not be valid in your situation. Another important fact is that our courses were for older students and adults, so a teacher of younger students should make appropriate modifications.

From an organizational point of view, we recommend the following structure of courses. It is most effective to start with two intensive courses about these topics:

1. Basics of Windows and MS Word.

2. Windows advanced features and basics of MS Excel.

Each course should take about 20 hours (2 1/2 full days or 5 half-days). Additional lectures (2 hours 2 times per week) are recommended after each course, while the user is using the software at work (school or home). There should be at least a two-week break between the two intensive courses mentioned above. 

The course is divided into 5 sessions. First, it is necessary to explain the usability and concepts of the software (Windows 95, Word, Excel) and the basic elements of the environment (desktop, Window, application menu, most used dialog boxes, ...), then to train the orientation on the desktop (in Windows) and finally to teach individual actions. The exercises and the themes for independent work are the important part of every session as well as the repetition of the themes taught in the previous session.

Be aware of the fact that each student needs a different amount of time to work. It is easier to work in Windows for those who have already used a similar type of application in DOS than for those who have never used the computer before. It is much easier to learn how to use the second Windows application than to work in Windows for the first time. The big advantage of Windows is that Windows applications use the common user interface, so the greatest difficulty is to master the Windows application and then it will be easier to use further applications.

It is easier to teach students who use the computer often than to teach those who use it only occasionally.

Finally we would like to give many thanks to Mr Branislav Mamojka –President of the Slovak Union for the Blind and Partially Sighted, for his advice and help. This module would probably not have existed without him.

Authors

WINDOWS 95/98 WITH JAWS 3.3 FOR WINDOWS

Initial Settings

Control Panel Settings

It is recommended to use the following Control panel settings:

Color Scheme: set to Windows Standard.

Desktop: Pattern set to none, Screen Saver set to none. Color Scheme set to none.

Sound Scheme: set to rich sound scheme where you are able to distinguish different situations like robots JFW Settings.

JFW Settings

It is recommended to use the default JFW settings unless otherwise indicated.

Verbosity: Beginner

NumLock: Switch off

Helpful Keystrokes

Here are some keystrokes, which you may find helpful as you work with Jaws for Windows. 

To silence JFW at anytime, press Ctrl or Shift.

To make JFW repeat a selected item, press Insert-Up Arrow.

To spell check the selected word, hold down the Insert key and press the Center key twice in rapid succession. (Center key is the 5 key on the number pad.)

To refresh the screen for JFW at any time, press Insert-Escape.

To activate the JFW context menu, press Insert -F1.

To verify the active application, press Insert-T.

Windows 95/98 Environment

Basic Features

Microsoft's Windows 95/98 is an operating system -- the program that governs all operations on your computer. The basic features are:

Graphical user interface (GUI) consisting of windows, menus, icons, and dialog boxes to help you to tell your computer what to do. Windows presents options and commands to you, accepts your responses, and translates them into commands for the computer. Windows eliminates the need for you to remember and type complex commands that require exact syntax.

Multi‑tasking - the ability to have several programs and documents open at the same time. You can quickly switch among programs to activate the one you need to use.

Data exchange - with a few simple keystrokes, you can extract information from one program and place it into another.

Standard Menu System - all programs must use a standard menu system. As a result, you will find the same menu system and similar choices in all programs.

Screen Layout

Windows screen contains two main objects – the Desktop and the Taskbar. The Desktop and the Taskbar serve as the main graphical interface to your computer. You can access all your programs and files from either the Desktop or the Taskbar.

The Desktop takes up the majority of the space on the screen. The Desktop lists program icons, which you can use to start programs. Desktop is similar to the top of your desk.

The Taskbar contains the Start button, buttons for open programs, and a clock. The Taskbar allows you to quickly start programs, manage tasks on the Desktop and on your computer, and exit Windows.

If one of the elements -- Desktop, Taskbar, Start button – has the focus, you can move to one of the other two by using the Tab key. If you press Tab and JFW only announces "Tab", no item is in focus, press Insert-F6 to move the focus to the Desktop. If you have a Windows 95 keyboard, you can press the Window key - M keystroke.
You can use the Arrow keys to select program icons on the Desktop and to select program buttons on the Taskbar.

You can open the Start Menu by pressing Ctrl-Escape. If you have a Windows keyboard, you can press one of the Window keys located on either side of the Alt keys.

You can open a sub-menu by pressing Enter when JFW reads the command with a sub-menu. You can close a sub-menu by pressing Escape.
You can determine the hot key for each menu command by pressing the Center key.

You can execute a menu command by pressing its hot key.

Exercise 1.

Move the selection cursor to the Desktop, Taskbar, and Start button on the Taskbar. Review the Desktop items, Start menu items and Taskbar items.

PC Cursor and JAWS Cursor

Windows uses the selection cursor, insertion point, and mouse pointer to indicate where on the screen the computer focus is directed. The PC Cursor represents the insertion point and the selection cursor. The JAWS Cursor represents the mouse pointer.

Press the Minus key to activate the JAWS Cursor. JFW announces, "JAWS Cursor."

Press the Plus key to activate the PC Cursor. JFW announces, "PC Cursor."

You can review the screen using the JAWS Cursor.

Move the JAWS Cursor to the top left-hand corner of the screen by pressing Page Up, then, press the Home key to move the mouse pointer to the left edge of the screen and press the Left Arrow key until JFW announces, "Top of Window Blank."
Begin reviewing the Desktop and Taskbar. Press Insert-Down Arrow to review the screen. JFW automatically reads the entire screen beginning with the My Computer icon and ending with the current time as it appears on the Taskbar.
You can review the screen by element if you press Ctrl-Right Arrow to move from one element to another.

If you want to read character-by-character, press Right Arrow. If you want to read line by line, press the Up and Down arrow keys.

Exercise 2.

Review the Desktop and Taskbar using the JAWS Cursor. If you have a tactile image of the Windows screen, try to compare your impression with the picture.
Starting and Exiting Programs

You can start a program by activating the program icon on the Desktop or by choosing the program from the Programs sub-menu, or you can use Run dialog box. 

For programs listed on a menu, you may press the first letter to open the program quickly. When the program opens, JFW reads the title bar. 

Each time you open a program, Windows places a button for that program on the Taskbar. You can use these buttons to switch between different open programs. When the full program title does not fit on the program button on the Taskbar, Windows only lists the first few words in the title followed by ellipses to indicate the title is longer than what is listed on the button. 

You can switch between running applications also using Alt-Tab or Shift-Alt-Tab.

You can close a program window by accessing the Program Control-menu (see below) and choosing the Close command, or by pressing Alt-F4. You can also use Exit command in File sub-menu of application menu (see below).

If you are running Windows and JAWS is not speaking, maybe you need to run JAWS. Press Ctrl-Esc to activate the Start menu, then press P to activate Programs Sub-menu, then press J to open JAWS sub-menu and finally press J to run JAWS.

You can also use special keys in the JAWS application:

Press Insert-J to switch to JAWS quickly.

Press Insert-F4 to exit JAWS quickly.
Exercise 3.

a) Activate the Start menu, review the Start menu commands, open a sub-menu (Programs, Documents, Settings), and read the hot keys for the menu commands. Try to use the keyboard shortcuts for selecting and executing menu commands.

b) Open My Computer using the program icon on the Desktop.

c) Start WordPad using the Programs sub-menu.

d) Start Notepad using the Programs sub-menu.

e) Switch among the WordPad, Notepad, and My Computer program windows using a keyboard shortcut and the open program buttons on the Taskbar.

f) Close My Computer using a keyboard shortcut Alt-F4.

Application Window

Each program runs in a window. A window is simply a framed region on the Desktop. The number of windows that can appear on the Desktop depends on your computer's memory, the Windows program, the amount of memory your programs require, and the manner in which you choose to display them. 

There are two types of windows: program windows and document windows.

Program Window: A computer program is a set of instructions that perform a specific task, such as word processing or data management. A program window might contain several document windows. You can only enter commands through a program window.

Document Window: A document is any information you create with a program, such as a letter, spreadsheet, or database file. When you open or create a document in a program, you open a document window. Each document window contains a single document and always appears in the program window's work area. This type of window is sometimes referred to as a child window.

Each window can be in three states:

Minimized - appears as small as a button

Maximized - appears as large as the Desktop

Restored - any size in between. 

However, JFW works best when the program and document windows are maximized. Therefore, you should always make sure the window in which you are working is maximized. You can use the Program or Document Control-menu (see below) to minimize, maximize, or restore a window.

You can pull down the Program Control-menu by pressing Alt-Spacebar. Then you can choose Restore, Minimize or Maximize command.

You may use the JFW keystroke Insert-F6 to minimize all windows. 

Most windows contain a combination of the following elements:

Window Borders: Window borders are the four edges that define a window.

Control Menu: The Control menu lets you move, close, or change the size of a window.

Control Menu Box: The Control menu box is a button appearing in the top left-hand corner of the window. When you activate the Control menu box with Alt-Spacebar keystroke the Control menu appears.

Title Bar: The title bar is a horizontal bar directly below the window's top border between the Control-menu box and the resize buttons. The title bar lists the window's name. Press Insert-T to read the title bar.

Resize and Close Buttons: The resize and close buttons appear in the top right-hand corner of the window. You must use the JAWS Cursor to activate these buttons. The resize buttons perform the same tasks as Minimize, Maximize and Restore commands on the Control menu. The Close button performs the same task as the Close command.

Menu Bar: The menu bar is a horizontal bar the length of the window. It appears at the top of a program window, directly beneath the title bar. The menu bar lists all menus for the program.

You can access the menu bar in a program by pressing the Alt key. To move the focus off the menu bar, you can press the Escape key twice or the Alt key once.

You can press the Left or Right Arrow key to select a new menu once the menu bar is active. 

You can press the Up or Down Arrow key to select a new menu command once the menu is active.

You can use keyboard shortcuts to pull down a menu quickly.

You can use keyboard shortcuts to execute some menu commands quickly.

Work Area: Every window has a work area. What you do in the work area depends on the window. Generally, a window's work area holds information. For example, a program window's work area holds the document window.

Icons: Icons are small, graphic representations of programs, drives, folders, and documents. When you activate an icon you start the program, open the document, or access the contents of the drive or folder.

Scroll Bar: A scroll bar is a bar along the right edge and/or bottom edge of a window that lets you scroll the contents of a window or list box to show information not currently visible on the screen.

Status Bar: The status bar is a horizontal bar beneath a document window. It lists status information such as page number, date, time, or status of task. You can read this information if you press Insert-Page Down.

Exercise 4.

a) Access the menus and review the menu commands in WordPad. Use the Alt-F keyboard shortcut to open the File sub-menu, use the Alt-O keyboard shortcut to open the Format sub-menu

b) Minimize, maximize, and restore the Notepad program window.

c) Close the Notepad and Wordpad programs using the program Control menu.

Dialog Boxes

Windows uses dialog boxes to either display or request information. A dialog box can be very simple, displaying a brief message or listing just a few fields of information. Other dialog boxes can have numerous fields and can contain menu and button bars. 

You can either accept the information listed in the fields on the dialog box or change it. A field in a dialog box can be formatted as a Check Box, Command Button, Drop‑down List box, List Box, Option Button, Spin Box, or Text Box. A dialog box may also contain Tabbed Pages. 

You can press Insert-H to find out the dialog box hot keys and Insert-B for an overview of a dialog box.

You can press Tab to move forward through the fields on a dialog box. You can press Shift-Tab to move back to the previous field.

You can press Ctrl-Tab to move through the tabbed pages in a dialog box.

You can select a field quickly by pressing Alt-field hot key.

In some dialog boxes, you can press Escape to close a dialog box without selecting a command. In dialog boxes with menus, press Alt-F to open the File menu. Then, press C to close the dialog box.

Exercise 5.

a) Open and review the Find dialog box.

b) Open and review the Run dialog box.

c) Run Notepad program and open and review the Open and Save dialog boxes.

Exiting Windows

You can exit Windows using the Shut Down command on the Start menu or move to the Desktop and press Alt-F4.

You should always make sure all your documents and programs (except JFW) are closed before exiting Windows.

You should always exit Windows before you turn off your computer.

Exercise 6.

Exit out of Windows; do not close JFW before you exit Windows.

Using the My Computer Window

The My Computer window allows you to access and organize all the information saved on your computer or floppy disks. Using the My Computer window, you can create, copy, move, open, rename, and delete folders and files on your drives.

Overview

The My Computer window has the following elements:

Program Control Menu

Title Bar
Program Resize and Close Buttons
Menu Bar containing the following menus: File, Edit, View, and Help.

Toolbar with shortcuts to commonly used commands

Status Bar

The majority of the window is reserved for listing the drives, folders, and files on your computer.

Opening and Reviewing the My Computer Window

To review the My Computer Window:

Move to the Desktop, select the icon My Computer and press Enter
Maximize the My Computer window (Alt-Spacebar, X for Maximize command)).

Press the Minus key to activate the JAWS Cursor.

Press Page Up and then press Home to move the mouse pointer to the left edge of the screen.

Press Insert-Down Arrow to review the screen. 

Press the Plus key to activate the PC Cursor

Exercise 7.

Open the My Computer window and find the following elements:

a) Program Window Title (My Computer)

b) Resize and Close Buttons (Minimize, Maximize/Restore, and Close)

c) My Computer Menus (File, Edit, View, Help)

d) Toolbar buttons (Drives and Folders combo box, a Network connections button, View buttons, and editing buttons)

e) Drives and Folders (A:, C:, CD-ROM drive, network drives [if applicable], Control Panel folder, and Printers folder.)

f) Status Bar (lists the number of items in the window, the amount of disk space remaining for the selected drive, and the total amount of disk space available for the selected drive)

Navigating Through the My Computer Window

Press Insert-T to verify the My Computer window is the active window.

Use arrow keys (left, right, up, and down) to read all the items in the window. Each time you press an arrow key you select a different item. 

Press Insert-Page Down to read the status bar.

Review all the menus and menu commands. Press Alt-F to pull down the File menu. Press the Down Arrow to review the menu commands. Then, press the Right Arrow key to move to the Edit menu. Repeat for each remaining menu.

Closing the My Computer Window

Press Alt-F4 keystroke to close My Computer window.
Changing the View Options

Windows 95 allows you to customize the way information appears in the My Computer window. You can choose to have the items appear in a horizontal list or a vertical list. You can choose between large icons or small icons. Finally, you can choose to list only the names of the drives, folders, and files, or you can list more detailed information about each of these items.

Not only can you determine how you want the drives, folders, and files to appear, but you can also decide how you want to browse the information in each drive and folder. By default, a new window opens each time you choose a drive or folder. You can change this so that only one window remains open and the contents of the window changes. If you do not like to keep track of numerous open windows on your Desktop, you may find it easier to browse using a single window.

To change the View options for the My Computer window, use the View menu. The following list describes the View menu commands.

 The Toolbar command allows you to display the toolbar in the window or hide it. If the toolbar appears on the screen, a check mark appears next to the command. JFW announces, "Toolbar Checked" when this command is checked. The T key is the hot key for this command.

The Status Bar command allows you to display the Status Bar in the window or hide it. If the Status Bar appears on the screen, a check mark appears next to the command. JFW announces, "Status Bar Checked " when this command is checked. The B key is the hot key for this command.

You may choose one of four icon view options: Large Icons, Small Icons, List, and Details.

When you select the Large Icons command, the items in the window appear as large icons (approximately one-half inch) with a text label underneath the icon. The icons and labels are arranged horizontally in the window. You may have several rows of items in a window. The G key is the hot key for this command.

When you select the Small Icons command, the items in the window appear as small icons (approximately one-quarter inch) with a text label beside the icon. The icons and labels are arranged horizontally in the window. You may have several rows of items in a window. The M key is the hot key for this command.

When you select the List command, the items in the window appear as small icons (approximately one-quarter inch) with a text label beside the icon. The icons and labels are arranged vertically in the window. You may have several columns of items in a window. The L key is the hot key for this command.

When you select the Details command, the items in the window appear as small icons (approximately one-quarter inch) with a text label beside the icon. Additional information about the each item, such as file type, file size, and the last modified date, also appears. The icons and labels are arranged vertically in the window. You may have several rows of items with several columns of information in a window. The D key is the hot key for this command.

The Arrange Icons command opens a sub-menu with options to arrange the items by name, date, type, or size. You may also select the Auto Arrange option from this menu. The I key is the hot key for this command.

The Line Up Icons command allows you to line the items up in rows. The E key is the hot key for this command.

The Refresh command updates information in the window that has changed. For example, if you move a folder into another folder, the Refresh command updates the window to reflect the move. The R key is the hot key for this command.

The Options command opens the Options dialog box. From this dialog box, you can change the view to show folders in a single window, hide or display specific types of files, and change the icon associated with different file types. This dialog box contains multiple tabbed pages. The O key is the hot key for this command.

Recommended View Settings

The recommended View settings ensure consistency in the way Windows displays the information, making it easier for you to access the information you want. 

The Following View Settings Are Recommended for Windows 95:

Open the View menu of My Computer window.

Select the Toolbar command to display the toolbar. 

Reason: You will not be able to switch to a different drive or folder if the toolbar does not appear on the screen.

Choose the List command to arrange the items in the window in a vertical list using small icons or the Details command to arrange them in a vertical list with file or folder properties like file type, size, date of the last change, etc.

Reason: When you use the Large Icons or Small Icons command, Windows does not automatically move the selection cursor to the next row once you have reached the last item in the row. You must press the Down Arrow key to move the selection cursor to the next row. Then, press the Left or Right Arrow keys to read the items. If you use the List command, Windows will automatically move to the next column once you have reached the last item in the column. If you use the Details command all items are arranged just in one column, because there are file/folder properties for every file/folder in the other columns.

Choose the Options command. The Options dialog box with three tabbed pages appears.

On the Folder tab check the option Browse folders using a single window that changes as you open each folder.

Reason: Windows does not use the same settings for each window it opens. Therefore, if you choose to open a separate window for each folder or drive, you must maximize and change the View settings for each new window that opens.

On the View tab ensure the following settings:

Display the full MS-DOS path in the title bar: Set this option to On.

Reason: By default, Windows only lists the name of the folder in the window title bar. It does not indicate the full path. This can cause you problems if you happen to have more than one folder with the same name. For example, if you have a folder named Documents on your floppy disk and a folder name Documents on your C drive, Windows does not indicate which Documents folder you have opened unless you choose to display the full MS-DOS path in the title bar.

Hide MS-DOS file extensions for file types that are registered: Set this option to Off.

Reason: If you use file extensions it is not necessary to read the details of the file to know the file type.

Activate the Maximize command to maximize the My Computer window. This command appears on the Program Control-menu.

Reason: JFW works best when the window is maximized.

The Following View Settings Are Recommended for Windows 98:

Open the View menu of My Computer window.

In the Toolbars submenu, select the Address bar command to display the address bar.

Reason: You will not be able to switch to a different drive or folder if the address bar does not appear on the screen.

The Explorer bar set to None.

Reason: The view of My Computer with Explorer bar can cause problems with the navigation in the window.

Disable View as WEB Page in the View menu.

Reason: The view of My Computer as WEB Page can cause problems to screen reader.

Choose the List command to arrange the items in the window in a vertical list using small icons or Details command to arrange them in a vertical list with file or folder properties like file type, size, date of the last change etc.

Reason: When you use the Large Icons or Small Icons command, Windows does not automatically move the selection cursor to the next row once you have reached the last item in the row. You must press the Down Arrow key to move the selection cursor to the next row. Then, press the Left or Right Arrow keys to read the items. If you use the List command, Windows will automatically move to the next column once you have reached the last item in the column. If you use the Details command all items are arranged just in one column, because there are file/folder properties for every file/folder in the other columns.

Open the Folder Options submenu. In the Options dialog box, General tab choose the option Custom, based on settings you chose for Windows Desktop Update, and then press Settings button.

For Active desktop check the option Use Windows classic desktop.

Reason: This setting disables viewing desktop as Web page.

For Browse folders as follows check Open each folder in the same window, which allows you to browse folders, by using a single window that changes as you open each folder or drive.

Reason: Windows does not use the same settings for each window it opens. Therefore, if you choose to open a separate window for each folder or drive, you must maximize and change the View settings for each new window that opens.

Switch on the View tab of the Options dialog box, and then ensure the following settings:

Remember each folder's view settings: Set this option to Off.

Reason: It is more comfortable for you if the view of My Computer window is the same for all folders.

Display the Full Path in the Title Bar: Set this option to On.

Reason: By default, Windows only lists the name of the folder in the window title bar. It does not indicate the full path. This can cause you problems if you happen to have more than one folder with the same name. For example, if you have a folder named Documents on your floppy disk and a folder name Documents on your C drive, Windows does not indicate which Documents folder you have opened unless you choose to display the full MS-DOS path in the title bar.

Hide file extensions for known file types: Set this option to Off.

Reason: If you use file extensions it is not necessary to read the details of the file to know the file type.

Show pop-up description for folder in desktop: This option should be also set to Off.

Smooth edges of fonts: If you are visually impaired, set this option according to your sight. For the blind it is recommended to set this option to Off.

Reason: It can speed up your computer a little bit if Windows need not draw smooth edges of letters.

Then press button Like current folder for Folder views. The message box with the message “Set all the folders on your computer to match the current folder’s view settings (except for toolbars)?” appears. Press Yes.

Activate the Maximize command to maximize the My Computer window. This command appears on the Program Control-menu.

Reason: JFW works best when the window is maximized.

Exercise 8.

Change the View Settings to the recommended settings listed above.

Accessing Drives

The My Computer window lists all the drives available on your computer. Each drive contains unique folders and files. In order to work with the folders and files on your various drives, such as C:, A:, or D:, you must access the drive where the files and folders reside.

Note: Windows always lists the floppy disk drive first.

Note: By default, Windows lists drives before folders and folders before files.

To determine whether the selection cursor is on a folder or file, press Insert-Tab. JFW will indicate folder or file.

Exercise 9.


Access the hard drive by pressing Tab to move the focus to the Drives and Folders combo box. 

Press the Down Arrow key to open the combo box list. Select the drive by pressings the Down Arrow key, then press Enter to change the contents of the window. 

Note: The title bar always lists the current path.

Note: The window always lists the contents of the current drive.

Press the Up or Down Arrow key to read the files and folders in this window.

Opening Folders

To open a folder press the Up or Down Arrow key to select the folder and press Enter.

If you know the name of the folder, you can repeatedly press the first letter of the folder name .

Selecting and Deselecting Files

If you want to perform the same function on several files, Windows allows you to select more than one file at a time. If you decide not to include a file, you can deselect the file.

Selecting Consecutive Files

Press the Spacebar to select the first file, press Shift-Down Arrow to select the second one and continue to hold down the Shift key, and press the Down Arrow key to select the third one.

Note: If you press the Down Arrow key without holding down the Shift key, you cancel the selection.

Verify the selection by pressing Shift-Insert-Down Arrow.

Tip: You can press Shift-Insert-Down Arrow at any time while selecting files to verify the filename. This keystroke does not interfere with the selection process.

Press the Down Arrow key to deselect the selected files. 

Selecting Non-Consecutive Files

You can select more than one non-consecutive file at a time by holding down the Ctrl key and pressing the Up or Down Arrow key repeatedly. Then, press the Spacebar when JFW reads the file you want to include in the selection.

Select the first file.

Press and hold down the Ctrl key to begin the non-consecutive file selection.

Continue to hold down the Ctrl key while pressing the Down Arrow to move the selection cursor to next file, which you want to select.

Press the Spacebar to include this file in the selection.

Press Shift-Insert-Down Arrow to verify the selection.

Press the Down Arrow key to deselect the selected files.
Selecting All Files

If you would like to select all the folders and files in a folder, use the Select All command. Select this command from the Edit menu, or use the keyboard shortcut Ctrl-A.

Deselecting Files

You can remove a single file from a selection by pressing Ctrl-Spacebar.
Creating New Folders

You can create new folders on your computer and floppy disks.

The name you assign a folder can be from 1 to 255 characters long. You cannot use a period as well as the following characters: * ” ? : \ / | < >. 

The New command appears on the File menu. The Folder command appears on the New sub-menu.

Windows temporarily assigns new folders the name New Folder. You can replace this name by typing the new name.

Copying Files and Folders

You can copy files and folders listed in one location to another location. 

You will have two copies of the selected files and folders when you use the Copy and Paste commands.

The keyboard shortcut for the Copy command is Ctrl-C. The keyboard shortcut for the Paste command is Ctrl-V.

Moving Files and Folders

You can move files and folders listed in one location to another location. 

When you move a file or folder, the selected file and/or folder will only reside in the destination.

The keyboard shortcut for the Cut command is Ctrl-X.

The keyboard shortcut for the Paste command is Ctrl-V.

Renaming Files and Folders

You can rename files and folders using the Rename command on the File menu.

The keyboard shortcut for the Rename command is F2.

The name you assign a folder or file can be from 1 to 255 characters long. You can use most characters, including spaces. You cannot use the following characters: * “ ? : \ / | < >. You cannot use a period except to separate the file name from the extension.

File names can include an optional period and a one to three character extension. The file extension is optional as all Windows programs automatically assign an extension. Do not assign an extension to a folder.

Deleting Files and Folders

You can delete files and folders you are no longer using.

When you delete a file or folder from your computer, Windows places the information in the Recycle Bin.

When you delete a folder, you also delete all the files and folders contained in it. 

Windows prompts you to confirm the deletion of your files and folders.

The keyboard shortcut to delete a file or folder is Del.

For deletion without saving in the Recycle Bin press Shift+ Del.

Formatting A Floppy Disk

You should use caution when formatting a disk, as you will not be able to recover information on a disk that is incorrectly formatted.

Formatting a disk prepares the disk to be used, and may remove any existing information on the disk. If you are using an older disk or you want to recycle a disk with existing data, you may need to reformat it.

The Format command appears on the File menu. This command is only available when the focus is on the main My Computer window and the floppy disk is selected.

To cancel the formatting after it has begun, press Escape. Windows cancels the formatting operation. JFW reads the window title. Press Escape to close the dialog box. 

Copying A Floppy Disk

You can copy the contents of one floppy disk (called the source) to another disk with the same storage capacity (called the destination). 

When you use the Copy Disk command, Windows overwrites the contents of the destination disk.

You do not need two floppy disk drives to use the Copy Disk command. Windows prompts you to switch disks as needed.

The Copy Disk command appears on the File menu.

You need to set the Screen Echo to Say All in order to complete this task. 

Exercise 10.

a) Create a new folder on the drive C: and name it First. 

b) Create subfolders Second and Third in the folder First. 

c) Copy the files Letter.doc, Mix.doc and Format.doc from the folder C:\WordData into the new created folder Third.

d) Rename the file Mix.doc in the folder Third to Mixed.doc.

e) Copy the folder C:\WordData into the new created folder Second.

f) Delete the files Manually.doc, Jumbled.doc and Correct.doc from C:\First\Second\WordData

g) Move the files Program.doc and Format.doc from C:\First\Second\WordData into the C:\First\Third

h) Move the folder Third to the C:\First\Second

i) Replace the file Letter.doc from the C:\First\Second\WordDatas by the file Letter.doc from C:\WordData

Working With the Recycle Bin

Opening, Reviewing, and Closing the Recycle Bin Window

The Recycle Bin program icon appears on the Desktop. When you delete a file from your hard drive, Windows does not automatically remove the file from your computer. Instead, the file moves to the Recycle Bin where you can retrieve it if necessary.

Windows does not place files deleted from a floppy disk into the Recycle Bin. You cannot recover files deleted from a floppy disk.

You can run the Recycle bin by completing the following steps:

Press Insert-F6 to minimize all open windows and move cursor on Desktop.

Select the Recycle Bin icon by pressing R until JFW announces "Recycle Bin." Then, press Enter to open this window. JFW announces, "Recycle Bin List View Not Selected" followed by the first file in the Recycle Bin.

Maximize the Recycle Bin window by pressing Alt-Spacebar to activate the Program Control menu. Then, press X to select and execute the Maximize command.

Recycle Bin window is similar to My Computer or Explorer window, but in the list view it contains only deleted files. You can review the list with Arrow keys or pressing the first letter of the file that we are looking for.

To close the Recycle Bin window do the following:

Press Insert-T to verify the Recycle Bin window is the active window. JFW announces, "Title Equals Recycle Bin."

Press Alt-F4 to close this window.

After you close the Recycle Bin, the focus moves to the Taskbar. You cannot move the focus off the Taskbar until you either press Ctrl-Escape to open the Start menu, press Insert-F6 to move to the Desktop, or press Alt-Tab to activate a program button on the Taskbar.

Exercise 11.

Open, review, and close the Recycle Bin window.

Restoring Deleted Files

You can mark files that you want to retrieve and use the Restore command on the File menu. 

If you deleted a folder, the Recycle Bin only lists the files within that folder. If you restore a file that was originally located in a deleted folder, Windows recreates the folder, and then restores the file to it.

If you want to move files from Recycle Bin to the different folder as they were originally, use clipboard commands Cut (Ctrl-X), Copy (Ctrl-C), Paste (Ctrl-V).

Exercise 12.

Delete a file, which you created in Notepad (Wordpad) or Word program and retrieve it back.

Emptying the Recycle Bin

Deleted files remain in the Recycle Bin until you delete the file from the Recycle Bin, empty the Recycle Bin, or until the Recycle Bin reaches its maximum size. You can delete files from the Recycle Bin when you are sure you no longer need them.

You can open the Recycle Bin and empty it or delete selected files. 

The Empty Recycle Bin command appears on the File menu.
If you only want to delete a few files from the Recycle Bin, select the files and press the Delete key.

If you do not want to store the deleted files in the Recycle Bin, you can delete them pressing Shift-Delete keystroke instead of Delete key, or you can check the “Do not move files to the Recycle Bin” check box in Recycle Bin Properties dialog box. You can open this dialog box, if you choose Properties command in File menu.

Exercise 13.

Ensure that you do not need the files placed into the Recycle Bin,  and then empty the Recycle Bin.

Finding Files and Folders on Your Computer
You can use the Find dialog box to find files and folders you need. The Find dialog box allows you to search by using the file or folder name, date created or modified, file size, file type, and/or text within the file. You can also search by using part of the file or folder name.
You can use the Find dialog box at anytime. Use this dialog box when you want Windows to search for a specific file.

You can open the Find dialog box by using the Files and Folders command on the Find sub-menu. You can access the Find sub-menu by choosing the Find command on the Start menu.

Windows lists the results in a list box, which appears at the bottom of the Find All Files dialog box. This list box displays the result of the search in a table format, with four columns of information.
If the full path for a file or folder does not fit in the In Folder column, Windows only lists the first few folders in the path followed by ellipses to indicate the path is longer. You may try a couple of options to determine exactly where the file resides.

Exercise 14.

Find the Notepad.exe file using the Find dialog box.

Creating Shortcuts

You can create shortcuts to the programs, folders, and files you use often. Shortcuts can be icons on the Desktop or options on the Start menu. 

In order to create a shortcut, you must first find the program file.

Select the command Create shortcut in context menu (move to the file and press Shift-F10) for the program file. 

Cut shortcut to clipboard and paste it on Desktop or in the appropriate part of the C:\Windows\StartMenu folder, if you want it to be in Start menu. 

Another way to create a shortcut is to use the option on the Start menu Programs tabbed page in the Taskbar Properties dialog box. You can access this dialog box by choosing the Taskbar command on the Settings sub-menu. Open the Settings sub-menu by choosing the Settings command on the Start menu. This way is more difficult, especially for blind users.

It is useful to assign a shortcut key to a shortcut. You can do it by using the context menu.

Move the selection cursor to the shortcut on Desktop.

Open the context menu with Shift-F10 and choose Properties command.
When Properties dialog box appears, move to the Shortcut tab and Shortcut key edit field. Any key you press now is entered as a shortcut key with combination of keystrokes Ctrl-Alt.

Exercise 15.

a) Add the WordPad and Paint (Pbrush.exe) programs to the Start menu.

b) Add the Notepad program icon to the Desktop.

c) Assign a shortcut key (e.g. Ctrl-Alt-N) to the Notepad shortcut.

Removing Shortcuts

You can remove a shortcut from the Desktop by selecting the shortcut icon, then pressing the Delete key.

Move to the Desktop by pressing Insert-F6.
Move to the shortcut by pressing the first letter of its name.

Press Delete key.

You can remove shortcuts from the Start menu by deleting them from the C:\Windows\StartMenu folder or by using the Remove Shortcuts/Folders dialog box.

You can access the Remove Shortcuts/Folders dialog box by activating the Remove button on the Taskbar Properties dialog box.

Exercise 16.

a) Remove the Notepad program shortcut from the Desktop.

b) Remove the Paint program icon from the Start menu.

Control Panel

The Control Panel allows you to change the settings of your computer. Through the Control Panel you can add and remove programs and fonts, you can set the date and time, you can add new hardware or set up the printer, etc.

To Change Your Computer’s Settings

Press Windows key to open Start menu.

Find Settings command or press S to open Settings menu.

In the Settings menu choose Control Panel or press C to open Control Panel folder.

Find the item that represents the settings you want to change and press Enter.

Date/Time/Time Zone

Windows uses the date and time setting to identify when files are created or modified.

To change your computer's date and/or time:

In the list of Control Panel items, find the Date/Time item and press Enter.

The Date/Time Properties dialog box with two tabbed pages (Date(Time and Time Zone) appears and by pressing Tab and Ctrl-Tab you can review the items.

On the Date section, select the item you want to change:

To change the month, open the month list, and then choose the correct month.

To change the year, press the arrows in the year list, or type the correct year.

To change the day, move to the calendar by pressing Tab, and then choose the correct day by pressing arrows.

Under the Time section, select the item you want to change:

To change the hour, select the hour, and then type the correct value.

To change the minutes, select the minutes, and then type the correct value.

To change the seconds, select the seconds, and then type the correct value.

To change your computer's time zone:

In the list box on the Time Zone tab find your current time zone.

If you want your computer's clock to adjust automatically when daylight saving time changes, make sure the Automatically adjust clock for daylight saving changes check box is selected.

Fonts

To add a new font to your computer:

Open Control Panel, find Fonts, and press Enter – to open the Fonts folder.

On the File menu, choose Install New Font.

Choose the drive and the folder that contains the fonts you want to add, and then find the font you want to add.

To delete a font from your computer:

Open Control Panel, find Fonts, and press Enter – to open the Fonts folder.

Find the name for the font you want to delete.

On the File menu, choose Delete. 

Keyboard

To change the keyboard layout for an installed keyboard language:

Open the Control Panel, then find the Keyboard item to open the Keyboard Properties dialog box.
On the Language tab put the cursor to the language list box.

Find the language the keyboard layout of which you want to change, and then press the button Properties.

Choose the keyboard layout you want to use, and then press OK.

Printer

Through the Control Panel you can set up a printer, change printer settings, let the printer be shared, etc.

To set up a printer:

In the list of Control Panel items find the Printers item and press Enter.

Then choose the item Add Printer.

Follow the instructions on the screen.

If you want to use a shared network printer, you can set it up quickly by browsing for it in Network Neighborhood, choosing the printer's icon, and then choosing Install on the File menu.

Changing printer settings:

You can change your printer settings through the Control Panel or through the Printers command in the Settings in the Start menu a little more quickly:

Choose Settings command in the Start menu, then find Printers and then press Enter.

Select the printer you are using, then press Shift-F10 to open context menu.

Choose Properties command from the context menu of the printer.

The settings you can change depend on the type of printer you have. Review the different tabbed pages to see all of the options you can set.

Changing the printer properties will change them for all documents you print on this printer. To change these settings for one document only, choose Page Set-up or Print Set-up from the File menu in your document.

To share your printer: 

Choose Settings command in the Start menu, then find Printers and then press Enter.

Choose the printer you want to share.

On the File menu, find Properties, and then press Enter.

Switch to the tabbed page Sharing, and then choose Shared As. 

Hints that will  improve communication between a blind or visually impaired user and a computer with Windows 95(98 operating system:

Here we present some recommendations which could make the Windows environment friendlier for visually impaired users and could make their communication with the computer easier and faster.

1. Disable toolbar "Quick launch" and other toolbars of Taskbar -- do it in the ToolBars menu of the context menu of taskbar. This will substantially simplify your screen and desktop. All operations made through those toolbars can be done by use of menus and hot keys.

2. For the My Computer window use the view settings recommended in the My Computer part of this handbook.

3. Always maximize any window you are using.

4. When both screen reader and an enlarging software are needed, choose products that are able to cooperate with each other. The best way is to use both products from the same producer who declares and guarantees their mutual cooperation. Some producers even offer products with both functions integrated in one product. For examples, JAWS and Magic from Henter-Joyce, Supernova (Hal and Lunar) from Dolphin Computer Systems, Zoomtext from Ai-Squared. The screen reader Wintalker enables users to magnify characters and change colours of the foreground and background in its virtual window (off line-like mode).

5. For partially sighted users adjust the Mouse pointers: size, shape, colour, trail, speed of movement.

6. In the Internet browser, switch off any multimedia functions which blind or partially sighted users will not need to use. This will speed up the computer; the speed is decreased by the visually impaired person’s methods of communication with the computer.

7. Disable Office Assistant by renaming Actors folder (e.g. as actors0) or use appropriate JFW hot key.

8. Use a rich sound scheme, which can help to identify what happened on the screen by means of different sounds.

9. Keep in mind that:

Adaptations which are good for one kind of visual impairment can be bad for another.

Settings which are good for people with standard sight may not be suitable for visually impaired people.

Some changes of settings can disable access to a computer for visually impaired persons, and restoration of the original settings might be impossible without the help of a sighted person.

10. When a computer is used by more than one visually impaired person and some task requires changing its settings, restore the original settings after finishing that task. It is recommended to accomplish temporary changes, like switching High Contrast on and off, by means of appropriate standard windows hot keys rather than by a permanent change in settings. Each change of settings intended to be permanent should be discussed with the visually impaired users of the computer in question.

Experience From Real Courses

We did not offer a special course for Windows; rather, we conducted one full course that covered Windows and MS Word. The contents of the course are mentioned below, as well as a description of some problems which occurred during the course and suggestions for possible solutions.

Be aware of the fact that some of our comments could be influenced by the version of screen reader, Windows applications and configuration of computers that we used and therefore may not be valid in your conditions.

Contents of the Course

In the courses we used the following structure:

Movement among desktop, taskbar, start menu, etc.

The area for application -- window, its parts -- main menu, control menu.

Notepad and Word.

Opening of the file.

Reading commands.

Working with the blocks.

Explorer window.

Main elements.

Copying, moving, deleting files and folders, using two Explorer windows and Clipboard.
Creating a shortcut and moving it to the Desktop, assigning shortcut keys.

Setting of the file attributes.

Context menu.

Control panel -- fonts, sounds, adding/deleting hardware and software, settings for handicapped, date and time.

Start menu and adding/deleting some items.

Number of Participants

It is essential not to have a large number of participants because it enables us to work with participants individually and to proceed quickly.

Keyboard Commands

New users learn the keyboard commands for Windows, applications and screen reader simultaneously. This means that they have to learn many commands in a short time, which might cause problems. It is recommended that you use access software with functions similar to those the users are accustomed to working with.

Orientation on the Screen

Blind users cannot see the whole screen at once, and for this reason they often have a problem orientating themselves on the screen, to find out what is on the screen and where the focus is placed.

If a shortcut icon on the desktop is overlapped by a window, Jaws cannot read it; therefore it is important to minimize all windows before moving onto the Desktop (Insert-F6 keystroke).

If the block overhangs the size of the window, Jaws can read only the part of the text which is visible in the window (it is easier for sighted users to observe that it is necessary to scroll the window, whereas blind users will have a problem with this). You can avoid this situation if the window is maximized and the WordWrap switch is on.

For a blind user it is a problem to remember how to move in the current situation, when to use arrows, Tab, Alt-Tab, Ctrl-F6, etc. Blind users can overcome this problem only through  practice. Many exercises are needed.

In some cases JAWS does not show that the focus is on the Taskbar. When you press the Tab key, it just says “Tab.”

Dialog Boxes
It is necessary to pay attention to the orientation in dialog boxes. When the user lets the screen reader read the contents of the whole dialog box, he can easily get lost in the amount of text produced by the speech synthesizer. He often does not know if it is more suitable to use Tab or Shift-Tab key, and sometimes, even if the focus is on the item searched, he does not realize it and therefore does not change it.

Tactile diagrams are very useful and helpful teaching aids for overcoming these problems. The strategy is to learn hot keys, especially in frequently used dialogs.

Menu Items

It may be a problem for a blind user to realize that the first item in a menu is already the current item and there is no need to find it with arrows. Another problem could be to realize that if left/right arrow is pressed, the reaction depends on the kind of item (command or sub-menu) where the focus is set. It is necessary to explain this behavior properly at the very beginning.

Speech Synthesiser
For independent work with this system, you need a high quality speech synthesizer with full national language support; otherwise, a good knowledge of English is necessary. Use of the Braille line instead of a speech synthesiser, or both together, might make the work more transparent.

Notepad Application

When we used Notepad to learn JAWS reading commands, several problems occurred.

Some users opened the Notepad each time they wanted to open a text file. After a while, they had too many Notepad windows on the screen and they did not remember which file was in which Notepad window.

It is not possible to find out the number of the current line and column in Notepad Window.

To avoid both problems mentioned above, we used MS Word instead of Notepad.

My Computer

If you choose another command to arrange the items in the window as the List command, JFW does not tell you if the item on which your cursor is located is a folder or a file. The announced function Insert-Tab did not work on our computers. If you want to have this information, you must change the View options of My Computer window and arrange the items of the window by Details command.

Deleting Files or Folders

If you have deleted a file or a folder by mistake, you can use Undo command. JFW should tell you the name of the restored item, but it announces only “Undo delete.”

WORD 97 WITH JAWS 3.3 FOR WINDOWS

Initial Settings

Control Panel Settings

Use Control panel settings as recommended in the previous chapter (about Windows).

JFW Settings

It is recommended that you use the default JFW settings for Word unless otherwise indicated.

Verbosity: Beginner

Screen Echo: Highlighted

Helpful Keystrokes

Use helpful keystrokes recommended in the previous chapter.

Disable the Microsoft Office Assistant

Office assistant is an animated graphic mark. It was created to help the user (if you click on it, the help window appears) but it is not speech friendly and can interfere with JFW. If it is not disabled before the beginning of the work with Word 97, you can close it by pressing Ctrl + Insert + F4.

The Layout and Elements of the Word Screen

MS Word

MS Word is a word-processing application, which allows you to create documents, store them on your computer or floppy disk, edit documents, and print them on a printer. Word-processors simplify the editing process because you do not have to retype the entire document when you want to make any changes. You can easily fix typos; insert or remove paragraphs, words and sentences; rearrange your text; and change the appearance or format of the text. Word-processors are the most common computer applications.

Opening Word

There are several ways to open Word. The first is by selecting the command from the Start menu (from the Program sub-menu, usually). You can also open Word by activating a Word program icon on computer Desktop or by pressing hot key (if you have set it).

Whenever you open Word, a new blank document appears in the document window and the insertion point appears on the first line of the document.

It is recommended that you verify that the program and document windows are maximized after you have started the program (use the application and document control menu to do this).

The Word Screen

Open Word (if Word is running but Word window is not active, hold down the Alt key and repeatedly press the Tab key until JFW announces, "Microsoft Word - Document1."). Press Insert-4 to set the Graphics mode to Active. JFW announces, "Active Graphics Mode." If you do not change mode to Active Graphics mode, JFW will not read all the buttons on the toolbars.

You can review the Word screen using the JAWS Cursor (press numeric minus to activate it). Press Page Up and the Home key to move the JAWS Cursor to the top, left-hand corner of the screen. Then, press Insert-Down Arrow to review the screen. JFW automatically reads the entire screen beginning with the Application Control Menu Box and ending with the status bar.

To review the screen element by element, move the JAWS Cursor to the top left-hand corner of the screen and press Ctrl-Right Arrow.

When you are finished reviewing the screen, press Insert-4 to set the Graphics mode to Standard. JFW announces, "Standard Graphics Mode." You should always activate the PC Cursor (by pressing numeric plus) when you are finished using the JAWS Cursor.
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Picture 2.1. Word screen with blank document Document1.

Another possibility to explore the screen is to use the PC Cursor. You can switch between the most important parts of the screen by pressing the following keystrokes:

Insert-T to read the title bar.

Insert-End to read all information in the first line of the window (control icon, title bar, minimize icon, maximize icon).

Alt key to activate the menu bar (focus is on its first item) and then arrows to move between menu items.

Ctrl-Tab (if the menu bar is active) to switch to toolbars.

Word uses buttons and combo boxes on toolbars to give the user a quick way to access the most commonly used commands. Most commands on the toolbars are also found on the menus.

You can show or hide toolbars. However, the Standard and Formatting toolbars must appear on the screen in order to use some keyboard shortcuts with JFW.

The toolbars, that can be shown or hidden, appear on the View menu on the Toolbars sub-menu. (Checked toolbars appear on the screen.)

Alt-Space to activate the application control menu and then arrows to move between menu items.

Alt-Dash to activate the document control menu.

Insert-Page Down to read the status bar. The information on the status bar depends on whether you are working in a document or selecting or carrying out commands. You must activate the JAWS Cursor to read each element on the status bar individually.

Exiting Word

The Exit command appears on the File menu and also on the application control menu. The faster way to exit Word is to press Alt-F4.

If you made changes to a document since the last time you saved it, a Microsoft Word dialog box appears, prompting you to save the document before exiting Word. To prevent mishaps, you should always save your documents before activation of the Exit command.

Exercise 1.


Open the Word, review the Word screen and close the application window.

Working With Documents

Creating a New Document

When you open Word, a new document, titled Document1, automatically opens. However, you can create a new document at anytime while you are working in Word.

Word uses templates to define default settings, such as margins, font, and font size, for documents. Unless specified otherwise, all new documents use the Normal template, which represents the most commonly used settings.

The New command appears on the File menu, but you can create a new document also by pressing Ctrl-N.

Entering Text

Once a new document is opened, you are ready to begin typing in text. You do not need to know when your text reaches the margin of the page. Word automatically "wraps" text to the next line when it reaches the margin. Also, you should not press Tab or the Spacebar numerous times to indent lines of text. If you do this, the printed text may not be aligned correctly. (See Formatting Text for more information.)

If you want to insert a blank line, press Enter twice.

You should not press Enter numerous times to insert a new page. If you want to insert a new page, press Ctrl-Enter.

Press the Up and Down Arrow keys to read the text you typed. To verify you inserted a new page, press Insert-Page Down. Press Ctrl-Home to move the insertion point to the beginning of the document.

Exercise 2.


Create a new file and write to the first line: ”This is the first line of the text.” Then write to the second and third line: ”This is the second line of the text.” and ”This is the third line of the text.”

Saving a Document

The Save command appears on the File menu but the keyboard shortcut Ctrl-S can also be used.

If you would like to save a document under a different name, use the Save As command. When you use the Save As command, the existing document remains intact. Any changes you made to the document are reflected in the document you created by the Save As command.

The first time you save a document or when you are using the Save As command the Save As dialog box appears. The dialog box is prompting you to assign a name and specify the drive and directory in which you want to save the document.

In the Save As dialog box, make sure you selected the correct drive in the Save In combo box, opened the correct folder in the list box, and assigned a valid name in the File Name field. If you know in which drive and folder you want to save the document, you can type the full path to indicate this.
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Picture 2.2. The Save as dialog box.

You should save your documents frequently; otherwise, you run the risk of losing the information you entered since the last time you saved the document.

Exercise 3.

Save the document edited in the previous exercise under the name MyDoc1.doc and then save it again under the name MyDoc2.doc (use the Save as command).

Closing a Document

When you finished working in a document, you should close it. You can close documents without exiting Word. If you choose to close a document before you save it, a dialog box appears asking you if you want to save it.

The Close command appears on the File menu. The keyboard shortcut for closing a document is Ctrl-F4.

Exercise 4.

Close documents MyDoc1.doc and MyDoc2.doc saved in previous exercise.

Opening an Existing Document

You can use several methods to open documents in Word. The method you choose depends on whether you know the path for the file, whether you know the file name, and how recently you worked in the document.

The Open command appears on the File menu. You can use the keyboard shortcut Ctrl-O. Word uses the Open dialog box to prompt you for the name and location of the file you want to open. You must specify directory and drive in which your file resides. The Open dialog box is formatted much like the Save As dialog box.

Press the Tab key to move forward through the dialog box fields. 

To read a selected item again, press Shift-Insert-Down Arrow.
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Picture 2.3. The Open dialog box

The File Name box lists only those documents which reside in the directory in which you last saved or opened a document. In addition, it only lists those documents with the .DOC extension. To make sure Word is pointing to the correct drive and directory, you should check the Drives and Directories fields.

If you already know in which drive and directory a file resides, you can type in the entire path in the File Name edit field. This shortcut can save you some keystrokes when opening a file.

For quick access to your documents, Word lists the last four documents you used before on the File menu. If the document you want to open does not appear on the File menu, you can open it using the Open dialog box.

Exercise 5.

Open the document Letter.doc and read its contents.

Working With Multiple Documents

Word allows you to have more than one document open at a time. When you have more than one document open, only the active document appears on the screen. You can switch among open documents in two ways. The first method uses the Window menu. The second method uses a keyboard shortcut Ctrl-F6.

Exercise 6.


Open the documents MyDoc1.doc and MyDoc2.doc (the file Letter.doc is still open), try to switch among them using the Window menu and using the keyboard shortcut. Compare their contents and close them.

Navigating Through and Reading a Document

You can move in your document and read its contents several ways: by characters, by words, by lines, by sentences, by paragraphs, by screens and by pages.

If you want to move and read by characters:

To read the current character, press Center key.
To move one character to the right or left and read it, press Right or Left Arrow.
To move one line up or down and read the whole line, press Up or Down Arrow.
To switch to the special mode, where the word is read by characters and every character is explained by the word beginning with this character (the word ”and” is read Alpha November Delta), press Center key twice. If you want to switch back to the normal mode press Center key once.
If you want to move and read by words:
To read the current word, press Insert-Center.
To move to the next/previous word and read it, press Insert-Right(Left Arrow.
To switch to the spelling mode, press Insert-Center, Center.
If you want to move and read by lines:
To read current line, press Insert-Up Arrow.
To move through the lines to the end of document and read them (the last line twice), press Insert-Down Arrow.

To move to the beginning of the document and read the first line, press Ctrl-Home.
To stop reading and move the cursor before the last word read, press Ctrl.
To move to the last line of the document and read it, press Ctrl-End.
To read the line from the beginning to the cursor position, press Insert-Home.
To read the line from the cursor position to the end of line, press Insert-PgUp.
Commands for reading special lines:

To read the title line, press Insert-End.
To read the status bar, press Insert-PgDn.
To switch to the JAWS Cursor, press – (minus key on the numeric keyboard).
If the JAWS Cursor is active, you can move to the status bar pressing PgDn.
To switch to the PC Cursor, press + (plus key on the numeric keyboard).

If you want to move and read by sentences:

To read the current sentence, press Alt-Center.
To read the previous sentence and move the cursor to its beginning, press Alt-Up Arrow.
To read the next sentence and move, press Alt -Down Arrow.
If you want to move and read by paragraphs:
To move to the previous paragraph and read it, press Ctrl-Up Arrow.
To move to the next paragraph and read it, press Ctrl -Down Arrow.
To move among the paragraphs, the cursor is before the first character of the paragraph.
If you want to move and read by pages:

To move to the next page and read the first line, press Ctrl-PgDn.

To move to the previous page and read the first line, press Ctrl-PgUp.

It is important to remember that there is a difference between movement between screens (PgDn, PgUp) and movement between pages.
Changing the Document View

Word allows you to choose one of six different view options. Each view option affects how your document and the document's pages appear on the screen. Normal view is the default document view. You should always use this view while typing, editing, and formatting your documents. JFW reads formatting information more accurately in this view. You should work in Page Layout view when you want to check header and footer information or to verify on which page information will print. The view commands appear on the View menu.

Exercise 7.

Open the document Mobidy.doc and read its contents. Try to move in it by characters, by words, by lines, by sentences, by paragraphs, by screens and by pages. Finally close this document without saving it.

Editing a Document

Selecting Text

In order to make changes to a text you have typed, you have to select the text. Selecting the text tells the computer in which text to direct its attention.

To verify your selection at any time, press Shift-Insert-Down Arrow.

You can press and hold the Shift key while pressing

The Right or Left Arrow key to select a single character.

The Up or Down Arrow key to select a line in the document.

You can press and hold Shift-Ctrl while pressing the Right or Left Arrow key to select a word.

You can press the Shift-End (or Home) to select the text from the cursor position to the end (or beginning) of line.

You can press Control-A to select all text in the document. A selection cursor appears around the selected text.

To cancel a selection, press any arrow key to move the insertion point.

Correcting and Deleting Text

To delete one character at a time, press either the Delete key or the Backspace key. The Delete key removes character to the right of the insertion point. The Backspace key removes the character to the left of the insertion point. JFW only reads the character you are deleting when you use the Backspace key. When you use the Delete key, JFW reads the character the insertion point lands on after the deleted character.

To delete one word to the left of the insertion point, press Ctrl-Backspace. 

To delete one word to the right of the insertion point, press Ctrl-Delete.

To delete more than one character at a time, select the text you want to delete. Then, press the Delete key.

To replace text with new text, select the text you want to replace. Then type the new text. The text you type replaces the selected text. 

Note: JFW does not indicate the text was deleted or replaced. Read the text again using a JFW reading command such as Insert-Up Arrow.

Copying, Cutting and Pasting Text

The Cut command, Copy command and Paste command appear on the Edit menu. The keyboard shortcut for copying is Ctrl-C, for cutting is Ctrl-X, and for pasting is Ctrl-V.

The Paste command does not remove the text from the Clipboard. If you want to paste the same text in several different locations, move the insertion point to the place where you want the text to appear. Then, press Ctrl-V. Repeat the paste as often as necessary.

Using the Undo/Redo/Repeat Commands

Word's Undo command allows you to reverse editing or formatting changes you’ve made. You can use the Redo/Repeat command and cancel the Undo command.

The Undo and Redo commands appear on the Edit menu and their names depend on the last action taken.

The keyboard shortcuts for Undo and Redo commands are Ctrl-Z and Ctrl-Y, respectively.

Exercise 8.
Open the file Manually.doc, read its contents and manually correct the mistakes you find:

a) Insert a missing comma.

b) Put together two words by erasing the space.

c) Erase double appearance of the word (by characters, CTRL + Backspace, Ctrl + Del).

d) Insert the text into the sentence before the last one. It should look like this:” I have been concentrating on such editing features as inserting text into a document, deleting text from a document and correcting errors.”

Exercise 9.
Open the file Jumbled.doc.

a) Verify you have opened  the correct  file by reading the title line and save the document under a new name (e.g. Jumbled1.doc). 

b) Shuffle the lines in this file to get the correct  order of lines.

c) Shuffle the words in the sentence ”This is the text of line ninth” to get correct sentence. 

d) Finally, save and close the file.

Exercise 10.
Open the file Mix.doc. There are two documents mixed in it. Create two new files and separate the text from the file Mix.doc into these  new files. 

Using the Find, Replace, and Go To Commands

The Find, Replace, and Go To commands are helpful editing commands. You can use the Find and Go To commands to move to a specific place in your document. Use the Find command to move to a specific word or special character in your document. If you want to move to a different page in your document, use the Go To command. The Replace command allows you to search your document for text, formats, special characters, and other elements and replace that information with the information you specify.

The Find command appears on the Edit menu and the keyboard shortcut is Ctrl-F.

If you press Ctrl-F the Find dialog box appears. The dialog box is prompting you to enter the text for which you want to search.

When Word finds the first occurrence of the word searched, it places a selection cursor around the text. The Find dialog box remains open and active.

Press Insert-C to verify that the selected word is the specific occurrence of the word you want. JFW announces, "Say Word in Context," followed by the line of text in which the word number appears. The focus remains in the Find dialog box.

If JFW does not read the word in context, the Find dialog box may be covering the line in which the word appears. You may need to maximize both the application window and the document windows. If you are sure the windows are maximized, you must close the dialog box in order to read the line in which the word occurs. Then press Ctrl-F to begin the search again.

Press Escape to close the Find dialog box.

The Replace command appears on the Edit menu. It can be activated using the shortcut key Ctrl-H.

 After the Replace command is activated the Replace dialog box appears. The dialog box is prompting you for the text you want to replace and the text you want to insert in its place.

 When Word finds the first occurrence of the word, it places a selection cursor around the text. The Replace dialog box remains open and active.

To verify the selected word is the specific occurrence of the word you want to replace, press Insert-C. The focus remains in the Replace dialog box.

If you are sure you want to replace every occurrence of the text, activate the Replace All button.

The Go To command appears on the Edit menu. The keyboard shortcut for Go To command is F5 or Ctrl-G. The dialog box appears, prompting you for the page number to which you want to move.

Exercise 11.

Open the file Findandreplace.doc

a) Find all occurrences of the word ”press” and determine  the context of the words found (Insert + C).

b) Find the word ”Press” (check the choice Match case) and determine the context.

c) Replace some of the words ”search” by the word ”find” according to the context (check the choice Find, whole words only).
d) Replace all “Word” by the words ”MS Word” (check the choices Match case, Find whole words only and use the button Replace All).
e) Find all text in this document in which  formatting is set to: Arial, bold, centered.

f) Determine  the format of the searched text.

Close the file Findandreplace.doc without saving it.

Formatting a Document

I. Character Formatting
About Character Formatting

Every character you type has attributes, such as font and font size, associated with it. Collectively, a character's attributes are known as the character's format. A character's format affects how the character appears on the screen and on the printed document.

When you begin typing in a new document, Word uses the default format for any text you type. To change the appearance, or formatting, of your text, you must specify new attributes. You can change the formatting using keyboard shortcuts or by using the Font dialog box.

Remember, a document's appearance often influences the reader's judgement about the quality of the document.

The font, font size, bold, italic, and underline attributes appear on the Formatting toolbar. In JFW, the Formatting Toolbar must appear on the screen in order to use the format keyboard shortcuts.

A font is a collection of characters that have a particular design. The font size determines how large or small a character appears. The font and font size you can use to format the text in your document depends on the fonts you have installed on your computer and printer. 

Most professional documents are produced in the Times New Roman, Helvetica, or Arial font with a twelve-point font size. However, you should choose the font and font size which best fits your document.

You can select text for formatting in two ways.

If you want to change the format of text you have already typed, you must select the text before using a format command.

If you want to define the format of text before you type it, select the commands for the formatting style you want before you begin typing. Word applies the format at the insertion point. The text you type from that point forward appears in the new formatting until you make another format change.

The second method is usually used when you have decided how you want the text to appear.

Checking Text Attributes

You should check the text attributes when you change the format to verify the text appears as you defined it. Checking attributes is part of editing your document for consistency and accuracy.

Important: You must set the document view to Normal and the Zoom to 75 percent in order to check the attributes in JFW. If you do not use these settings, JFW may read the font size incorrectly.

To set the document view to Normal

Open the View menu and verify whether the Normal view command is checked.

If the command is not checked, press Enter to set the view to Normal.

If the command is checked, press the Alt key to exit the menu bar without selecting a command.

To set the zoom to 75 percent

Open the View menu and press Z to select and execute the Zoom command. The Zoom dialog box appears. The Zoom To options are formatted as radio buttons.

Press the Down Arrow key until JFW announces, “75% Radio Button Checked.”

Press Enter to accept the information in the dialog box.

Now you can select a text in the document and check the character attributes by pressing
Insert-F.

Changing the Font, Font Size, and Other Formatting

You can change the format of your text in two ways. The first method involves using the Font dialog box. The Font dialog box allows you to change several attributes at once. The second method uses keyboard shortcuts to make changes. Use keyboard shortcuts when you want to make only a few changes.

If you want to change text formatting using the Font dialog box press Alt-O to pull down the Format menu and press Enter to execute the Font command. The Font dialog box appears. This dialog box contains two tabbed pages, Font and Character Spacing. You may also open the Font dialog box using the keyboard shortcut, Ctrl-D.

Press the Tab key to move forward through the Font dialog box fields. 

The Font field is both an edit field and a list box. Type a font name in the edit field, or press the Up and Down Arrow keys to select a font. The keyboard shortcut for this field is Alt-F.

The Font Style field is both an edit field and a list box. Type a font style in the edit field, or press the Up and Down Arrow keys to select a style. The keyboard shortcut for this field is Alt-O.

The Size field is both an edit field and a list box. If the size you entered is not available on the current printer, Word chooses the closest available size. Type size in numbers in the edit field, or press the Up and Down Arrow keys to select the size. The keyboard shortcut is Alt-S.

The Underline field is a combo box. Type in an underline type, or press the Up and Down Arrow keys to select a type (Single, Words Only, Double, Dotted). The keyboard shortcut is Alt-U.

The Color field is a combo box. Type a color, or press the Up and Down Arrow keys to select a color. Press Alt-C to move to this field.

The Strikethrough field is a check box. This attribute draws a line through selected text. Press Alt-K to select this option. 

The Superscript field is a check box. This attribute reduces the font size and then raises the selected text above the base line, which is an imaginary horizontal line directly beneath a line of the text. You can press Alt-P to select this option.

The Subscript field is a check box. This attribute reduces the font size and then lowers the selected text below the base line, which is an imaginary horizontal line directly beneath a line of the text. Press Alt-B to select this option.

The Hidden field is a check box. This attribute hides text that you do not want to appear on the screen or print, such as notes or comments. The Options command on the Tools menu allows you to show hidden text. The keyboard shortcut for selecting this option is Alt-I.

The Small Caps field is a check box. This attribute shows lowercase characters as uppercase characters and reduces their size. The Small Caps option does not affect numbers, punctuation, non-alphabetic characters, or text typed in uppercase letters. Press Alt-M to select this option.

The All Caps field is a check box. This attribute shows lowercase characters as uppercase characters. It does not affect numbers, punctuation, non-alphabetic characters, or text typed in uppercase letters. The keyboard shortcut for selecting this option is Alt-A.

Use the Default button (Alt-D) when you want to change the default format settings. (When you change the default formatting, Word saves the new settings in the current template and overwrites the old settings.)

To check/uncheck the check boxes, press the Spacebar. To determine whether the check box is checked or not checked, press Insert-Center.

Use keyboard shortcuts when you want to make only a few changes.

The keyboard shortcut, Ctrl-U, is a toggle command. That is, it will either turn underlining on or off, depending on the current formatting. Word always uses the single underline style whenever the keyboard shortcut is used.

The keyboard shortcut, Ctrl-B, is a toggle command. That is, it will either turn bold on or off, depending on the current formatting.

The keyboard shortcut, Ctrl-I, is a toggle command. That is, it will either turn italic on or off, depending on the current formatting.

You can change the font by pressing Ctrl-Shift-F.

You can change the font size by pressing Ctrl-Shift-P.

To make the text next larger size, press Ctrl-Greater Than Sign (>).

To make the text next smaller size, press Ctrl-Less Than Sign (<).

To make the text one point larger, press Ctrl-Right Bracket (]).

To make the text one point smaller, press Ctrl-Left Bracket ([).

Note: JFW does not indicate the point size is changing. Press Insert-F to verify font point size.
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Picture 2.4. The Font dialog box

Copying, Pasting, and Removing Text Format

If you need to apply the same formatting style to several characters, words, or series of words, you can save yourself several keystrokes by using the Copy Format (Ctrl-Shift-C) and Paste Format (Ctrl-Shift-V) commands. If you want to quickly remove the attributes you added to text, not including font and font size, use the Remove Format command (Ctrl-Spacebar). When you remove the formatting, Word uses the default attributes as defined in the Normal template.

Exercise 12.

Open the MyDoc1.doc file and try to find out the text formatting of the document. Now modify the text according to the following instruction:

a) Change the format for the first line using the Font tab on the Format dialog box. Change the font to Desdemona, font style to regular, and font size to fourteen. Add single underlining. Finally verify the format using the Format dialog box.

b) Change the format for the second line using the keyboard shortcuts. Change the font to Courier New, font style to regular, font size to twelve. Add single underlining. Finally, verify the format using the keyboard shortcut.

II. Paragraph Formatting
About Paragraph Formatting

Just as a character has a specific format, each paragraph also has a specific format. Typical attributes in a paragraph format include line spacing, alignment, and spacing before and after the paragraph. The paragraph’s format affects the way it appears on the screen and on the printed document.

When you begin typing in a new document, Word uses the default paragraph format settings. To change a paragraph's format, you must specify new attributes using keyboard shortcuts or using the Paragraph dialog box.

Important: When you change a paragraph's attributes, the whole text of the paragraph is affected (even if you select a part of text in a paragraph).
The alignment, numbers and bullets, and indentation attributes appear on the Formatting toolbar. In JFW, the Formatting toolbar must appear on the screen in order to use the format keyboard shortcuts. 

In Word, the term Paragraph refers to any block of text, graphics, object, or any other item followed by a paragraph mark. Each time you press Enter you insert a paragraph mark.

You can select a paragraph for formatting in two ways.

If you want to change the format of a paragraph that is already in your document, you must select the paragraph before using a format command.

If you want to define the format of a paragraph before you type it, make sure you are on a blank line. Then, select the commands for the formatting style you want before you begin typing. Word applies the format at the insertion point. Paragraphs from that point forward appears in the new formatting until you make another format change.

Points to Remember:

Do not press Enter at the end of each line. When you press Enter, you are inserting a new paragraph mark. Moreover, if you do this and want to add or delete text, you will have to manually reconstruct each line. Word automatically wraps text to the next line when it reaches the right margin.

Do not press Tab or the Spacebar numerous times in order to indent lines of text. If you do this, the printed text may not be aligned correctly. This may also result in additional work  when you want to add or delete the text. Instead, you should use the Indent command. 

Changing Alignment, Line Spacing, and Other Formats

You can change the format of your paragraph in two ways. The first method uses the Paragraph dialog box. The Paragraph dialog box allows you to change several attributes at once. The second method uses keyboard shortcuts to make changes. Use keyboard shortcuts when you want to make only a few changes.

To change the formatting of selected paragraphs using the Paragraph dialog box, press Alt-O to pull down the Format menu and press P to select and execute the Paragraph command. The Paragraph dialog box appears. This dialog box contains two tabbed pages, Indents and Spacing, and Text Flow. 

Press the Tab/ Shift-Tab key to move forward/ backward through the dialog box fields.

The Indentation Left and Indentation Right fields are spin boxes. These fields list the current number of inches the paragraph is indented from the left/right margin. Type the number of inches you want the paragraph to be indented from the margin, or press the Up and Down Arrow keys to select a number. If you want the text to appear in the margin, type in a negative number. Press Alt-L or Alt-R to move to these fields.
The Special field is a combo box. This field defines the type of indentation for the first line of the paragraph. Press Alt-S to move to this field. Type in an indentation type (none, first, hanging), or press the Up and Down Arrow keys to select a type. 

The By field is a combo box. This field lists the amount of indent for the First Line or Hanging indent. Press Alt-Y to move to this field. 

The Spacing Before and Spacing After fields are spin boxes. These fields specify the amount of space, which appears above/after the first line of the paragraph. Press Alt-B or Alt-E to move to these fields. 

The Line Spacing field is a combo box. This field defines the amount of vertical space between the lines of the text. Press Alt-N to move to this field. Type in a spacing type (Single, 1.5 Lines, Double, At Least, Exactly, Multiple), or press the Up and Down Arrow keys to select a type. 

The At field is a combo box. This field lists the amount of line spacing you want. You can only use this field when you have selected At Least, Exactly, or Multiple in the Line Spacing field. Press Alt-A to move to this field.

The Alignment field is a combo box. This field defines the position of the paragraph on the page. Press Alt-G to move to this field. Type in an alignment type (Left, Centered, Right, Justified), or press the Up and Down Arrow keys to select a type. The following types are available.

To read the selected field again, press Insert-Up Arrow.

You can use keyboard shortcuts for formatting a paragraph:

Press Ctrl-L
to set alignment of the current paragraph to Left.

Press Ctrl-R
to set alignment of the current paragraph to Right.

Press Ctrl-E
to set alignment of the current paragraph to Centered.

Press Ctrl-J
to set alignment of the current paragraph to Justified.
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Picture 2.5. The Paragraph dialog box

Setting Tab Stops

Word allows you to define the number of spaces the Tab key and Indentation settings will shift your text from the left or right margins.

Tab Stop settings only affect the selected paragraph, the paragraph in which the insertion point appears, or the paragraph following the changes. If you want to change the Tab Stop settings for several paragraphs, select the paragraphs before making any changes. To save time, you should decide on the Tab Stops before you begin typing. When you press Enter, the Tab Stops settings are carried to the next paragraph.

Tab Versus Indent: When you press Tab, you are indenting only the first line in the paragraph. If you want all the lines in the paragraph to be indented on either the right or left side, or both sides, use Indent. To indent your paragraph, use the Paragraph dialog box.

To set Tab Stops move the insertion point to the beginning of the document (Ctrl-Home).

Press Alt-O to pull down the Format menu.

Press T to select and execute the Tabs command. The dialog box is prompting you to enter the tab stop settings for the current paragraph.

Press the Tab key to move forward through the dialog box fields.

The Tab Stop Position field is a list box. This field lists the tab stops set in the selected paragraphs. If you are working in a new document or paragraph in which no tab stops have been set, this field is empty. Press Alt-T to move to this field. To set a new tab stop, type the measurement. To change a tab stop, press the Up or Down Arrow key to select it, and then type a measurement.

The Default Tab Stops field is a spin box. This field contains the default measurement for tab stops. Press Alt-F to move to this field. Type in a new measurement, or press the Up or Down Arrow key to select a new measurement.

The Alignment radio buttons indicate the alignment of text at a tab stop. Word allows you to define a different alignment for each tab stop. You may choose one of the following alignment options: Left, Center, Right, Decimal, Bar.

The Leader radio buttons indicate the type of character which will fill the empty space to the left of a tab stop. You may choose one of the following options: None, Dotted, Dashed, and Solid.

The Set button accepts the new or changed tab stop settings you defined in the Tab Stop Position list box.

The Clear button allows you to select specific tab stops to remove. To remove a tab stop, select the tab stop in the Tab Stop Position list box. Then, press Alt-E to activate the Clear button.

The Tab Stops To Be Cleared field lists the tab stops that will be cleared from the selected paragraphs when you choose the OK button. To read the tab stops in this field, use JAWS Cursor.

The Clear All button removes all tab stops listed in the Tab Stop Position list box.

Note: You must press Insert-S to set the JFW screen echo to Say All before you activate this button. If you do not set the screen echo to Say All JFW will not read this button. Press Alt-A to activate this button.

*Pressing Escape can close the Tabs dialog box.

Verifying Tab Alignment: Unfortunately, you need sighted assistance to verify whether the tabbed text is properly aligned. You can search for the Tab character using the Find dialog box. Choose the Special button.

Creating Numbered and Bulleted Lists

Bullets and Numbers are often used to list or itemize text. When you choose the Bullets and Numbering option, whenever Enter is pressed, Word indents the paragraph and places a bullet or number next to the paragraph.

The Bullets and Numbering option is a part of the paragraph format. Therefore, Bullets and Numbering only affects the selected paragraph, or the paragraph following the changes.

To create a bulleted list:

Select the lines you want to have bulleted

Press Alt-O to pull down the Format menu.

Press N to open the Bullets and Numbering dialog box. The Bullets and Numbering dialog box is divided into three tabs: Bulleted, Numbered, and Multilevel.

Verify you are on the Bulleted tab (Insert-T). If not, press Ctrl-Tab until JFW announces, "Bulleted." The Bulleted page lists six types of bullets. The choices appear in two rows of three.

In order to select a bullet, you must route the JAWS Cursor to the PC Cursor (Insert-Minus). The JAWS Cursor and the PC Cursor are both positioned on the first bullet option on the first row.

Important: JFW only reads the last four of the six bullet options. It does not read the first two options in the top row correctly. (It refers to them as space markers.) Usually, the first option is a small, darkened circle and the second option is a larger, darkened circle.

Use all the arrow keys to position the JAWS Cursor on a bullet options correctly. 

Select a bullet by moving the JAWS Cursor to its option.

Press the Slash key on the number pad to click the left mouse button. Word moves the selection cursor to the bullet option indicating you have selected this option.

Press Enter to activate the OK button. 

To determine whether the selected bullet appears next to the item, use the JAWS Cursor.

To create a numbered list:

Select the lines you want have numbered:

Press Alt-O to pull down the Format menu.

Press N to open the Bullets and Numbering dialog box.

Select the Numbered tab by pressing Ctrl-Tab.

Press Tab to select the first option. Then, press the Right Arrow key to review the options.

Choose the scheme and press Enter to activate the OK button.

Checking Paragraph Attributes

The method used to check a paragraph's formatting varies according to the attribute you want to verify. The JFW command Insert-F indicates the character attributes and the paragraph alignment based on the location of the insertion point. To determine the indentation and line spacing for the paragraph in which the insertion point is located, you must check the information in the Paragraph dialog box.

Exercise 13.

Open the Format.doc file and try to determine the layout of the information in the document. Then modify data according to the following instructions.

a) Change the format for the first paragraph using the Font tab on the Format dialog box. Change the paragraph formatting: Alignment to centered, indentation to hanging, and line spacing to one and half. Finally, verify the formatting and save the file Format.doc.

b) Change the format for the whole document using the keyboard shortcuts. Change the paragraph formatting: Alignment to right, line spacing to double. Finally verify the format using the keyboard shortcut.

III. Page Layout
About Page Layout

Page Layout refers to the attributes that affect the layout of the pages in your document, such as margin settings, paper size and orientation, and headers and footers. Word uses the default page settings when you open a new document.

Typically, you define the set-up of your page before you begin typing. However, you can change the set-up at any time using keyboard shortcuts or using the Page Set-up dialog box.

Specifying Paper Size and Orientation

Paper Size refers to the dimensions of the paper on which the document will be printed. Paper Orientation affects the manner in which the text will be printed on the paper. Orientation can be set to either Portrait or Landscape.

Paper size and orientation affect the appearance of the text and the amount of text that will fit on a single sheet of paper.

How to set Paper Size and Orientation:

Press Alt-F to pull down the File menu and press U to select and execute the Page Set-up command. The Page Set-up dialog box appears. The Page Set-up dialog box is divided into four tabbed pages Margins, Paper Size, Paper Source, and Layout. The Paper Size and Orientation fields are on the Paper Size tab. (Press Insert-T to determine which tab is active. If the page Paper Size is not active, press Ctrl-Tab until JFW announces, "Paper Size.") 

Press Alt-R to move to the Paper Size list and press the Up and Down Arrow keys to explore the size options. 

Select an Orientation. Press Alt-I to select the Portrait radio button or Alt-C to select the Landscape radio button.

Press Alt-A to move to the Apply To combo box. Press the Up and Down Arrow keys to explore the options (Whole Document, This Point Forward).

Exercise 14.

Verify the settings for paper size and orientation for the document in Mobidy.doc. Set the paper size to A4 and change the orientation to Portrait. Verify the number of printed pages this document will produce.

Setting Margins

Margins determine the amount of space between your text and the edge of the paper. You can set the margin to the size that best fits your document.

To set the margins:

Open the Page Set-up dialog box and press Ctrl-Tab until JFW announces, "Margins." 

Press Insert-S until JFW announces, "All." You must set the Screen Echo to All. If you do not, JFW will not read the margin setting fields properly.

Change the following fields.

Top (Alt-T), Bottom (Alt-B), Right (Alt-G), Left (Alt-F) are spin boxes. These fields list the top, bottom, right and left margin in inches. To verify your setting, press Home to move the insertion point to the beginning of the number. Then, press Insert-5.

Press Insert-S until JFW announces, "Highlighted."

Press Enter to activate the OK button and accept the changes.

Exercise 15.

Set the margins for document in Mobidy.doc. Set the top margin to one and half inches, the bottom margin to one and quarter inches, the left margin to one inch and the right margin to one inch.

Verifying Margin Settings

The only way to verify margin settings is to open the Page Set-up dialog box and review the information in the Margin fields.

Exercise 16.

Verify the margins of your document.

Creating Headers and Footers

Headers and footers allow you to place the same information, such as document titles, on every page. Word automatically makes the necessary adjustments to ensure the header and footer appears on each page.

To create a header and footer:

Press Alt-V to pull down the View menu, and then press H to select and execute the Header and Footer command. Header and Footer Toolbar appears on the screen. You do not need to use the toolbar. Word uses a rectangle with dotted line to indicate the header area. This rectangle area appears at the top of your page in the margin. Word places the insertion point inside the rectangle.

Type text of your header.

You can change the format for your header. Select the text of header (Home, Shift-End), press Ctrl-D to open the Font dialog box and change the format. You can press Insert-F to verify the format.

Press the Down Arrow key to move to the insertion point to the Footer. Word uses a rectangle with dotted line to indicate the footer area. This rectangle area appears at the bottom of your page in the margin. Word places the insertion point inside the rectangle.

Note: JFW may not indicate the insertion point moved to the footer. To find out whether the insertion point is in the header or footer, press Ctrl-Shift-S to move to the Style Combo box on the Formatting Toolbar. JFW announces, "Edit Combo Footer" when the insertion point is in the footer or " Edit Combo Header" when the insertion point is in the header. Press Escape to return the focus to the footer or header.

Type the text of your footer.

You can change the format for your footer in the same way as for the header.

When you finished typing the information in the header and footer, press Alt-V to pull down the View menu, and then press H to select and execute the Header and Footer command. The Header and Footer toolbar disappears, and the insertion point returns to its previous position. The header and footer appear on every page; however, the information is grayed.

Headers and Footers only appear on the screen when the document is viewed in the Page Layout view. Because the information is grayed, you must activate the JAWS Cursor to read the information in the header and footer.

To edit header/footer text, you must access the header or footer using the Header and Footer command on the View menu.
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Picture 2.6. Creating Header

Inserting Page Numbers

Page numbers help to orient the reader, especially in long documents. They also make it easier to refer to specific information in your document. Word automatically updates the page numbers whenever the document length has been changed.

Word considers page numbering either a header or footer element, depending on what you have chosen. You can only access the field by using the Header and Footer command on the View menu. Also, like a header and footer, the field does not appear on the screen unless the Page Layout view of the document is used.

To insert page numbers:

Press Alt-I to pull down the Insert menu and press U to select and execute the Page Numbers command. The Page Numbers dialog box appears.

The Position field (Alt-P) indicates where (Top of Page, Bottom of Page) the page number will appear on each page in your document.
Press Alt-A to move to the Alignment field and by pressing the Up and Down Arrow explore the alignment options (Right, Left, Center, Inside, Outside).

Press Enter to activate the OK button and accept the page numbering format.

Inserting Date and Time

You should include date and time information when it is important for the reader to know when the document was created, such as with letters and memos. You can choose from a variety of date and/or time formats.

If you want Word to automatically update the date and time in your document, insert the date and time as a field. You can only access these fields using the Header and Footer command on the View menu. Similar to header and footer, these fields do not appear on the page unless you are viewing your document in the Page Layout view.

To insert date and/or time:

Press Alt-I to pull down the Insert menu and press T to select and execute the Date and Time command. The Date and Time dialog box appears.

Press the Up and Down Arrow key to select the format in the Available Formats list box.

Press Alt-I to check/uncheck the Insert as Field check box.

Press Enter to activate the OK button and accept the information in the dialog box.

Once you have defined a date and/or time format, you may press Alt-Shift-D to insert the date and/or time into your document. Word uses the format defined in the Date and Time dialog box.

Exercise 17.
Define header and footer information for Findandreplace.doc file. For the header use the words "Using the Find feature" to appear in the top right corner of the page. For the footer, use the word "Page" followed by the page number. The footer information should be centred at the bottom of the page. Verify the header and footer information.

Exercise 18.
Open the file Program.doc. There are programs of several TV stations there. The programs are organized neither by TV stations nor chronologically. You have to create a new file Program1.doc and organize the programs by TV stations in it. The programs for each TV station should be written chronologically.

Format the text in the file Program1.doc:

a) The names of TV stations set to Arial, Bold, size 14, centered.

b) Other text set to Times New Roman, size 12, left alignment.

c) Time set to Italic.

d) The spacing of the whole text should be 1,5.

e) Insert the page number on the top of the page.

f) Define the footer for this document and insert text ”updated on” and then insert the date.

Proof Reading and Printing a Document

Proofreading Your Document

You should always proofread your document before you print it. This step can save you from additional work in the future.

You should check the text attributes to ensure the font, font size, and other formatting are correct. You can check the formatting by moving the insertion point to the text you know has special formatting. Then press Insert-F to check the attributes. You may also use the Find Font dialog box to search your document for specified formatting styles and combinations of formatting styles. This method is better, as you can find all occurrences of formatting styles, such as bold, in your document. Using the Find dialog box, you can find the text you meant to bold as well as the text you mistakenly bolded.

Exercise 19.

Verify what formatting Word will search for. Press Insert-Minus to route the JAWS Cursor to the PC Cursor. Then press the Down Arrow key once. JFW automatically reads the entire line.

You should check paragraph attributes to ensure the paragraphs which are indented or centered or right aligned or justified appear as such. You can check the Paragraph attributes by moving the insertion point to paragraphs with special formatting, then opening the Paragraph dialog box. You may also use the Find Paragraph dialog box to search for paragraph attributes and ensure your paragraphs appear as you want. (Remember, Word retains search criteria from the previous search.)

You should check the page layout and margins to make sure your document will be printed properly. You can check the page layout and margins by opening the Page Set-up dialog box. Use the Margins tab to check the margins. Use the Paper Size tab to check the page settings.

You should always check your document for spelling errors. You should check your spelling just before you print. Running the spell checker last will catch those mistakes you may make while proof reading your document. 

Checking the Spelling in a Document

Word allows you to check the spelling of selected text or an entire document. If you want to check the spelling of a single paragraph or word, select the text you want to check before activating the Spelling command.

The Spelling command appears on the Tools menu. The keyboard shortcut is F7.

When you press F7, Word immediately begins checking your document for misspelled words. If Word finds a word it considers misspelled, it opens the Spelling dialog box. The misspelled word appears in the Not in Dictionary field. The selection cursor appears in the Change To edit field around the word that Word offers as the correction to the misspelling. If you are satisfied with this new word, press Alt-C to activate the Change button. Word replaces the misspelled word with this new word and continues checking the document. If you are not satisfied with Word’s offer, press Tab to move to the Suggestions list box. The Suggestions list box contains additional, possible corrections. If you are not satisfied with any of them, press Alt-T to move to the Change To edit field. Then, type the correct word and press Alt-C to activate the Change button. Word continues checking your document. If Word does not find any additional misspellings, JFW announces, "Microsoft Word Dialog The Spell Checking is Complete. OK Button." Press Enter to activate the OK button and close the dialog box. The insertion point returns to its previous position.

The following list describes other fields available on the Spelling dialog box.

Add Words To: This combo box allows you to add to a personal dictionary the word that Word judged as misspelled. Move to this field (Alt-W) when the word in the Not In Dictionary edit field is correctly spelled but is not found in the main dictionary and is a word you use often. Then, press the Down Arrow key to select a dictionary.

Ignore: This command button ignores the word in the Not In Dictionary edit field. Word continues checking the document. Press Alt-I to activate this button.

Ignore All: This command button ignores the word in the Not In Dictionary edit field. Word continues checking the document. Word will not prompt you for a correction if it encounters the word again during any spell check in the current Word session. The keyboard shortcut is Alt-G.

Change/Delete: This command button corrects the word in the Not In Dictionary edit field using the word in the Change To edit field. If you did not choose or type in a correction, Word changes the name of the button to Delete. Press Alt-C/ Alt-D to activate the Change/ Delete button.

Change All/Delete All: This command button automatically corrects the word in the Not In Dictionary edit field using the word in the Change To edit field each time it encounters the word in your document. Word will not prompt you for a correction again during any spell check in the current Word session. If you did not choose or type in a correction, Word changes the name of the button to Delete All. Press Alt-L to activate the Change All or Delete All button. 

Add: This command button adds the word in the Not In Dictionary box to the dictionary selected in the Add Words To list box. The shortcut for activating this button is Alt-A.

Exercise 20.

Check the Correct.doc file for spelling errors and correct any errors using the Spelling dialog box.
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Picture 2.7. The Spelling and Grammar dialog box

Printing a Document

When you are finished working with your document, you can print it. Word allows you to specify the amount of your document you want to print.

The Print command appears on the File menu. You can use the keyboard shortcut, Ctrl-P.

After you activate the Print command, the Print dialog box appears. Press the Tab/Shift-Tab key to move forward/backward through the dialog box fields. (To read a selected item again, press Shift-Insert-Down Arrow.)

The Print What field is a combo box. This field lists the type of information to print (Document, Summary Information, Annotations, Styles, Auto Text Entries, or Key Assignments). Document is the default. Use Document when you want to print the pages in your document. Press Alt-P to move to the Print What field.

The Copies field is a spin box. This field lists the number of copies you want to print. The default is one. Press Alt-C to move to the Copies field. Type the number of copies you want to print.

The Print Range radio buttons allow you to specify the pages you want to print. You can choose from:

All (Alt-A) prints the entire document.

Current Page (Alt-E) prints the selected page or the page on which the insertion point appears.

Selection (Alt-N) prints only the selected text. You must select the text before opening the Print dialog box and choosing this command.

Pages (Alt-G) prints only the pages you specify. Type the number(s) of the pages you want to print. Separate the numbers by commas, or for a range of pages, with a hyphen between the page numbers.

The Print field is a combo box. This field lists the order in which the pages will be printed (All Pages In Range, Odd Pages, Even Pages). The default is All Pages In Range. Press Alt-R to move to the Print field

To determine the name of the active printer and the printer connection, press Alt-T to activate the Printer button. Then, press Alt-Down Arrow to read the Printer list box. The first item selected is the current printer. Press Escape or Enter to close the Print Set-up dialog box.

Exercise 21.

a) Print the entire Letter.doc file.

b) Print a selected part of the text from the Letter.doc file.
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Picture 2.8. The Print dialog box

Using Word Help

You can open the Help application anytime you have a question about using Word. When you are finished reviewing the Help information you should exit the Word Help application.

Every Windows application has its own Help file. As a result, Help topics and Help information depend on which application is active. While the topics and information may vary, the methods for using Help are the same regardless of the application in which you are working. 

Help can be activated through the Help menu (the keyboard shortcut is Alt-H) or by pressing F1. In the first case you can choose one of the Help menu commands:

The Microsoft Word Help command opens the Office Assistant (if it is not disabled). If the Office Assistant is disabled this command works as the Contents and Index command.

The Contents and Index command opens Help Topics dialog box with three tabbed pages:

Contents page is a categorical list of all Word Help topics.

Index page contains a comprehensive index to information contained in the Word Help system.

Find page is a dialog box to help the user locate specific information through keyword searches.

The What’s this? command activates a screen sensitive help.

Through the Microsoft on the Web submenu you can connect to the Web servers of Microsoft and other locations which offer the most topical information.

The WordPerfect Help command opens a dialog box with information and demonstrations about equivalent Word and WordPerfect features. The W key is the hot key for this command. This Help feature is intended to help WordPerfect users learn to use Word.

The About Microsoft Word command opens a dialog box with information about the Word application such as, copyright, version, user and company name, and system information. The A key is the hot key.

If you activate Help by pressing F1, the Office Assistant appears. If the Office Assistant is disabled (this is recommended) the Help Topics dialog box opens.

Finding Information in Word Help

If you want to find information on some items in Word Help, use the Help Topics dialog box:

Press Alt-H to pull down the Help menu.

Activate the Contents and Index command. The Help Topics dialog box opens and its Contents page offers a categorical list of all Word Help topics.

Press Tab to put the cursor to the list and then press Down Arrow until JFW announces the topic you are searching for. Then, press Enter or Right Arrow.

If there are some subtopics related to the selected topic in the Help application a new list of these subtopics appears. JFW reads the topic and says, ”open.”

It there is not a list of subtopics under your item, a window for help on the selected topic appears.

In all the lists we can move by arrows.
If you press Down Arrow or Up Arrow you move your cursor to the next or previous item on the same level.
If you press Right Arrow or Left Arrow you move your cursor one level down or up.
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Picture 2.9. Help Topics window with the Contents page selected

Press Ctrl-Tab twice to activate the Find page. The insertion point is in the edit field, the first field on the dialog box. The dialog box is prompting you to type in a keyword to search.

Press Tab to move to the middle list box and verify that the selected keywords relate to the topic about which you would like more information.

The topics related to the keyword appear in the bottom list box. Press Tab to move to the bottom list box and choose a topic.

Activate the Show Topics button.
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Picture 2.10. Help Topics window with the Index page selected

Exercise 22.

Create a Memorandum with your opinion about this course:

a) Verify Word is the active application.

b) Create a new document.

c) Verify the document window is maximized, the view is set to Normal, and the zoom is set to 75 percent.

d) Set the font to Arial and the font size to 14 point.

e) Type the title Memorandum. Then, press Enter.

f) Center and bold the title.

g) Type the following items on separate lines: Date:, To:, From:, and RE:. 

h) Place the insertion point after the colon following Date. Then, press Tab. Use the Date and Time command to insert the current date. The date should be in the following format: Month Day, Year.

i) Type the following information. After To:, type the name of your lecturer. After From:, type your name. Finally, after RE:, type My assessment of this course. Use the Tab key to align the information.

j) Insert two blank lines after the RE information.

k) Double-space the Date, To, From, and RE information.

l) Open the document Assess.doc. Use the Open dialog box to find and open this file.

m) Read and copy the information in Assess.doc.

n) Switch to the memorandum document.

o) Paste the information from Assess.doc into the memorandum document. You should insert the information from Assess.doc on the last line of the memorandum document.

p) Find and italicize the following: Word 97 with JAWS For Windows 3.3.

q) Verify the information is italicized.

r) Type what you liked about this tutorial after the sentence: "I liked the following aspects of this tutorial." Indent your comments one-inch from the left margin.

s) Type the problems you experienced after the sentence: “I had problems with the following aspects of this tutorial.”  Indent your comments one-inch from the left margin.

t) Type your ideas for improvement after the sentence: "I would like to offer the following recommendations."

u) Save your work. You may save it to a floppy disk or the C drive. Name the document Memo.doc.

v) Use the Page Numbers command to insert page numbers into your document. The page numbers should appear at the bottom  center of your document.

w) Proof your document. Verify the following styles:

Document Title appears centered and bold.

The text appears in Arial, 14-point font.

The reference to the tutorial title is italicized.

Page Number appears at the bottom, center of the page.

x) Spell check your document and correct any misspellings.

y) Save your document.

z) Print your document then, close Memo.doc and Assess.doc.

Experience from Real Courses

In real courses we used materials from [2] and [5] as well as our own materials. Our courses were the basic courses and their subject was in the frame of this handbook. Some items were explained more or less in details based on the knowledge and skills of the participants.

Be aware of the fact that some our comments could be influenced by the version of screen reader, Windows applications and configuration of computers that we used and therefore may not be valid in your conditions.

The Layout and Elements of the Word Screen

For users who are a bit skilled in working with Windows (not necessary in Word) there is no problem to review the Word screen, because almost all Windows applications have the same window layout. To less experienced users working with screen reader it is important to state that one of the first things necessary to do after opening an application is maximizing the application window, without which the screen reader could work improperly. Another recommendation is to maximize the child window as well. The document name is written on the title bar only if you work in Word with child window maximized.

If the child window is not maximized and you want to review the items in menu bar cyclically, after you press Right Arrow from Help item or the Left Arrow from the File item, the control menu of the application or of the document window opens. If you press arrows again, the submenus of the main menu are open and you read the names of the first items in sub-menus instead of names of the items in the main menu. This can cause problems for the blind user – he could loose the orientation on the screen. 

Opening and Saving a Document

The Open and Save as dialog boxes are the first dialog boxes the users worked with. Their structure is a little bit complicated. Probably this is the reason why the blind users often have problems to use them. In our courses we found out, that for the participants it was not easy to remember how to review the dialog boxes in general - which keystrokes should be pressed (Tab, Ctrl-Tab, arrows, Space, Enter) to move around the items of the dialog box, to switch between tabbed pages, to choose some options (check boxes, radio buttons, lists) etc.

We believe it is very important to train this skill.

Another problem is that the blind user has to move around all the items of the dialog box to reach those that he wants to set. One possibility to resolve this problem is to use shortcut keys. The disadvantage of this approach is that the user has to remember many shortcut keys. Therefore, we think it is reasonable for them to learn the most frequently used hot keys for the dialog boxes they often work with as well as to learn how to move in dialog box, how to read the whole dialog box and how to find out the shortcut keys for the items in the dialog box.

What were the most frequent mistakes while learning the Open and Save as dialog boxes?

When you open one of these dialog boxes, the cursor is located in the File name edit field. The participants of the course often did not check the location of the file they wanted to open or save. They just typed the file name and by pressing OK button, they leave the dialog box. It was necessary to remind them that they had to find out which folder was chosen at first. Another possibility is to write the file name with the whole path to the File name edit field. Both of these possibilities have their disadvantage. When the users tried to set the right folder where they wanted to open or to save a file, they often did not know, when and how to switch between Look in combo box and List of items. On the other hand if you want to declare the whole path to the file - you have to remember it.

Navigating Through and Reading a Document

We discovered several imperfections of JFW which have already been corrected in its later versions in navigating through and reading the document.

For example, if there is a table in the document, JFW does not announce it. It does not do that even if your cursor is located in the table.

The JFW function Alt-+ for reading current sentence does not work correctly. Instead, we used the function Alt-Center.

Some of our students were not satisfied with these shortcomings:

JFW does not read apostrophes,

JFW repeats the word before period,

JFW does not read periods or comas between numbers,

when reading text by sentences, JFW does not read the whole sentence if it is broken by the end of a line,

there were some problems with diacritic in the national environment.

You can choose the appropriate settings of JFW according to your needs (if you prefer to read the punctuation or not, ...)

Every document can be assigned a zoom. Every time the document is opened it is displayed in the child window with this zoom. If the zoom is too large, not the whole lines are visible on the screen. In such a case it is necessary to adjust the zoom of the document, because the screen reader can read only the visible part of the document. The best way to handle it is:

to open the View menu by pressing Alt -V or Alt and Right Arrow,
to choose Zoom command,
in the Zoom dialog box check the Page Width radio button.

Selecting Text

If you press Shift-Insert-Down Arrow JFW will read all the selected text. We found out that this key combination does not work every time. You should press LEFT Shift key, Insert key and Down Arrow.

It is important for you to remember that pressing some keys after selecting a text could cause that:

the selection disappears -- if a key for moving the cursor (arrows, PgUp, PgDn, Home, End) or Esc was pressed 

the selected text is deleted -- if Del key or Backspace key  was pressed,

the selected text is replaced by the letter of the pressed key.

It is necessary to think of this, for example, if a text is selected and the user switches between two or more documents. By switching, JFW does not announce selected text without pressing Shift-Insert-Down Arrow. If you are not careful enough (or if you have forgotten that there is selected text in some document), you can lose it by pressing any inappropriate key.

Using the Find, Replace, and Go To Commands

In the Find and Replace dialog box there are three tabbed pages: for Find command, for Replace command and for Go To command. Switching among them by Ctrl-Tab does not work correctly. For the blind user there is only one way to resolve this problem -- to reach each of these pages by its own command in Edit menu or by its own shortcut:

press Ctrl-F (or Find command in Edit menu) for Find dialog,

press Ctrl-H (or Replace command in Edit menu) for Replace dialog,

press Ctrl-G (or Go To command in Edit menu) for Go To dialog.

Another problem is that, for example, by replacing one text with another, we need to read the found text in context. The JFW function Insert-C does not work correctly if the found text is covered by Replace dialog box. In this case you have to press Escape to close the Find dialog box. Now you can read the line in which the word occurs. (Press the Right Arrow key. Then, press Insert-Up Arrow to read the line.) Once you have read the line, press Ctrl-F to begin the search again.

Formatting a Document

JFW does not read correctly the names of tabbed pages in the Paragraph dialog box.

The function Ctrl-Shift-F for activating Font combo box does not work on some computers.

Word offers functions Ctrl-Shift-C and Ctrl-Shift-V to copy and paste formatting. These functions do not work correctly on some computers.

Printing a Document

There are radio buttons in the Page Range section of the Print dialog box. Switching from the radio buttons to the assigned edit field and back does not work correctly on some computers.

If you press Properties button in the Print dialog box, the dialog box for printer properties appears. On the Paper tab you can set by the radio buttons the paper orientation to Portrait or Landscape. The switching between this two radio buttons using only keyboard does not work correctly.

Using Word Help

Help dialog box contains tabbed pages, but they can’t be accessed by Ctrl-Tab.

Other Problems with Dialog Boxes

If the dialog box contains a group of options which belong to the same command, these options are located in the common section of the dialog box and this section (or group of options) has its own name. In this manner the sighted user can distinguish for each option to what group it belongs to. This is important in a case when two (or more) options in different groups of the same dialog box have the same or similar name.

For blind user it can be a problem to find what is to be set in some option or to what group the option belongs, because JFW does not always read the names of groups.

For example there are groups Indentation and Spacing in the Paragraph dialog box on the Indents and Spacing tab. JFW should announce “Indentation” and then the name of the option (”Left”, “Right”, “Special” or ”By”), where the cursor is located. In fact JFW reads only the name of the option.

EXCEL 97 WITH JAWS 3.3 FOR WINDOWS

Initial Settings

Control Panel Settings

Use Control panel settings as recommended in previous chapters (about Windows and Word).

JFW Settings

It is recommended that you use the default JFW settings for Excel. We recommend the scripts delivered with JFW 3.31, because they allow you to perform more functions in Excel.

Helpful Keystrokes

To read a selected cell again, press Insert-C and the Center key. (The Center key is the 5 key on the Number pad.)

To spell the text in the selected cell, press and hold the Insert key. Then press the Center key twice in rapid succession.

Also use the helpful keystrokes recommended in previous chapters.

Disable the Microsoft Office Assistant

It is recommended to disable the Microsoft Office Assistant before the beginning of work with Excel 97.

The Layout and Elements of the Excel Screen

Excel 97

Excel 97 is a spreadsheet program which allows users to easily edit data, establish relationships between the data, and perform calculations. It is possible to manipulate data to compare financial outcomes or establish projected costs. Excel is often used by businesses to figure out profits and expenses, and by individuals to create budgets and project various loan payment scenarios.

Opening Excel

It is possible to open Excel by selecting the command from the Start menu or the Program sub-menu. Another possibility is to open Excel by activating an Excel program icon on computer Desktop.

When you open Excel, it always opens a blank workbook (Book1) so that you can begin entering data immediately. The initial focus is always on cell A1 in the first worksheet in the workbook.

It is recommended to verify that the program and document windows are maximized after you start the program (use the application and document control menu to do this).

The Excel Screen

If Excel is not the active program, hold down the Alt key and repeatedly press the Tab key until JFW announces, "Microsoft Excel - Book1." Then, release the Alt key.

You can review the Excel screen automatically using Insert-Down Arrow. You can review each item individually by activating the JAWS Cursor (numeric minus) and pressing Insert-Right Arrow. If your JAWS Cursor will not move, the Cursor restriction may be active. Press Insert-R to turn off the restriction. You may also need to press the Alt-Shift-Down Arrow keys to move the JAWS Cursor by a specified amount of pixels.

It is a bit difficult to explore the screen using the JAWS cursor, it will be easier to remember few keystrokes which will enable you to reach the most important parts of the window:

You can press Insert-T to read the title bar.

You can press Insert-End to read all the information in the first line of window (control icon, title bar, minimize icon, maximize icon).

You can activate the menu bar pressing the Alt key and use arrows to move between menu items.

If the menu bar is active, it is possible to switch to toolbars pressing the Ctrl-Tab keystroke. Excel uses several types of toolbars to display the most commonly used commands. Most commands that appear on the toolbars also appear on the menus. (However, some commands do not.) JFW may not read all the buttons on the toolbars.

You can show or hide toolbars. However, the Standard and Formatting toolbars must appear on the screen in order to use some keyboard shortcuts with JFW.

The Toolbars command appears on the View menu. The toolbars that you can show or hide appear on the Toolbars sub-menu. Toolbar commands that are checked appear on the screen.

JFW does not indicate whether or not the Standard command is checked when you first open the Toolbars sub-menu. It does, however, indicate the status when you press the Up and Down Arrow keys once the sub-menu is open.

You can activate the application control menu pressing the Alt-Space keystroke and use arrows to move between menu items or use Alt-Dash to activate the document control menu.

To read the status bar, press Insert-Page Down. JFW announces, "Ready," indicating you can enter data or execute a command. If JFW does not announce, "Ready," press Insert-Up Arrow to read the current line.
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Picture 3.1. Excel 97 application window with new empty workbook.

Inside the window is a new empty workbook which contains 3 worksheets; each worksheet is similar to a table consisting of 65536 rows and 256 columns. It is possible to use Arrow keys to move between cells.

Exiting Excel

You can press Alt-F4 to exit Excel.

If you made changes to a workbook since the last time you saved it, a Microsoft Excel dialog box appears, prompting you to save the workbook before exiting Excel. To prevent mishaps, you should always save your workbooks before you activate the Exit command.

The Exit command also appears on the File menu.

When the Excel program closes, JFW reads the current focus.

Exercise 1.

Open the Excel program, review the Excel screen and finally close the application window.

Working with Worksheets

JFW Settings for Working with Worksheets: When you are reviewing a worksheet or entering data in a worksheet, you should set the JFW Screen Echo option to Say None. If the Screen Echo option is set to any other option, JFW reads extra information that may cause confusion.

When you are using menus or dialog boxes, you should set the Screen Echo to Say Highlighted or Say All.

To change the Screen Echo settings, press Insert-S until JFW reads the option you want: Say None, Say Highlighted, or Say All.

Navigating Through and Reading Worksheet Data

Generally, the data in a worksheet is laid out like data in a table, with each column and row assigned a descriptive text label. Labels help the reader to understand the purpose of the worksheet data. Often, a worksheet author enters a descriptive text label in one of the first four cells of the current column. Likewise, the author also enters a text label in one of the first four cells of the current row. JFW offers four keystrokes to read the data in the first four cells of the current column. In addition, it offers four keystrokes to read the data in the first four cells of the current row. The selection cursor does not move when you use these keystrokes.

To read the first cell in the current column, press Alt-1.

To read the second cell in the current column, press Alt-2.

To read the third cell in the current column, press Alt-3.

To read the fourth cell in the current column, press Alt-4.

To read the first cell in the current row, press Alt-5.

To read the second cell in the current row, press Alt-6.

To read the third cell in the current row, press Alt-7.

To read the fourth cell in the current row, press Alt-8.

You will use these keystrokes to determine the current column and row labels. These keystrokes can be helpful when you want to verify that you are entering data in the correct cell.

The cell that has the focus is known as the active cell. A selection cursor appears around the active cell.

Any data you enter appears in the active cell. You can use the Arrow keys to move the selection cursor to the adjacent cell.

You can press Ctrl-Home to move to the cell A1, the first cell in a worksheet.

If you press the Home key, you will jump to the first cell in the current row.

If you press the Ctrl-End keystroke, you will jump to the last cell in the worksheet.

You can press Insert-C at any time to read the cell reference and determine which cell is the active cell.

To read the cell reference and data in active cell, press the Center key.
To read the data in active cell, press the Ctrl-F2 keystroke.
To spell the selected cell, press and hold the Insert key. Then, press the Center key twice in rapid succession.

To read the all data in current worksheet, move the selection cursor to the cell A1 (Ctrl-Home) and press Insert-Down Arrow.
Exercise 2.

Open the workbook Timetable.xls and try to find out the following:

number of columns filled with any data,

number of rows filled with any data.

a) Why is the cell E7 blank? What is the meaning of data in this cell?

b) What is written in cell B6 and what is the meaning of this text?

c) When does go a train from Bratislava to Warsaw?


A
B
C
D
E
F

1
Train timetable






2







3

Bratislava
Bucharest
Budapest
Warsaw
Prague

4
Bratislava

11:00
5:00
3:20
12:15

5
Bucharest
7:00

15:15
1:12
23:14

6
Budapest
21:00
7:09

0:43
18:15

7
Warsaw
9:00
14:00
22:20

6:18

8
Prague
17:00
5:35
13:00
3:30


Table 3.1: Tometable.xls workbook.

Entering Data

Excel treats the data you enter in a cell as either a constant value or a formula.

Constant Value: Any data that you enter in a cell that is not a formula is a constant value. This includes text and numeric figures such as dates, times, currency, or percentages. This type of data does not change unless you select the data and edit it.

Formula: A formula is a mathematical expression that is composed of numeric values, cell references, functions, and operators. The data that is produced by a formula can change when other values in the worksheet change. We will learn more about formulas later.

By default, all text is left aligned and all numbers, dates, and time are right aligned. If you type in a combination of text and numbers, the data is left aligned. Formulas are right aligned.

You can type as much information into a single cell as necessary for your work, from a single number to a lengthy text label.

When you want to enter data in a worksheet, you should set the JFW Screen Echo option to Say None. If the Screen Echo option is set to any other option, JFW reads extra information that may cause confusion. Once you have finished entering your data, you should return the JFW Screen Echo option to Say Highlighted or Say All.

To move to a new cell, use the Arrow keys to move the selection cursor. To enter data, select the appropriate cell and type the data. You should always verify the cell reference before you type or edit data in a cell. You can press the Center key to read the cell reference and contents again.

Once you type the data, you can press Tab or Enter key to enter the data.

When you press Enter, the selection cursor moves to the cell below the cell in which you entered data. When you press Shift-Enter, the selection cursor moves to the cell above the cell in which you entered data.

When you press Tab, the selection cursor moves to the cell in the same row, but in the next column as the cell in which you entered data. When you press Shift-Tab, the selection cursor moves to the cell in the same row, but in the previous column as the cell in which you entered data.

When you enter data in a cell, it appears in two places: the active cell and the edit field on the Formula Bar. (You can press Ctrl-F2 to read the information in the edit field.)

You can enter some special data in a cell. The most common are:

Linebreak: Alt-Enter
Current date: Ctrl-;
Current time Ctrl-:
To check the data in a cell, use the same keys that you used for reading data in other text documents (e.g. in Word). It is recommended to switch the screen echo to Say All or Say Highlighted.
To replace part of the data in a cell with new data, you must press F2 to activate the edit mode and place the insertion point inside the cell. You may then select the data you want to replace. With the data selected, type the new data. The data you type replaces the selected data. JFW does not indicate the text was replaced. Read the text again using a JFW reading command, such as Insert-Up Arrow.

To replace all the data in a cell quickly, select the appropriate cell and then type the new data. JFW does not indicate the data was replaced with new data. Read the data again using a JFW reading command, such as Insert-Up Arrow.

Exercise 3.

Enter data to the cells according to the Expenses.xls workbook.


A
B
C

1
Budget



2
Personal



3




4
Month
Expanses
Incomes

5
January
$1 680,00 
$10 869,00 

6
February
$1 474,00 
$10 566,00 

7
March
$1 710,00 
$9 900,00 

Table 3 2: Expenses.xls workbook.

Saving a Workbook

You should save your workbooks frequently.

You must follow the Windows 95 naming guidelines when you assign a name to a workbook.

You should let Excel supply the default extension for Excel workbooks which is .xls. You can use the default extension by typing a name without a period.

The keyboard shortcut for the Save command is Ctrl-S.

You use the Save As dialog box the first time you save a workbook and when you want to save an existing workbook with a new name or in a new location.

In the Save As dialog box, make sure you selected the correct drive in the Save In combo box, opened the correct folder in the list box, and assigned a valid name in the File Name field. If you know in which drive and folder you want to save the workbook, you can type the full path to indicate in which drive and folder you want to save the workbook.

Exercise 4.

Save the book edited in Exercise 1 under the name Expenses.xls and then save it again under the name Expenses2.xls (use the Save as command).

Closing a Workbook

You should close workbooks when you have finished working in them. You can close workbooks without exiting Excel.

If you choose to close a workbook before you save it, a dialog box appears asking if you want to save it.

The keyboard shortcut to close a workbook is Ctrl-F4.

Exercise 5.

Close workbooks Expenses.xls and Expenses2.xls saved in previous exercise.

Creating a New Workbook

When you open Excel, a new workbook titled Book1 automatically opens. However, you may want to create a new workbook when you are already working in a workbook. You can create a new workbook at any time while you are working in Excel.

If you use the New command on the File menu, the New dialog box will appear prompting you to select a template. All Excel workbooks are based on a template. Excel uses templates to define default settings for workbooks. Unless you specify otherwise, all new workbooks use the standard Workbook template.

You can create a new workbook quickly (without displaying the New dialog box) by pressing Ctrl-N.

When you open a new workbook, the focus is on cell A1 on the first worksheet.

Excel automatically assigns a default name to new workbooks. This name is always "Book" followed by a number. Once you open a new workbook, you are ready to begin working.

Opening an Existing Workbook

You can use several methods to open workbooks in Excel. The method you choose depends on whether you know the path for the file, whether you know the file name, and how recently you worked in the workbook.

The keyboard shortcut to open the Open dialog box is Ctrl-O.

To select and open a workbook, choose the correct drive in the Look In combo box, open the correct folder in the list box, and select the workbook file in the list box. Initially, the list box only lists those workbooks that reside in the folder in which you last saved or opened a workbook. In addition, it only lists those workbooks with the .xls extension. To make sure Excel is pointing the correct drive and folder, you should check the Look In combo box and the list box. If you need to move back to a previous folder, press the Backspace key in the list box. The contents of the previous folder will appear in the list box. If you know the first letter in the workbook's name, you may press the first letter in the name until JFW reads the workbook you want to open.

You can quickly open a workbook by typing the full path and name in the File Name field or by choosing the workbook from the File menu.

You can use the Open dialog box to search for Excel workbooks that match the criteria that you specify.

For quick access to your workbooks, Excel lists on the File menu several recently used workbooks.

Exercise 6.

Open workbooks Expenses.xls and Expenses2.xls, check the data in them and close them finally.

Modifying a Worksheet

Selecting Cell Ranges and Data in a Cell

In order to make changes to the data you have entered, you must select the data. You can select the entire cell or select only part of the data within the cell. Any keystrokes that you use will affect the selected data.

To select data within a cell, press F2 to activate the edit mode and place the insertion point inside the cell. 

You can select a range of cells by pressing and holding the Shift key while pressing the Arrow keys.

To select an entire column of cells, you can press Ctrl-Spacebar. 

To select an entire row of cells, you can press Shift-Spacebar. 

You can press Ctrl-A to select all the text in the worksheet. (Do not press Shift-Insert-Down Arrow to verify the selection. Your computer may lock-up.)

Press Shift-Insert-Down Arrow to verify the selection. JFW announces, for example, "Selected Range A6 Through A12," followed by the contents of the selected cells.

To cancel a selection, press any arrow key or the Home key to move the selection cursor.

Correcting and Deleting Data

To delete part of the data in a cell, you must press F2 to activate the edit mode and place the insertion point inside the cell. You may then use either the Backspace key or the Delete key to remove data. The Delete key removes character to the right of the insertion point. The Backspace key removes the character to the left of the insertion point. JFW only reads the character you are deleting when you use the Backspace key. When you use the Delete key, JFW reads the character the insertion point lands on after the deleted character.

To delete all the data in a cell quickly, select the cell and then press the Delete key. JFW does not indicate the data was deleted. Read the data again using a JFW reading command, such as the Center key.

To replace part of the data in a cell with new data, you must press F2 to activate the edit mode and place the insertion point inside the cell. Do not use Ctrl key in combination with arrows, because it is not working well in this mode (in some cases it is necessary to restart JFW). You may then select the data you want to replace. With the data selected, type the new data. The data you typed replaces the selected data. JFW does not indicate the text was replaced. Read the text again using a JFW reading command, such as Insert-Up Arrow.

To replace all the data in a cell quickly, select the appropriate cell and then type the new data. JFW does not indicate the data was replaced with new data. Read the data again using a JFW reading command, such as Insert-Up Arrow.

The Delete key performs the same function as the Clear command on the Edit menu, NOT the Delete command on the Edit menu. 

The Clear command simply removes the data that currently appears in the selected cell or range of cells. 

The Delete command removes a selected cell, row, or column.

Copying Cell Data

The clipboard is a Windows feature that allows to copy or move data from one location to another.

It is possible to copy data in a selected cell by pressing Ctrl-C. Excel copies the data and places it on the clipboard. JFW announces, "Copied Selected Range." 

When you copy a cell, Excel places a dotted selection cursor around the cell. The dotted selection cursor remains around the cell until you press Enter to accept the information in the cell to which you pasted the data.

After you position the selection cursor where you want the copied data to appear, you can press Ctrl-V to activate the Paste command. Excel inserts the copied data. JFW announces, "Pasted Selected Range."

When you are copying a range of cells, you must paste the data into a location of the same size. For example, if you want to copy the contents of cells A6, B6, and C6, then you must paste the information into three adjacent cells in the same row, such as E10, F10, and G10.

When pasting data from a range of cells, you do not need to select all the cells where the range data will be placed before you activate the Paste command.

If any of the cells where you pasted the data contain data, that data will be overwritten by the new data. To insert the copied data without replacing existing data, use the Insert command on the Edit menu rather than the Paste command.

To remove a dotted selection cursor, press Escape. You should ALWAYS remove a dotted selection cursor. Otherwise, JFW will not be able to read the data properly.

Moving Cell Data

You can use the Cut and Paste commands to move data within a cell or data in a selected cell or range of cells to another cell.

When you activate the Cut command, Excel places the data on the clipboard and changes the selection cursor around a cell or range of cells to a dotted selection cursor. The cut data will remain in the cells until you activate the Paste command.

You can press Ctrl-X to activate the Cut command. You can press Ctrl-V to activate the Paste command.

When you are moving a range of cells, you must paste the data into a location of the same size. For example, if you want to copy the contents of cells A6, B6, and C6, then you must paste the information into three adjacent cells in the same row, such as E10, F10, and G10.

When moving a range of cells, you do not need to select all the cells where the range data will be placed before you activate the Paste command. If any of the cells where you pasted the data contain information, that information will be overwritten by the new data. 

To insert the copied data without replacing existing data, use the Insert command on the Edit menu rather than the Paste command.

Using the Undo and Redo/Repeat Commands

Excel's Undo Command allows you to reverse editing or formatting changes you’ve made.

Press Ctrl-Z to activate the Undo command.

You can press Ctrl-Y to activate the Redo command and cancel the Undo command.

The name of the Undo and Redo/Repeat commands depends on the most recent action taken.

The Undo and Redo/Repeat commands appear on the Edit menu.

If you want to undo or redo/repeat a series of actions, press Ctrl-Z or Ctrl-Y repeatedly. 

Using the Go To Command

The keyboard shortcut for the Go To command is Ctrl-G or F5 key. When you press one of them, the Go To dialog box appears.

You can use the Go To command to move to a specific cell in your document. 

You can use the Go To dialog box to select a range of cells. You are not restricted to selecting adjacent cells (e.g. A6:F12; H13).

In the Go To list box, press the Down Arrow key to select an item. When the Screen Echo is set to Say None, you must press Insert-Up Arrow to read each option after you press the Down Arrow key.

Using the Find and Replace Commands

You can use the Find command to locate cells that contain the data you specify. 

The keyboard shortcut for the Find command is Ctrl-F. When you press Ctrl-F the Find dialog box appears.

Because the Find dialog box remains open, it is possible that it is covering the cell that Excel selected. Therefore, you cannot press the Center key to determine which cell is selected and read its contents. INSTEAD, you must press Insert-C to read the cell reference. To read the data that appears in the selected cell, you must press Ctrl-F2 to read the edit field on the Formula bar.

Excel does not indicate when it has found all cells containing the data you specified in the Find dialog box. It will continue to move to the cells containing the data. When Excel returns to the first cell it found containing the data you specified, then the search is complete.

If you want to find a previous occurrence of the data, press Alt-Shift-F.

The Replace command allows you to search your worksheet for text, formats, special characters, and other elements and replace that information with the information you specify.

The keyboard shortcut for the Replace command is Ctrl-H. When you press Ctrl-H the Replace dialog box appears.

You have two options for replacing the data. You may active either the Replace button or the Replace All button. When you use the Replace button, Excel prompts you to confirm each replacement. When you use the Replace All button, Excel automatically replaces every occurrence of the data without prompting you to verify. Use the Replace All button when you are certain you want to replace every occurrence.

In the Find and Replace dialog boxes, the By Columns search direction generally yields results faster than the By Rows option.

In the Find and Replace dialog boxes, Excel retains search criteria from one search to the next, until you exit Excel.

Exercise 7.

Open the Sales.xls file and try to find out the layout of the information which are in the workbook. Then modify data according to the following instructions.

a) Delete the words “Pampered Piggies” in the cell A1.

b) Delete all the data in cell A2.

c) Replace the word “Premium” in the cell A6 with the word “New”.

d) Replace the words “January”, “February” and “March” in the cells B6, C6, D6 with the words “Week 1”, “Week 2”, “Week 3”.

e) Copy the cell A1 to cell A14.

f) Copy the words “Quarterly Totals” from the cell A4 to the end of text in the cell A14.

g) Copy the data from cells A7 through A11 into the cells A16 through A20.

h) Copy the data from cells A6 through A12 into the new workbook (Create the new workbook, copy data into the cells A1 through A7 and then close the new workbook without saving it).

i) Move data from the cell A1 to the beginning of text in the cell A12.

j) Move data from the cell A4 to the cell A21.

k) Move the data in cells E6 through E12 to cells B15 through B21.

l) Clear data from the cell A6 and check if the cell is empty. Then undo the Clear command and check if the data are back in the cell A6. Redo the Clear command and check if the cell is empty again. Finally undo the Clear command again and check if the data are back in the cell A6.

m) Select the cell D6 using the Go To dialog box and then select cells C6 through C12 using the Go To dialog box.

n) Find cells that contain the word "Products" in the active worksheet.

o) Replace every occurrence of the word "Week" in the active worksheet with the word "Quarter".

p) Close the workbook Sales.xls without saving it.


A
B
C
D
E

1
Pampered Piggies Pedicure Products





2
First Quarter Catalogue Sales





3






4
Quarterly Totals





5






6
Premium Products
January
February
March
Total

7
Happy Hooves Callus Jelly
592
523
647
1762

8
Happy as a Hog Foot Cream
692
664
629
1985

9
Welcoming Wallow Heated Foot Massager
685
522
432
1639

10
Smells Like the Barnyard Foot Mud
521
539
623
1683

11
Piggies Polish
642
691
688
2021

12
Total
3132
2939
3019
9090

Table 3.3: Sales.xls workbook.

Performing Calculations

Understanding Formulas

You perform calculations in Excel by using formulas. All formulas begin with an equal sign. The equal sign directs Excel to treat the data as a formula rather than as a constant value.

You should only use constant values in a formula when the value will not change frequently.

A function is a pre-defined formula. Excel offers numerous functions to help you analyse your data.

Operators are symbols that represent mathematical operations (the plus sign, minus sign, asterisk, forward slash, and parentheses are common operators).

Operands are the elements to be calculated. An operand can be a constant value, a cell or range reference, a label, a cell or range name, or a function.

All elements in a formula must follow a specific syntax or order. In Excel, the formula syntax is an equal sign (=) followed by the operands (elements to be calculated) and the operators. 

By default, Excel calculates a formula from left to right, starting with the equal sign (=). Also, Excel calculates multiplication and division before addition and subtraction.

You can control how Excel performs a calculation by changing the formula syntax, often by using parentheses.

Creating a Simple Formula

Formulas can be simple, such as those that sum a series of cells. They can also be complex, using a combination of constant values, cell references, operators, and functions.

You can use cell references in formulas. When you use a cell reference, Excel will use the data in the referenced cell to perform the calculation.

Excel displays the active cell's data in two places, in the cell and in the edit field on the Formula Bar. When you enter a formula, only the result of the formula appears in the cell and only the formula appears in the edit field on the Formula Bar.

JFW prompts you to enter a formula when you type an equal sign.

JFW announces, "Equals," to indicate the cell contains a formula.

You can press Ctrl-F2 to read the information in the edit field on the Formula Bar.

Understanding and Using Functions

Excel functions represent the most commonly used formulas. The SUM and AVERAGE functions are examples of simple functions.

Use Excel's functions to avoid lengthy and confusing formulas. For example, using the SUM function is better than typing all the cells that you want to add, especially when you are working with numerous cells and worksheets. Functions simplify formulas and can save you keystrokes.

A function can be used alone or as an element in a larger formula.

When using functions, use the following syntax: equal sign, function name, and arguments. An argument is the value to be used in the calculation performed by the function. Include arguments in parentheses and separate each argument with commas. The following is a formula that uses a function with proper syntax:

=SUM(A12; B6:B10; E14).

You can find more information about functions in the section entitled “Advanced Features,” later in this chapter.

Using the AutoSum and AutoCalculate Features

The AutoSum and AutoCalculate features allow you to find the sum for selected cells quickly. 

The AutoSum command causes Excel to check the cells above or to the left of the current cell for a series of cells containing numbers. If either the cells above or to the left of the current cell contain a series of numbers, Excel places a dotted selection cursor around those cells. Then, it will automatically enter a formula that sums the numbers in that cell range.

Press Alt-Equal Sign to activate the AutoSum command. 

If you use the AutoSum command in a cell that intersects a column of numbers and a row of numbers, the command will sum the numbers in the column. 

If text appears in a cell within the range you want to sum, the AutoSum command will only sum numbers up to the text.

Whenever you select a series of cells that contain numbers, Excel's AutoCalculate feature sums the numbers and displays the sum in the status bar. Press Insert-Page Down to read the status bar.

Comparing Financial Scenarios

Because you can quickly and easily change worksheet data, you can compare the benefits of various financial scenarios. By using cell references in a formula rather than specific numbers, you can change the numbers to reflect different scenarios. Excel will then automatically recalculate all formulas that reference the cell.

When comparing data, you should first check all the cells where the changes will take place. Be sure to note the current figures. Then, make the changes. When you are finished entering the changes, check the cells again to note the new totals.

Absolute and Relative Cell References

Excel distinguishes between two types of cell references: absolute cell references and relative cell references.

When you use a relative cell reference in a formula, Excel finds the data referenced by using the cell with the formula as a starting point. 

When you use an absolute cell reference, Excel finds that data reference using the exact coordinates of a cell regardless of the position of the cell that contains the formula.

Excel updates relative cell references if you copy a formula to another cell. Excel does not update an absolute cell reference if you copy a formula to another cell.

Use absolute cell references when you are sure the cell reference you need will not change.

Excel uses dollar signs to denote an absolute cell reference. To quickly change a relative cell reference to an absolute cell reference, press F2 to activate the Edit mode. Place the insertion point after the reference. Then, press F4.

Naming Cells and Cell Ranges

Excel allows you to assign names to cells and cell ranges. Naming cells and cell ranges makes it easier for you to read and to remember the cells that contain the data you need.

Once you name a cell, you can use the cell name rather than the cell reference in formulas or in the Go To dialog box.

You must follow Excel naming guidelines when assigning names to cells and cell ranges.

You use the Define Name dialog box to assign a name to a selected cell or range of cells. You can use the keyboard shortcut Ctrl-F3 to open the Define Name dialog box. 

Or, you may choose the Name command on the Insert menu. Then, choose the Define command to open the Define Name dialog box.

You can use the keyboard shortcut Ctrl-Insert-N to read the cell name. You must have copied the JFW configuration file provided with the tutorial [2] in order to use this keystroke. If you did not copy this configuration file, you must use the JAWS Cursor or define a frame to read the name. (The name appears in the Name combo box on the Formula Bar.)

Exercise 8.

Open the Company.xls file and try to find out the layout of the information which are in the workbook. Then modify data according the following instructions.

a) Read the sales and service revenues. Then, enter simple formulas that will calculate the yearly sales and service revenues (enter the formula "=B5+C5+D5+E5" into the cell F5 and "=B6+C6+D6+E6" into the cell F6).

b) Read the expenses for wages and supplies. Then, enter simple functions that will total the yearly expenses for wages and supplies (enter the function "=SUM(B10:E10)" into the cell F10 and "=SUM(B11:E11)" into the cell F11).

c) Find the total quarterly and yearly revenues using the AutoSum and AutoCalculate features (enter functions in cells B7, …, E7, B13, …, E13).

d) Compare the results caused by a change to the figure in cell E6. First, check the current data in cells E6, E7, F6 and F7. Then, type new data in cell E6. Finally, check the data again to note the differences.

e) Type the formula “=B7-B12” into the cell B18 and copy the cell B18 to the cells C18, …, E18. Check the contents of these cells.

f) Type the formula: “=B18*$B$17” into the cell B19 and copy the cell B19 to the cells C19, …, E19. Check the contents of these cells.

g) Assign these names to the following cells: name cell E6 as Service_Quarter4, name cell F7 as Revenue_Total, name cell F12 as Expenses_Total, name cell B14 as Gross_Profit. In the “Gross_Profit cell, type =Revenue_Total - Expenses_Total”. Try to use cell names in Go To dialog box.


A
B
C
D
E
F

1
Pampered Piggies Pedicure Products






2
1997 Budget Report – Administration






3







4
Revenue
Quarter 1
Quarter 2
Quarter 3
Quarter 4
Year

5
Sales
3000
5000
6000
8000


6
Service
5000
6000
7000
8000


7
Total






8







9
Expenses
Quarter 1
Quarter 2
Quarter 3
Quarter 4
Year

10
Wages
1000
1500
1650
1800


11
Supplies
200
250
225
275


12
Total






13







14
Total Gross Profit






15







16
Income






17
Tax Rate
17%





18
Gross




0

19
Taxes Due




0

20
Net
0
0
0
0
0

Table 3.4: Company.xls workbook.

Formatting Data

About Formatting

Every cell has attributes associated with it, and collectively, these attributes are known as the cell's format.

The Formatting toolbar must appear on the screen in order to use some formatting keyboard shortcuts.

You can determine the format for a selected cell or data by opening the Format Cells dialog box and reviewing the selected options. You can open it by pressing Ctrl-1 keys or using Cells… command from Format menu.

To change the format of all the data in a cell, you must select the cell before using a format command. You can do this either before or after you enter data into the cell. When you select a cell for formatting, the formatting is associated with the cell not with the data within the cell.

To change the format of part of the data in the cell, you must press F2 to enter the Edit mode. Select only the data that you want to change. Then, use a command for the formatting style that you want.

Changing the Font Format

You can change the font format for your data using either the Format Cells dialog box or keyboard shortcuts. 

The Format Cells dialog box allows you to change several attributes at once.

Use keyboard shortcuts when you want to make only a few changes.

The keyboard shortcut Ctrl-U is a toggle command. It will turn underlining either on or off, depending on the current formatting. Excel always uses the single underline style when you use the keyboard shortcut. When underline is on, JFW announces, "Underline Button Pressed." When underline is off, JFW announces, "Underline Button."

The keyboard shortcut Ctrl-B is a toggle command. It will turn bold either on or off, depending on the current formatting. When bold is on, JFW announces, "Bold Button Pressed." When bold is off, JFW announces, "Bold Button."

The keyboard shortcut Ctrl-I is a toggle command. It will turn italics either on or off, depending on the current formatting. When italics are on, JFW announces, "Italics Button Pressed." When italics are off, JFW announces, "Italics Button."

To verify the formatting for the selected cell or data, you must open the Format Cells dialog box. Then, review the selected options. You can use also Ctrl-F keystroke to read a formatting information, but it is not detailed enough.

Changing the Number Format

You can change the numbering style for your numeric data using the Number tabbed page on the Format Cells dialog box. The main field on the Number tabbed page is the Category list box. The Category list box contains all the numbering styles available. Each time you select a new style in the Category list box, fields appropriate to that style appear on the Number tabbed page.

You can use keyboard shortcuts to quickly apply the Currency and Percentage style to the selected cell or range of cells.

To quickly apply the Currency style, use the keyboard shortcut Ctrl-Shift-4.

To quickly apply the Percentage style, use the keyboard shortcut Ctrl-Shift-5.

Excel will apply the Currency or Percentage style as defined in the Format Cells dialog box.

Changing Column Width

By default, approximately eight characters of data fit completely in a cell. If data exceeds the current size of the cell, the data will overlap, or be overlapped by, the contents of the adjacent cell. You can use the Insert-N keystroke to determine whether or not the data in a cell is overlapping into adjacent cells. It is not working properly if the text font is changed.

You can adjust the column width using the AutoFit Selection command or by typing a size for the column. The AutoFit Selection command appears on the Columns sub-menu. Choose the Columns command on the Format menu to open the Columns sub-menu. The AutoFit Selection command adjusts the column width according to the data in the selected cell or to the cell with the most number of characters in a selected range of cells.

You should use the AutoFit Selection command to adjust the column width to the average length of data in a column, not necessarily according to the cell in the column with the most number of characters. (If data in one cell is a lot longer than the average length of data in other cells in the column, use the merge feature to display the lengthy data properly.)

Controlling the Alignment of Data

By default, all text is left aligned and numbers, dates, and times are right aligned.

You can use the Alignment tabbed page on the Format Cells dialog box to change the alignment of the data in a cell.

To verify the alignment, you must check the fields on the Alignment tabbed page on the Format Cells dialog box.

Centering Text Across Cells

Most worksheets have a title. You can format your title so that it is centred at the top of your worksheet data.

You can use one of two methods to merge cells and center data in a cell. You may use the Center Across Selection Option or the Merge Cells and Center Alignment options. You can also use these options to ensure that lengthy data fits in a cell, thereby displaying properly.

Before you center the title across your data, you must determine the number of columns your worksheet data spans. Next, select the cells that you want to merge. Finally, choose the Center option in the Horizontal combo box and check the Merge Cells check box.

Removing Cell Formatting

Formatting is associated with a cell. If you want to remove the attributes you added to a cell, use the Clear Formats command. When you remove the formatting, Excel uses the general attributes as defined by the template.

The Formats command appears on the Clear sub-menu. Choose the Clear command on the Edit menu to open the Clear sub-menu.

Inserting Rows, Columns, and Cells

You can use the Cells, Rows, or Columns command on the Insert menu to insert a blank row, column, or cell.

When you insert a new cell, row, or column, Excel shifts the cells in the worksheet to accommodate the new cells.

Excel also updates all formulas so that the cell references are accurate, including absolute cell references.

Deleting Rows, Columns, and Cells

You can use the Delete command on the Edit menu to remove a selected cell, a row, or column.

Excel automatically updates formulas to reflect their new locations. However, a formula that refers to a deleted cell displays an error.

Exercise 9.

Open the Format.xls file and try to find out the layout of the information which are in the workbook. Then modify data according to the following instructions.

a) Change the format for cell A1 using the Font tabbed page on the Format Cell format dialog box. Change the font to Century Gothic, font style to regular, font size to twelve, add single underlining. Finally verify the format using the Format Cells dialog box.

b) Change the format of cells A6, …, A8 to bold and the format of cells B5, …, E5 to underlined. Finally verify the format using the Format Cells dialog box.

c) Format the word “Corporate” in the cell A3 to italic.

d) Apply the Currency style Dollar with two decimal places to a range of cells B7 through F9 and B12 through F14.

e) Apply the Percentage style with zero decimal places to cell B16.

f) Adjust the width of the column A according the width of cell A18.

g) Set cells B5 through F5 to center alignment.

h) Use the Merge Cells for cells A1 through F1 and then center the worksheet title in cell A1. Verify that the title appears centred over the cells in column A through F.

i) Remove the formatting changes you made to cells B5 through F5.

j) Insert a blank row at row 18 and shift the cells in row 18 down to row 19. Insert a blank cell at A19 and shift the remaining cells in row 19 to the right.

k) Delete row 2 from the worksheet.


A
B
C
D
E
F

1
Pampered Piggies Pedicure Products






2







3
1997 Budget Report – Corporate






4







5

Quarter 1
Quarter 2
Quarter 3
Quarter 4
Year

6
Revenue






7
Sales
46000
49680
53654,4
57946,752
207281,152

8
Service
55000
59400
64152
69284,16
247836,16

9
Total
101000
109080
117806,4
127230,912
455117,312

10







11
Expenses






12
Wages
62000
63240
64504,8
65794,896
255539,696

13
Supplies
22500
22950
23409
23877,18
92736,18

14
Total
84500
86190
87913,8
89672,076
348275,876

15







16
Tax Rate
0,17





17
Taxes Due
$2 805,00 
$3 891,30 
$5 081,74 
$6 385,00 
$18 163,04 

18
Date Completed






Table 3.5: Format.xls workbook.

Managing Workbooks

Switching among Multiple Open Workbooks

You can have several workbooks opened at the same time. You can switch among opened workbooks using the Window menu or the keyboard shortcut Ctrl-F6.

Exercise 10.

Open the workbooks Budget98.xls, Company.xls, and Expenses.xls all at once and try to switch among them using the Window menu and using the keyboard shortcuts.

Switching among Multiple Open Worksheets

A workbook may contain up to 256 worksheets. New workbooks only have three worksheets, however.

You can switch among the worksheets by pressing Ctrl-Page Down to move to the next worksheet or press Ctrl-Page Up to return to the previous worksheet. JFW reads the worksheet name when you switch to a new worksheet.

Exercise 11.

Open the Year98.xls workbook and switch among the worksheets it contains.

Renaming a Worksheet

You can use the Rename command to assign a name to a worksheet. The Rename Sheet command appears on the Sheet sub-menu. Choose the Sheet command on the Format menu to open the Sheet sub-menu.

Worksheet names can be up to thirty-two characters, and you may use any character on the alphanumeric keyboard.

Exercise 12.

Assign names to the three worksheets in the Year98.xls workbook: Sheet1 – Representative Sales, Sheet2 – Product Sales, Sheet3 – Store Sales.

Inserting a Worksheet

You can insert a new worksheet into your workbook using Worksheet command on the Insert menu. Excel inserts the worksheet before the active worksheet. Excel assigns all new worksheets the name "Sheet" followed by a number.

Exercise 13.

Insert a new worksheet between the second and third worksheets in the Year98.xls workbook.

Moving a Worksheet

You can use the Move or Copy Sheet command on the Edit menu to rearrange the order of your worksheets. Excel will move the active worksheet to the position you choose in the Move or Copy dialog box. You can also use the Move or Copy Sheet command to move a worksheet to another workbook.

Exercise 14.

Move the Representative Sales worksheet to the end of the Year98.xls workbook.

Deleting a Worksheet

You can use the Delete Sheet command on the Edit menu to remove worksheets you no longer need. When you activate the Delete Sheet command, all of the data on the worksheet is deleted as well. Be sure you want to remove the data and that other worksheets in the workbook are not using the data on the worksheet you want to delete.

Exercise 15.

Delete Sheet1 from the Year98.xls workbook.

Preparing A Workbook For Printing

Determining Page Breaks

Worksheets that contain many rows and columns of information may not fit on a single sheet of paper when printed. If columns of data extend beyond the width of the paper, Excel inserts a column page break. If the rows of data extend beyond the length of the paper, Excel inserts a row page break.

In addition to the number of rows and columns of data, several other factors affect the placement of page breaks such as margin settings, whether you have included header and footer information, the size of the paper, and more. Making changes to these settings only affects the amount of information that will appear on the printed page; they do not impact how the worksheet data appears on the screen.

Before you print your worksheet data, you should determine where the page breaks occur. While Excel DOES NOT provide a nonvisual method for determining page breaks, you can use the Page Break macro to search for the breaks. This macro is included in the tutorial [2]mentioned at the beginning of this chapter.

To determine the number of printed pages a workbook will produce, choose the Print Preview command on the File menu. Then, press Insert-Page Down to read the status bar.

To insert your own page breaks, move to the cell that intersects the row and column where you want the row and column page breaks to appear. Then, choose the Page Break command on the Insert menu.

Exercise 16.

Determine the number of printed pages the Report.xls workbook will produce. Use the Page Break macro to determine where page breaks occur. 

Creating Headers and Footers

Headers and footers allow you to include the same information on every printed page, such as the workbook title or your name.

The header and footer fields appear on the Header/Footer tabbed page on the Page Set-up dialog box. Choose the Header and Footer command on the View menu to access the Header/Footer tabbed page.

You can use Excel's pre-defined header and footer elements or specify custom information.

Headers and footers only appear on the screen when you view your worksheet using Print Preview.

Exercise 17.

Define header and footer information for Report.xls workbook. For the header, use the words "1997 Budget Report" to appear in the top right corner of the page. For the footer, use the word "Page" followed by the page number. Below the word "Page" and the page number, use the words "Prepared By" followed by your name. The footer information should be centred at the bottom of the page. Verify the header and footer information.

Determine where the page breaks occur with the addition of a header and footer.

Setting Margins

Margins determine the amount of space between your text and the edge of the paper. They affect the amount of the data that will print on a single printed page. (Remember, most printers require a minimum margin setting.) You set the margins using the Page Set-up dialog box. The margin fields appear on the Margins tabbed page. To change the margins, type the number of inches for the margin. Then, activate the OK button.

Exercise 18.

Set the margins for worksheet in Report.xls workbook. Set the top margin to one and one-half inches, the bottom margin to one and one-quarter inches, the left margin to one inch and the right margin to one inch. Verify the margins for your document.

Determine where the page breaks occur with the new margin settings.

Specifying Paper Size and Orientation

Paper size refers to the dimensions of the paper on which the document will be printed. Paper orientation affects the manner in which the text will be printed on the paper. Paper size and orientation affect the appearance of the data and the amount of data that will fit on a single sheet of paper.

You change the paper size and orientation settings using the Page Set-up dialog box. These fields appear on the Page tabbed page.

Exercise 19.

Determine the paper size for Report.xls and change the orientation to Portrait. Determine the number of printed pages this worksheet will produce and where the page breaks occur.

Specifying Sheet Printing Options

You can use the Sheet tabbed page on the Page Set-up dialog box to define additional print features for your workbook such as whether or not you want the gridlines or the row and column titles to print. In addition, you can define the print order if your worksheet will print on more than one sheet of paper.

Proofreading  and Printing Workbooks

Checking the Spelling in a Workbook

You can check the spelling in your workbook using the Spelling command. The Spelling command appears on the Tools menu. The keyboard shortcut for this command is F7.

Excel allows you to check the spelling of a single cell, a selected range of cells, a single worksheet, or an entire workbook. If you want to check the spelling of a single cell or a range of cells, select the cells you want to check before activating the Spelling command.

When Excel has found a possible misspelling, you can choose one of Excel's corrections, type in your own correction, or direct Excel to ignore the word.

Exercise 20.

Check the Proof.xls workbook for spelling errors and correct any errors using the Spelling dialog box.

Proofreading Your Workbook

Use the following questions to ensure your workbook and worksheet data appears as it should.

1. Do any data overlap?

2. Are cells formatted correctly?

3. Is the data distributed uniformly?

4. Do you want the cell gridlines to print?

5. Will worksheet data print properly on the page?

6. Where do the page breaks occur?

7. What size paper and which orientation will be used to print the workbook?

8. If data does not fit on one page, what should be the print order?

9. How many pages will print?

Exercise 21.

Use the previous questions to ensure the data on Sheet1 in Report.xls appears as it should. 

Printing a Workbook

You can print your workbook using the Print dialog box. The Print command appears on the File menu. The keyboard shortcut for this command is Ctrl-P.

You can print an entire workbook, the active worksheet, or a selected range of cells.

Exercise 22.

a) Print the entire Report.xls workbook.

b) Print the only Sheet1 of the Report.xls workbook.

c) Print a selected range of cells (e.g. A3 through F10) on Sheet1 of the Report.xls workbook.

Advanced Features

Using AutoComplete

AutoComplete allows you to quickly enter identical information in a column. You may choose to turn off this option in Edit tabbed page of Options dialog box by unchecking the Enable AutoComplete for Cell Values check box. You can find the Options… command in Tools menu.
If the first few characters you typed in a cell match an existing entry in that column, Excel fills in the remaining characters for you.

You can also use a keystroke to simultaneously insert the same information in several cells. First, select the cell that contains the data to be repeated. Second, select the cells where the information will be inserted. If the range of cells is down a column, then press Ctrl-D. If the range of cells is to the right and in the current row, press Insert-3 and then Ctrl-R.

Excel completes only those entries that contain text or a combination of text and numbers; entries that contain only numbers, dates, or times are not completed.

Exercise 23.

Enter the text Monthly Total to the range of cells A1 through A4 and A1 through D1.

Using AutoCorrect

You can use the AutoCorrect feature to automatically correct common typing errors and to insert text or other information you frequently include in your workbooks. To enable Auto Correct feature it is necessary to check appropriate fields in the Auto Correct dialog box. The AutoCorrect command appears on the Tools menu. The letter A is the hot key for this command.

An AutoCorrect entry should not be a real word and cannot be longer than 31 characters. The text that is used to replace the entry, however, can be any length and include spaces and special characters.

Exercise 24.

a) Use AutoCorrect feature to correct a common misspelling (e.g. type the word “thier” into the cell A12 instead the word “their”). 

b) Add an AutoCorrect entry for your name. Verify if Excel will automatically replace your initials with your full name no matter in which workbook or worksheet you are working.

Using AutoFill

The AutoFill feature allows you to quickly enter an incremental series of data in selected cells. A series of data can be numbers, dates, months, or ordinals (first, second, third, etc.). You may also create a customised series.

Before you use the AutoFill feature, you must type the first entry in the series. Then, select the cells that will be used to complete the series. The selection can span multiple columns or extend several rows in either direction. The Fill command appears on the Edit menu.

To customise a list of series, choose the Options… command on the Tools menu. Use the fields on the Custom Lists tabbed page to define your own list.

Exercise 25.

a) Use the AutoFill feature to insert a series of months in a row of selected cells.

b) Use the AutoFill feature to insert a series of numbers incremented by ten in a row of selected cells.

c) Create a series of employee names in the Custom List tabbed pages on the Options dialog box. Insert the series of employee names you just created into selected cells.

Using the Formula Palette

The Paste Function dialog box allows you to insert functions for complex calculations. Rather than requiring you to memorise the exact syntax, the dialog box prompts you for the information necessary to perform the calculation. Excel will then insert the formula with the correct function and syntax into the selected cell.

Excel offers numerous functions including those related to math, trigonometry, financial, database, statistical, engineering, and reference.

The Paste Function dialog box contains lists of all the function categories and the functions available. To review the functions, open the Paste Function dialog box by choosing the Function command on the Insert menu. Once you select a function, a dialog box will appear prompting you for the data or cell references to be used in the formula.

You must use the JAWS Cursor to read the function descriptions and the field descriptions on the dialog boxes.

You can use Excel's on-line help to obtain more information about using functions. You may look up information using the function category or the function name.

Exercise 26.

Open the Payment.xls file and try to find out the layout of the information which are in the workbook. Insert a formula in cell B7 that will calculate the monthly payments for a loan. 

You can easily calculate monthly loan payments using the PMT function in a formula. The PMT function requires the following arguments: an interest rate amount, the total numbers of payment, and the total loan amount. 


A
B

1
Monthly Loan Payment Calculation


2



3
Interest Rate
11%

4
Total Number of Payments
36

5
Total Loan Amount
$25 000,00

6



7
Monthly Payment


Table 3.6: Payment..xls workbook.

Experience from Real Courses

In real courses we follow the structure mentioned in previous parts except for the last one (advanced features). We used exercises 1.-22. During the courses several problems occurred. Here we will present the problems and possible solutions. Be aware of the fact that some of our comments could be influenced by the version of screen reader, Windows applications and configuration of computers that we used and therefore may not be valid in your conditions.

Orientation in Open and Save Dialog Boxes

Orientation in these dialog boxes is difficult for the blind users. In some cases it is possible to avoid using these dialogs, especially for opening files.

You can use recent documents in File menu or Documents sub-menu in Windows Start menu.

You can open the file from Windows Explorer if you move the PC cursor to the file name and press the Enter key.

If it is necessary to use Open or Save Dialog Boxes it is recommended to use hotkeys and to do it in the following way:

If you know the whole path to the file, just enter the name with the path to the File name edit field. To move to this field, press Alt-N keystroke.

If you don’t know the path, you must set it in the dialog box.

At first, you must check the directory set in Look in combo box. You can move there by pressing Alt-I.  If  the correct directory is not there, you must change it. At first, you must use arrows to move to the correct disk (you can move from the original position, or at first press Home to get to the beginning of the list and then use Down Arrow several times) and press Enter.

Then use Tab key to move to the list view of the current directory and try to find the required directory or file. You can use arrows or the first letter of the file/directory name. Then press Enter again to open the file or directory.

Other Dialog Boxes

JAWS 3.3 doesn’t read well the names of tabs in Format dialog box if you are using Ctrl-Tab keystroke.

It is recommended to move to any Tabbed Page and move from one page to another with Arrow keys.

This is a bug either of Excel 97 or JFW 3.3 that hopefully will be fixed by developers.

Strategy for Reading Existing Workbooks

It is difficult to find out the data layout in unknown existing workbook. As there are keystrokes enabling the reading of first four rows and first four columns of worksheet without necessity to move the selection cursor, it is recommended to enter the titles in these cells.

Try to avoid blank cells among cells with data in the same line.

Use the following keystrokes to read the worksheet:

Insert-Down Arrow to read the whole worksheet

Press Shift-Spacebar to select an entire row of cells and then press Shift-Insert-Down Arrow to read the data in a row.

Use arrows to read cells from left to right and rows from up to down.

If there are blank cells among filled cells, use Ctrl-Arrows to move to the next block of data or to the edge of the current block of data.

Reading Data in a Worksheet

Several problems occurred in using some reading commands.

According to the manual, Ctrl-Arrow key should move to the edge of the current data region, but in some cases this keystroke switched PC cursor to JAWS cursor.

It could happen that JAWS would not read the decimal point in numbers if you use the local version of JAWS or Excel.

Some keystrokes could be difficult to press on your local keyboard (e.g. Alt-1, Alt-2, …). It is recommended to switch the keyboard to English (US) keyboard if you need to press any functional key together with numbers.

Numeric keyboard is very good for entering numbers, especially for sighted users, and blind users need it in order to use JAWS. Be aware of the fact that the meaning of pressing numbers on the numeric keyboard depends on whether the NumLock is switched on or off.

Very important is to switch the screen echo according to the rules mentioned at the beginning of part 3. In short:

Set the Screen Echo to Say None, when you are reviewing a worksheet or entering data in a worksheet. If the Screen Echo option is set to any other option, JFW reads extra information that may cause confusion.

Set the Screen Echo to Say Highlighted or Say All, when you are using menus or dialog boxes.

Working with Selected Range of Cells

When you copy a cell or a range of cells to clipboard, Excel places a dotted selection cursor around the cell. The dotted selection cursor remains around the cell until you press Enter to accept the information in the cell to which you pasted the data or until you press Escape.

JAWS cannot read the data in the block with the dotted selection cursor around it. It cannot even announce that there is such a block on the screen. It is necessary to be aware of this and cancel the selection with Escape.

This block can also occur on the screen when we redo a few steps and we run into this situation. 

Find and Replace Dialog Boxes

Several problems occurred while using Find and Replace dialog boxes.

Jaws did not read checkboxes in Find dialog on some computers.

In some cases, JAWS do not announce that the data were found and also do not read the find data when you press Insert-C or Ctrl-F2.

These are bugs either of Excel 97 or JFW 3.3 that need to be fixed by developers.

Entering Formulas

When you accidentally use the reference of the current cell in the formula, do not press OK button in a dialog which occurs afterwards, because then the Circular Reference Toolbar is displayed which you can cancel only in menu (View/Toolbars/Circular reference). Press the Cancel button or Escape instead and the dialog box disappears without displaying the Circular Reference Toolbar. Then move to the cell with the circular reference and correct the formula.

Formatting Data in Cells

You can use Insert-F, as you know this keystroke from Word. It should tell you the format of selected text inside the cell. This information is not complete in Excel.

You can use the Insert-N keystroke to determine whether or not the data in a cell is overlapping into adjacent cells. This keystroke doesn’t work well, if you change the font format of the data. Either JAWS tells nothing, or it reads the visible data in current column from the cell at the beginning of current data region to the current cell.

Application Menu

The items Delete… and Clear in Edit menu are confusing. It is good to remember:

If you want to remove cells, rows or columns and move remaining cells, use Delete… command.

 If you want to remove contents of cells, remove cell formatting or remove cell comments, use Clear sub-menu.
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Module 3b: Screen Readers

Introduction (by Branislav Mamojka)
Screen readers are special application programs providing visually impaired people with screen information and keyboard response in the form of a synthetic speech or a refreshable Braille which enables them to control computer and to use standard applications. We will concentrate our attention on windows screen readers because Windows has become the most used operating system for personal computers. There exist many products of that kind. Our objective is not to evaluate and to recommend one or few of them. In fact, it would be a rather difficult task because of fast development in this field and of increasing similarities of screen readers caused by unifying tendency supported by the Microsoft's Windows operating system. Therefore, in this publication, we present only overviews of some of screen readers. The main purpose of this presentation is to inform you about most important features screen readers might have which can help you when choosing one to be used.

If you have not had a chance to try screen readers before you choose, it is good practice to use demo versions which can be downloaded from Internet for free. These demo versions are full-featured versions with only limited time of use or number of keystrokes. After restarting your computer you can use the demo version again.

JAWS FOR WINDOWS (by Branislav Mamojka)
JAWS for Windows (JFW) is a screen reader software. It runs under either Microsoft Windows 95/98 or Windows NT 4.0. JFW works with, but does not replace, most computer applications. It offers comprehensive screen reading capability that includes extended product customization through powerful utility managers.

Producer:

Henter-Joyce, Inc.

11800 31st Court North

St. Petersburg, Florida 33716-1805 U.S.A.

http://www.hj.com

E-mail: sales@hj.com or info@hj.com

JAWS - Job Access With Speech - is a registered trademark of Henter-Joyce, Inc. JFW is used for JAWS for Windows.

Distribution Format:

JAWS for Windows is distributed on CD-ROM and features a self-starting, talking installation. It includes the Eloquence software speech synthesizer (speaking in seven languages), Quick reference cards in print and Braille to assist the user in learning basic Windows commands and JFW commands on desktop and laptop keyboard layouts, and cassette Tape Tutorials which take the user logically from installing to using JFW. On the installation CD you can also find English Microsoft Text-To- Speech synthesizer.

System Requirements
To use JAWS for Windows (version 3.5) it is needed:

A personal computer that will run the Windows 95/98 operating system, or Windows NT 4.0.

If it is intended to use the Eloquence for JFW or another software synthesizer, a Windows 95/98 or Windows NT compatible sound card is needed.

30 MB of available hard disk space is required.

VGA or higher-resolution video adapter (Super VGA 256-color is recommended).

As with most systems, the faster the processor and the more memory the computer has, the better the performance of the computer and JFW.

JFW 3.5 is a true 32-bit program, and will not work in the Windows 3.1x environment. For the convenience of those who need speech access in the Windows 3.1x environment, JFW 2.0 is also included on the installation CD.

Copy Protection:

Purchasers of a single user license of the JFW software receive five authorization keys on an authorization diskette. Purchasers of a JFW Timed Evaluation receive an authorization diskette that will operate for a 60-day period. The 40 minutes full functional demo version of JFW does not need any authorization and can be downloaded from producer's web page.

Basic Features of JFW Version 3.5

Talking CD Installation

Just after inserting the CD into the CD-ROM drive JAWS for Windows installation will automatically start. Right from the moment it starts, the computer will talk. The installation is interactive, asking the user for needed information.

Dr. JAWS

During the installation, JAWS for Windows runs a diagnostic tool, called Dr. JAWS, that reviews the current system and recommends the best set-up for running JAWS for Windows. It will check the number of colors and the video card in the system and if confirmed, the installation will even make the appropriate adjustments to the system.

JAWS for Windows Merge

This utility runs during the installation of JFW will upgrade the previous versions installed on the computer. The user won't have to manually merge the changes from the previous configuration file to the new version. With this utility, the changes and additions to the new version are automatically merged into the dictionary, graphic, and configuration files.

Supports Microsoft's Active Accessibility

JFW supports Active Accessibility in Windows 95/98. If there is a need to use the latest applications that have built-in Active Accessibility like the Office 97 Suite or Internet Explorer, JFW is already enabled for them.

Supports MSAPI Software Synthesizers

JFW uses the industry standard SSIL and supports Microsoft's Speech API (MSAPI). JAWS can be used with software synthesizers while its Control Panel "knows" the capabilities of each synthesizer and takes advantage of each. Most supported common speech synthesizers are including DECtalk PC, Accent, Apollo, Audapter, KeyNote, DoubleTalk, Infovox, Sounding Board, Microsoft Text-to-Speech, and others.

Support for Refreshable Braille Displays

The Braille support lets JAWS send to output any of the most popular Braille displays along with the standard speech output.

Works in an MS-DOS Window

All the power of JFW 3.5 is available in an MS-DOS window. There is no need to switch to an MS-DOS screen reader to run MS-DOS applications.

JAWS Help System

JAWS contains an extensive help facility that is always available with the touch of the keyboard. 

The user can access JAWS help through the JAWS Help menu or directly from the keyboard.

* Hot Key Help - Press INSERT to get instant help for the JAWS hot keys or Windows short cut keys available in the current dialog window.

* Screen Sensitive Help - Press INSERT+F1 to hear a description of the current focus item. The identity of the active window, instructions on using the available options, and help on maneuvering within the window are spoken.

* Keyboard Help Mode - Press INSERT+1 to enter Keyboard Help mode. With each keystroke a description of its function with a brief synopsis is spoken.

* Online Help - Provides instant access to all JAWS for Windows help including the user manuals and other printable documentation provided for user's reference purposes.

JFW Configuration Capabilities

Any of the JAWS for Windows standard settings for the current application or across all applications can be customized. JFW comes with various utility managers to help the user accomplish this.

* Keyboard Manager - This manager lets the user browse and change JAWS keys for any application or all applications. Each key assignment is accompanied by a description of its function.

* Graphics Labeler - This manager lets the user to give meaningful names to the graphics displayed on a screen and help the user to recognize graphics on the screen.

* Dictionary Manager - This manager lets the user to store special pronunciations for the current application or across all applications by changing default pronunciations to words or phrases.

* Configuration Manager - This manager lets JAWS for Windows give the user the utmost flexibility to "hear" the screen in a personally tailored manner. The user can change the way things are spoken and how much is spoken; change the verbosity, screen echo, graphics verbosity, punctuation, and numbers.

* Frame Manager - This manager lets the user to create screen boundaries and then have that area monitored for automatic reading of all, highlighted or no text. The user can assign a frame to a key so that the area can be read on demand. This feature is available on an application basis or across all applications.

* Script Manager - This manager lets the user to modify JFW standard scripts or to create user's own to accommodate even the most difficult, non-standard Windows applications.

Reading and Navigation

JFW has the ability to read a prior, current, or next text by character, word, sentence or paragraph in all applications. Using SayAll function of the Configuration Manager JAWS can be set to speak by line, sentence, or paragraph. This affects the way in which text that is sent to the synthesizer is spoken. This feature can be used to produce more natural speech patterns.

Tables Navigation Support for Many Applications

JAWS can detect tables and their row and column titles. There are navigation keys to be used when inside of a table. These commands read the contents of the cell, along with the associated row and column headings. The same keystrokes can be used to navigate tables and worksheets in different applications like IE5, MSWord, Excel, PowerPoint, and MSAccess.

Cursors

Three cursors are available - a standard PC cursor, a JAWS cursor emulating and moving mouse pointer, and an invisible cursor independent of both already mentioned.

JAWS Cursor Restriction Feature

The JAWS cursor (or Invisible Cursor) has 3 separate levels related to where it can move on the computer screen. The movement of this cursor can be restricted to either the current or parent window with focus or the JAWS cursor can also be set to move freely throughout the entire screen area. Each time INSERT+R is pressed with the JAWS cursor on, the next level of restriction is spoken and moves the status to that level.

JAWS Message Voice

The Message Voice is a configurable option used in Scripts that can cause JAWS to use a different voice when it speaks text that does not appear on the screen.

Text Attribute and Formatting Announcements

JFW optionally announces changes in text attributes like capitalization, font size, font style, color, indentation, and others. This feature can be turned on and customized in the JFW Configuration Manager.

Announcement of Cursor Shape

In Windows 95 and 98 only, the user can elect to hear JAWS announce changes in their cursor shape. When the feature is turned on, the user will be notified by the message voice if the cursor/mouse pointer changes shape

HJPad - Word Processor Training Tool Application

HJPad is a basic word processing program where the user can create, open, spell check, format, and save documents. Also, five sample dialogs have been created in HJPad for the purposes of training the new user. Users can learn how to operate the many dialog controls found throughout the Windows operating system using these sample dialogs and without the concern that they are altering valuable information in another program.

Window List

The Window List allows the user to switch between minimize, maximize, close, or switch to the application. Applications that are running appear in alphabetical order in the List view. Users with many application windows open, may find this to be a faster way to switch between applications than the taskbar or using ALT+TAB.

System Tray Dialog Box

This feature displays Icons from the System Tray in list form so that the user can easily review or change their settings.

Access to Internet Explorer 5.0

A very important feature of JFW 3.5 access to Internet Explorer 5.0 is the ability to read a Web page as if you were in a word processor. Once the Web page has loaded, JFW will report that it is complete and the virtual cursor begins to read the entire page. All standard reading features are available including the ability to select text and to use clipboard to copy and paste using standard Windows commands.

If the page being read contains frames, the user is notified with the number of frames present before beginning to read. At the end of a frame, the user is notified that the bottom of a particular frame has been reached and is alerted with the name of the next frame, and continues to reading.

The screen scrolls to track the virtual cursor movement. In the event you land on a control such as a list box or edit area often found in forms, you can press ENTER on or press the LEFT MOUSE BUTTON (NUM PAD SLASH) which allows you to work within that control with the actual PC cursor. Thus, to enter Forms mode you either press ENTER or click the LEFT Mouse Button. If you are in Forms mode, pressing the PC cursor key will turn back on the Virtual PC cursor and take you out of Forms mode.

When reading a Web page, JFW reports if a link has been visited previously, which is indicated by saying "Visited Link" rather than just Link before actual links when reading.

It is possible to create a dialog with Links List (INSERT+F7) containing all links of the page. In addition to activating a link by pressing ENTER on the link in the list, you can choose the Move to Link button, which puts you back in the existing page with the Virtual cursor on the selected link. This way you can read within the context of the page where the link is located without activating it. The Links List also allows Incremental searching. This is useful when on a page with lots of links that start with the same first letter, such as some newspapers. In the event you wanted to find the weather link, which might be one of many that start with W, you just start typing the word weather and you will jump through the list as you type the letters. Links List can also be set to display all links, or you can choose to have only the visited links or unvisited links appear in the list. Additionally, you can choose to have the links displayed alphabetically or in the order they actually appear on the page in your list of links.

Custom Scripts for Applications

JAWS for Windows has been customized and configured for many popular applications. It supports Internet Explorer 5, MS Office 2000, PowerPoint 97 and 2000, RealPlayer7, Access 97 and 2000, Excel 97 and 2000, Outlook2000, Word 97 and 2000, Eudora Pro, and Eudora Lite etc.

MAGic and JFW

MAGic (Magnification in Color) is screen magnification software also offered by Henter-Joyce that enlarges a screen from 2 to 20X. JFW 3.5 has been developed with script functions to provide many of the powerful features in JFW so they can be taken advantage of in MAGic. These scripts allow JAWS for Windows and MAGic to work in cooperation on the same system.

Language

JWF is available for many languages and can be localized for other languages. The necessary condition for it is availability of JFW compatible speech synthesizer (hardware or software) for language in question. The producer provides source files to be translated to the local language (menu prompts, help files, ...) and compiled to create a new language version of JFW. JFW, as it is (e.g. English version), can also be used for foreign languages if an appropriate speech synthesizer is available. Most of messages, names of symbols and other terms could be translated directly by user and immediately used. In this way JFW can be used also with those languages for which it is not localized at least by those users who understand JFW original language (English in this example).

Network Support

JFW can be network enabled. For those with multi-user licenses, a single network enabled copy of JFW can be installed on a server computer and be run from different computers by the same user or a variety of users. This means that any user can go to any computer on the network, activate and use JFW with his personal preferences preserved.

WINDOW-EYES 3.0 (by Tamás Babinszki)
Producer:

GW Micro, Inc.

725 Airport North Office Park

Fort Wayne, IN 46825

U.S.A.

Tel: (219) 489-3671

Fax: (219) 489-2608

Email: support@gwmicro.com

Web Page: www.gwmicro.com

FTP Site: ftp.gwmicro.com

Window-Eyes 3.0 is an application program that monitors the activities of other applications and reports textual information to speech synthesizers. Window-Eyes monitors keyboard, screen, and Windows activities and acts on information it needs, such as screen text changes, opening and closing windows, the appearance of dialog boxes, changes in focus, the pressing of its own hotkeys, etc. allowing other applications to run normally.

System Requirements
In order to install and run Window-Eyes successfully, you need to have a computer with MS Windows 3.1x or MS Windows 95/98 installed, at least a 80486/66 processor, at least 8 MB RAM if you are using Windows 3.1x, or 16 MB if you are using Windows 95/98, a compatible speech system, or a sound card under Windows 95/98. 

If you are using Windows 98 you may need to make a few adjustments:

- In "My Computer" in the View menu, under the Advanced Settings disable "Remember each folder's view settings"

- Disable the Active Desktop under the Settings menu, and enable the "Classic Style" radio button.

- In the setting menu disable the Animate Feature by disabling the "Animate Windows, Menus And Lists" check box.

Basic Features of Window-Eyes

Installation

Installing Window-Eyes is an easy process. From the CD run the Set-up program which is in the Windows directory. If you are using Windows 98 and have a sound card, the installation program will speak. Follow the instructions of the program. If you are planning on using a different speech synthesizer that requires its own software you have to install the software according to the instructions that came with the synthesizer. Now you are ready to use Window-Eyes.

Basic characteristics

Before running Window-Eyes we need to understand its basic characteristics. When first running the program, you will notice that MS Windows has two cursors: the caret, also called the insertion point, and the mouse pointer. Where you enter text from the keyboard, Windows normally displays a blinking vertical line immediately to the left of the place where the application program displays keyboard input. The caret behaves just like the MSDOS cursor, though it is not always on the screen. The mouse pointer is almost always present on the display screen, which may take several different shapes. When the mouse pointer changes shapes, Window-Eyes announces the new shape. The mouse is used to "interactively" review the screen. As you move the mouse pointer over text, it is read. You can then return to the keyboard to input text. Unlike the WE cursor, however, when you locate an icon or a menu item with the mouse, either by using the physical mouse or the mouse hotkeys, you can click on the item. If you prefer, you can use the set of mouse hotkeys to substitute for movement of the physical mouse. Instead of the mouse cursor you can activate the WE cursor by pressing the We/Mouse hotkey. This key is a toggle. When the WE cursor is active, the same keyboard commands that move the mouse pointer will move the WE cursor without disturbing either the caret or the mouse pointer.

You can reach Window-Eyes' different functions by pressing predefined hotkeys or cursoring keys. To change a hotkey: From the Window-Eyes control panel in the Keys list box of the Hotkeys dialog, select the definition you want to assign to a keystroke. You can either scroll down the list, or start typing the definition of the hotkey so Window-Eyes can easily find what you are looking for. Press TAB once to move to the Capture key button. Press ENTER or SPACE. Window-Eyes will prompt for the keystroke. Press the key combination you want to assign. You can use ALT, CTRL, SHIFT, WINDOWS, APPLICATION and Numpad-INSERT or any combination of these keys. Press ENTER. Window-Eyes will remove the Hotkeys dialog, returning you to the Window-Eyes Control Panel. You can also choose the Undefine button which will de-activate the currently selected hotkey. If desired, save your new setting to the current set file through the File menu. To undefine a hotkey, in the Keys list box of the Hotkeys dialog, select the hotkey definition you want to unassign. Press TAB twice to move to the Undefine Hotkey button. Press ENTER or SPACE to choose the button. Window-Eyes will remove the keystroke from the current hotkey and return you to the listbox on the hotkey you just undefined.

Window-Eyes does not have a so-called review mode, because it is not needed. Instead, you can set up user windows for which Window-Eyes has a special set of hotkeys. Not to be confused with Microsoft Windows, Window-Eyes user windows are user definable, rectangular portions of the display screen. You define them in terms of coordinates relative to the active window. For example, a window defined as the full active Window would have a left edge 0 pixels from the left edge of the active window, 0 pixels from the top edge of the active window, 0 pixels from the right edge, and 0 pixels from the bottom of the active window. As the active window is resized or moved, Window-Eyes user windows adjust to accommodate the changes.

Window-Eyes has two kinds of windows, standard and hyperactive. Standard user windows are for reading portions of the display screen while ignoring other portions. They can be set to any size. You can read the contents of any of the first twenty standard windows with the press of a hotkey. Any of the 50 standard windows can be read with the Any Window hotkey.

Hyperactive windows help automate Window-Eyes. Once set, a hyperactive window watches constantly for user-specified changes on the display screen and then instructs Window-Eyes to carry out some preselected task. For example, a hyperactive window might be set to watch for any changes on your application program's status line and then instruct Window-Eyes to read the line. Meanwhile, another hyperactive window might be set to watch for a certain color to pop up, and then trigger Window-Eyes to beep or maybe make some announcements.

Reading a full document

Window-Eyes lets you start with the caret at any point in a document and read the document from that point forward, all the way to its end or until you press the ESCAPE key. This task is accomplished by pressing the Read to End hotkey. When you press this hotkey, Window-Eyes reads the current line of the document and then automatically issues a DOWN-ARROW command to your application program. This process is repeated until the document runs out of new lines to move down to. Caret movement may run a line or so ahead of the reading.

Using the Internet

Since many of today's WEB pages are very visual, it has traditionally been difficult to have them read using a screen reader. The WEB page could have several columns and frames for example. You can use the MSAA application mode to make browsing in Internet Explorer much easier. To activate this mode you either need to turn on the MSAA application mode option in the general menu or press the MSAA application mode hotkey while you are in Internet Explorer. Once MSAA mode has been turned on, Window-Eyes will obtain data directly from Explorer bypassing the screen. This allows the program to present the data in a de-columnized speech-friendly manner. While you are in this mode Window-Eyes works with an invisible pointer that allows you to cursor through an internal buffer rather than working with the information actually presented on the screen. Once you enable the MSAA Application Mode, Window-Eyes will place you in a very special mode. Window-Eyes will read all the HTML code from the current page, line for line. However, in order for Window-Eyes to get this information, it must wait on Explorer to finish downloading the page. Therefore, it may take several seconds before you hear anything. If you try and issue a command to Window-Eyes before the page has been loaded from Explorer Window-Eyes will say "busy" and ignore your keystroke. Once the page has been completely loaded Window-Eyes will say "load done" and start by reading the top 24 lines. Here you can move with the tab key among the links. The Insert-Tab - Displays the Available Links dialog. This dialog contains a list box displaying all available links for the current web page. The Read To End hotkey will start reading the web page from the current position to the end of the web page. The Speak Summary hotkey will have Window-Eyes tell you how many lines are in the current web page and what line the pointer is currently on. It will also tell you if the web page has frames and if so, how many.

Web page designers have the option of using frames when creating their web pages. Frames are just a way of grouping information together. For example, a frame can be used on the left of a web page to display a group of links and a frame to the right to display the information relating to the link selected in the first frame. If the page has frames Window-Eyes will say "Load done has frames" after the web page has been completely loaded. If there are frames the following keys can be very useful.

- Ctrl-Tab - Moves the pointer to the beginning of the next frame and reads the line.

- Ctrl-Shift-Tab - Moves the pointer to the beginning of the previous frame and reads the line.

Using the MSAA application mode feature will give you excellent access to web pages in Internet Explorer but it will not give you access to web pages that use JAVA as MSAA is not aware of JAVA controls.

Language

It is important to note that Window-Eyes is based on the English language, however, it lets you configure it for an other non-English speech synthesizer. Though the menus remain English, all other features can be adjusted to any language which is based on the Latin alphabet. For this you have to do the following:

The easiest thing is if your synthesizer emulates one of the pre-set synthesizers, because at the installation you have to use that one. If not, then choose the Speech Synthesizer Interface Library, specify the driver for your speech synthesizer, and set up its features according to your needs. Before you run Window-Eyes, you have to run the drivers of your speech synthesizer.

The first time you will hear that certain characters are not voiced, numbers and punctuation are pronounced in English but with the phonetic system of your synthesizer. First, create a character dictionary in which you define all of the punctuation characters and give them a description in your language. And second, choose the Punctuation pull down menu both under the Screen and the Keyboard menu. Set all items either to On, or to "Dictionary Only". This will enable Window-Eyes to use the definitions of the character dictionary for all punctuation it encounters. In the Screen and Keyboard menu find the Enhanced item and set it to Dictionary Only. This will enable Window-Eyes to read ASCII characters above 127 but only if you define them in the character dictionary which you used before for punctuation. Use the same process, listing all the extended characters of your language. Make sure that you do all of these changes globally, otherwise your settings will take effect only in the current application window. For your convenience you can describe the most frequent buttons and messages in the word exception dictionary so to ease the work of those who do not understand English at all.

WINTALKER (by Rastislav Sacek)
Development of WinTalker product started in 1996. During the beginning period it was designed for the MS Windows 3.11 system. Because of the interest of blind users in speech the graphical interface, development of WinTalker continued. The aim was to reach highest utility value. The target of the first period of development was to use WinTalker to read text created by scanner and OCR programs. The speaking simple text editor (Notepad), which is a standard Windows accessory was enough in the beginning period. Universality - which means to sound a set of software as wide as possible - was another important target during the development process.

The biggest step forward during the development occurred when 32bit technology was used instead of the 16bit one when Windows 95 was introduced. Approximately one year after this change WinTalker acquired functionality similar to its current version. The most important was to speak the Windows 95 system itself and its accessories. Next step was to develop speech for other software. Low usage of system resources, high stability and fast response are other important features of WinTalker product.

WinTalker is designed for experienced users, but by setting MS Windows environment and customizing sound output (done by development company), it is possible to get a system for less experienced users who want to use only a subset of software (Wintalker functions). This way we can e.g. create a simple tool for text reading for elderly people or small children. This possibility is the result of the macrolanguage use. Many user operations can be simplified by using this macrolanguage. In the current WinTalker version customizing is done only by development company, because macrolanguage is not yet released for users. But to release the macrolanguage for users is planned for the future, when reliable robustness to prevent user mistakes is reached.

Producer:

RosaSoft 

Distribution format

WinTalker product is distributed on two diskettes. For MS Windows 98 environment it is also supplied CD-ROM with MS Internet Explorer 5.0, MS Active Accessibility version 1.2 and English voice.

Copy Protection

Program is protected against unauthorized copying by means of diskette or hardlock.

System requirements

Computer PC/AT with processor 80486 or higher

At least 16 MB of memory

Sound card compatible with SB installed in MS Windows environment

Microsoft Windows 95 / 98

Mouse or compatible pointing device

Program basic features

Control and Basic tools

Keyboard echo and sound response of the place under cursor are default settings for Windows 95 applications. To get orientation in the environment user can use special functions. There are two ways to execute WinTalker function: either by a shortcut or by pressing Ctrl+CapsLock to display WinTalker menu and then select the function from the menu. WinTalker menu changes according to the application user is working with. Additional functions can be used for certain applications. When user is working with such an application this function is added to WinTalker menu. When user is working with e.g. Notepad function ”Continuous reading” is added to WinTalker menu. When working first time with certain program user can simply find out which additional WinTalker functions can be used to control this program.

Basic rules and response types

The most frequent function is getting additional information on the current item. After selecting additional information WinTalker reports item value, name, position and type. It is possible to hear any item in dialog window, if this item has same system number. Some programs assign this number dynamically – it means it is different in each run of the program. In such a case the ”speaking an item” function works correctly only before the program is terminated. Using the ”speaking an item” function user can add a text to e.g. an edit box, for which screen-reader is unable to get its name. When working later with this edit box in this dialog window user can hear the notice he used to sound the item. It is a frequent situation that item names are painted or graphical symbols are used instead of text.

Another WinTalker tool is the ”Virtual Window”. This tool is similar to simple text editor where text can only be read. ”Virtual Window” is usually used when working with dialog windows and WWW pages, sometimes also to read text files. In ”Virtual Window” user can use functions for reading text in letter-by-letter, word-by-word or row-by-row mode. Functions for continuous reading and searching text are also present.

Content of the ”Virtual Window” is not only a ”speech window”, but it is also displayed on the screen. User can set color of text and background and font size in this window. This is an advantage for users with remaining sight. There is a simple function in WinTalker which displays contents of a window in its ”Virtual Window”. From the dialog window not only text but also item themselves (e.g. edit boxes, switches pageframes) are copied into the ”Virtual Window”. This means that user can read currently displayed text in a dialog window – it is useful for e.g. Properties window of a file. The advantage of the ”Virtual Window” is the possibility to also  display additional item information. When pressing Insert key on an item in the ”Virtual Window”, ”Virtual Window” is closed and cursor moves into to searched dialog window and is placed on the selected item.

Another WinTalker function displays dialog window ”Item Manager”. ”Item Manager” is used to speak window controls, navigation around menus and hypertext links and also to switch between displayed windows. This tool is especially useful when items of an application cannot be accessed directly by keyboard.

Using ”Item Manager” user can move to any item in the environment. Items can be selected from a list by cursor arrows. After confirming by Enter key cursor moves to selected item. ”Item Manager” contains following list types:

1. Running applications

2. Items

3. Hypertext links

4. Menu items

Running applications: This list contains names of all visible windows in the environment. Selecting name from the list and confirming it by Enter key we move into the selected window. This way we can move from one running application to another.

Items: The list contains names of controls (e.g. buttons, edit fields) in active window and their type, control availability (enabled/disabled), state and hotkey. To items without name we can add additional information. Selecting the item and confirming by Enter key we simulate left mouse click on the selected item. Similar function has command ”Display window text” in ”Virtual Window”.

Hypertext links: The list contains names of hypertext links in active window. Selecting item and confirming with Enter key we simulate left mouse click on the selected item. This is a way to navigate around hypertext-like documents, e.g. Help, Internet documents. Similar function offers command ”Display window text” in ”Virtual Window”.

Menu items: The list contains names of all menu commands in active application. Selecting item and confirming with Enter key menu command is executed.

Brief Description of Basic Functions

a) Information about active item and active window: ”Information about item” (Ctrl+F2) and ”Information about window” (Ctrl+F3).

b) Window detail exploration: ”Window content to Virtual window” (Ctrl+Shift+F5) – reads contents of active window (all texts and items) and places them into WinTalker ”Virtual window”. The ”Virtual window” then contains objects and items from active window user needs. When reading the contents of active window by means of ”Virtual window” it is possible to ask for detail information on selected item and pressing Enter key simulate mouse click on item. 

c) Reading clipboard content: Function ”Read clipboard contents” (F11) reads contents of clipboard and then it is possible to show it in ”Virtual window”.

d) Item speaking: Function ”Item speaking” (Ctrl+Shift+F12). It is possible to choose if added comment (additional speaking) will be pronounced before or after item value or instead of the item. WinTalker has also an option ”Additional information” (Ctrl+F5), which can be used to add comment to any item. This comment is read only when function ”Additional information” is executed. 

e) Mouse click simulation: ”Setting the mouse click position” (Ctrl+Shift+F7) – WinTalker writes down current mouse position in active window. It is possible to redo mouse click on this position later by selecting it from ”Item Manager” (Ctrl+Shift+F6). Mouse click selection is just after the selection of the point in the list – it means it is not necessary to click more than it is necessary. Accessible places are also shown in ”Virtual window” when user places such a window into the ”Virtual window” with function ”Window content to Virtual window”. It is possible to make mouse click from the window on selected place.

f) Repeat last message: ”Repeat last message” (Ctrl+Shift+F9) – simply speaks last message. It is possible to place the text of this message into ”Virtual window”.

g) Reading texts in dialog window: WinTalker user can read texts displayed in active window in ”Virtual window” after placing contents of active window into the ”Virtual window” using function ”Window content to Virtual window”. 

h) Setting voices and dictionaries. Allows to set voice volume, bass, intonation and type of response when reading in letter-by-letter mode.

Voice Output Support, Languages

WinTalker has embedded Czech (Slovak) voice output and it can also use English voice output if Microsoft Voice program is installed. It is possible to use other voice outputs if they comply with Microsoft Speech API. The Hungarian language version is also available.

Module 4: Internet: What It Is and How It Can Change Your Life

(Karolina and Victor Tsaran)

Introduction

Welcome! Here is another exciting chapter of this manual. It is exciting mainly because of its subject, the Internet. Even if you don't know what the Internet is all about and what this word actually means, you are bound to hear about it in the media, read about it in the newspapers, and watch it in action on the screens of countless numbers of computer users. If you don't have access to the Internet or you don't use it, it is almost certain that one of your friends does. And this is all because for the last several years the Internet has become more than just an excitement, but a part of our everyday life and activities. People explore the world on the Internet: read newspapers, listen to the radio, go shopping, play games, vote, marry, etc.

If you ever wanted to learn the Internet--or wished your students or children could make good use of this worldwide facility--but were afraid to ask others or never had the time to start, this chapter is for you. We will walk together from basic definitions to more complex things that have made the Internet what it is now. In particular, we will:

Define the word "Internet";

Find out how to access the Internet: about accessibility challenges and alternatives;

Learn what services are available on the Internet;

Learn how to use these services efficiently, and with which tools.

We will also look at the usefulness of the Internet for people with disabilities and how it can make their life more interesting and productive.

We hope that by the end of this chapter you will have no doubts--if you had any before--as to why the Internet should be given a high priority on your list of things to be accomplished.

What Is the Internet and Why Internet?

You'd be surprised to learn how many people don't know what the Internet is, even though they use it on everyday basis! They really don’t need to be aware of its structure and history if all they care about is its capabilities and usage. You might decide to join them after reading this chapter, which would be of no harm to anyone, but initial knowledge about the Internet's development will not hurt either. 

Internet is an abbreviation of two words: "international" and "network.” This implies a world-wide network of computers, located in various points of our globe and connected by all possible means of communication: wires, satellite connections and even radio waves. You might think of the Internet as a largely enhanced network of telephones or television stations. Say, if you wanted to talk to someone in Argentina who sits in front of the computer and knows how to work on the Internet, you might as well talk to him through the microphone and he would hear you almost instantaneously on the other end of the wire. We know it sounds almost unbelievable, but ask your grandparents how they felt when the telephone was introduced!

Of course, you can imagine that it took scientists many years to bring the Internet to its current state of development, and things were much different just 30 years ago. At that time networks were mostly built for and used by military institutions and scientific laboratories. When they began to feel that networks didn't fully satisfy their needs and requirements, the access to these networks was opened to more people, not necessarily those coming from military or scientific environments. Thus, in the midst of the 1980s, a new miracle called Internet was born and began to grow with mile-long steps.

What Can We Do on the Internet?

In recent years the Internet has constantly been growing, and with its growth the range of topics it covers also has widened. A person coming from any educational background or having any specific type of interest can find something for themselves there. It is literally impossible to describe all the areas which can currently be found on the Internet because they are so diverse that a single individual would not be capable of naming them all, but we'd like to give you some specific examples of what you might find useful on the Internet.

If you are a student in primary or secondary school, college or university, you might like to have a look at various guides, which may be useful in writing papers or solving mathematical problems. In addition, there is a vast number of texts in the electronic format. The texts are mostly in the English language; they are books from the nineteenth and earlier centuries and they are available free of charge in many university libraries, special-interest organizations, etc. Their electronic format enables many disabled individuals to access them easily: it is much faster to copy the whole book to your computer, rather than wait up to a couple of months for the book to be Brailled, enlarged or recorded on tape. Moreover, while a text on cassette is treated as a whole, with the computer you can underline, copy, paste or cut various parts of the text, once it is downloaded.

Apart from numerous guides and an increasing number of e-texts (a short form of electronic texts), students can join discussion groups where they can meet peers. Such a linkage may provide support for students who experience any kind of problem connected with studying. It may also be a place to ask questions on a given subject: something you did not understand in class or something that you want to learn more about.

If you are a teacher, the Internet can be as useful for you as for anyone else. The Internet is a place that can keep you updated on any kind of new technology used in the classroom and any new ways of presenting the material to students. Various conferences are announced on the Internet now, and in order to participate in them you can often complete a form provided on the related web-site. In case you cannot attend the conference of a special interest to you, you can still find many papers presented there after the conference is over.

Since the age of students vary, the approach to various materials differs as well. Like the guides for students, there are numerous guides for professionals who teach at various levels of the educational system, and have to address various individual students' needs, e.g. their disabilities. There are already designed curricula available on the Internet, which may contain useful information about specific age groups or individuals with special needs. Moreover, as in the case of students, the teachers can join electronic discussion groups or forums where they can exchange information in their particular fields with their colleagues from around the world.

When we decided to divide Internet users between students and teachers it was only for the purpose of narrowing down our description of specific resources available on the Internet. But we realize that every student, and even every teacher, would be interested to do something else other than studying or teaching. Thus here are some other things you can do on the Internet.

There are numerous stores in cyber-space now. You can buy books, CD's, toys, clothes or even, in some places, you can order your grocery products to be delivered to your home overnight. The products sold at the "cyber-stores" look especially attractive because, apart from irresistible descriptions, most of them are accompanied by colorful pictures or even made into sound samples, like CDs or videos. Shopping on the Internet has been gaining popularity, and no wonder--anyone who sits in front of a computer with a modem, no matter if he's in a wheelchair, using a speech synthesizer, or simply prefers to sit at one place and buy products from around the world--can enjoy "cyber-shopping.”

Exchanging information either via e-mail or special interest groups is another activity which anyone can enjoy. Knowing someone who has access to e-mail, or being able to decide which list that meets your interests you'd like to join, is the only condition you have to meet. In addition to the exchange of information, there are also places where you can do research for various books and articles. Some of them will be available in the e-text format; others will be found in specific libraries which will be displayed if they contain the item you're looking for.

There is one more important thing you can do on the Internet: a growing number of universities offer so-called on-line courses, which means that students don't have to attend regular classes, but do their homework at a convenient time and send it at the appointed deadline over the e-mail. There are even so-called virtual universities, where all the classes are happening on-line, so no matter where you live, you can earn a degree and never really see your professors and classmates. The on-line education is becoming increasingly popular. The question remains whether it can replace a regular classroom environment.  For an answer we will have to wait until the time when the Internet will become a part of everyday life for every single individual.

How Can We Make Use of All These Goodies of the Internet?

Terms such as Electronic Mail, the World Wide Web, or electronic archives may sound like parts of the most horrible definitions that have to be learnt by heart, promptly written on an exam paper and then forgotten. Yet, the reality is that once you learn these terms you'll never forget them, firstly because they're so simple and secondly because you'll use them very frequently. See for yourself!

Email

This term is actually made up of two words: "electronic" and "mail.” Electronic mail is analogous to snail mail, with the only difference that it is not the mailman but a certain Internet service that sends and delivers mail to you. In reality, you need to have a mailbox where your letters are delivered. On the Internet, your mailbox is called an Email Account. It is a little more convenient to have an email account rather than just a mailbox, since it allows you not only to receive your email but also reply or forward it to other people who have email accounts. In reality, you wouldn't be able to send a letter from your own mailbox.

Setting up your own e-mail account is also much easier than constructing a real mailbox. There are two ways you get your e-mail account. One of the ways is to find an Internet Service Provider (an organization that provides various Internet services) and ask them to give you an e-mail account. They will set up everything for you and give you all further instructions. The Internet Service Providers will charge you for their services. Alternatively, nowadays many colleges and universities provide students with email accounts which are usually free of charge.

Another way to set up an email account is to get it for free at various Internet-based companies, like yahoo.com, hotmail.com, etc. All you have to do is fill out a simple request form and the rest will be set up for you automatically. In order to fill out these forms, you must go to the World Wide Web. Please read on to find out what it is all about.

Discussion Lists

There are thousands of discussion lists (discussion groups) on the Internet. They vary in size (there can be a thousand members or simply two or three people), as well as in discussed topics. The lists are a very useful means of exchanging information or offering advice and support in a particular area of interest.

It is important to remember that the list members are not restricted by physical boundaries, but drawn together by common interests. Thus, very often a discussion is led in the English language. Moreover, people come from different cultural, religious and educational backgrounds, so if you become a member of such a discussion group, you should form your thoughts in such a way as not to offend anyone, and be understood by your peers.

Now that you know what a list is, you should keep in mind that before joining one, you should consider subscribing only to the lists most suitable for you. Since there are thousands of lists, you need to narrow your focus of interest as much as possible. If you would have a very specific question about mobility training techniques, for instance, you could not post it to the list which deals with access technology for visually impaired people. There are numerous lists dedicated to vision-related issues, but the range of topics they cover doesn't necessarily have to cover in detail the issues of your interest. It would prove more useful to find lists that discuss issues of mobility training for the visually impaired in particular. But even then, you need to make sure you read a description of all the similar lists since the range of issues they cover can also vary. The mobility training lists, for instance, may also be dedicated for beginners or more advanced users. If you are impatient, just ask your friend or your local agency that deals with services for the visually impaired. By the way, it is very easy to become a list member: all you will have to do is send an e-mail to the list and you'll get an automatic e-mail in response giving you instructions with further steps you need to take. Usually you would be asked to reply to the e-mail message.

WWW

The three WWWs are abbreviations of the World Wide Web. Imagine it as a place with millions of houses connected to each other, no matter where their geographical location. Now, let's call each house a web-site to understand the concept of the worldwide web as a network of web-sites located world-wide.

A web-site can be created and owned by any individual who wants to present his hobbies/ interests to others, or simply introduce himself to the WWW community. Web-sites owned by private individuals can be compared to private homes, which are all personalized and different from each other. These are often called personal homepages. Apart from private web-sites, there are web-sites owned by governments, embassies, NGO's, publishing houses, etc. These web-sites, like buildings where these agencies might be located, provide various kinds of official information related to their specific activities.

In order to get to a particular web-site, it is necessary to type its address. After all, all real houses in any location in the world have their addresses as well, with the only difference that the classification of web-site addresses is easier to remember, especially because of their ending. Please, refer to the table below.

Ending
Example
Type of Web-site

COM
www.yahoo.com
a company

EDU
www.princeton.edu
EDUcation - colleges, universities

ORG
www.redcross.org
an ORGanization

GOV
www.usa.gov
GOVernmental

These four major endings of web-site addresses are useful in determining what type of place you want to go to. Once you remember those endings, you will see that most of Internet web-sites have easy-to-remember addresses, so that it is easy to locate them.

If a web-site is located in another country other than the United States, then its WWW address might be appended with a two-letter abbreviation of that country. For example, .sk would stand for Slovakia, .cz for Czech Republic and .hu for Hungary.

From the examples of addresses given in the table, you can also see that most web-site addresses begin with "www,” an indication that the address you want to find is on the World Wide Web. Then, after a dot, there is the name of a web-site, followed by a dot, and one of the four endings described above and/or two-letter country abbreviation.

Once you’ve opened the web-site you want to visit, e.g. www.yahoo.com, in your WWW browser, you have to spend some time to understand its structure in order not to get lost or overwhelmed by the information you find there. Imagine that every web-site, like every private home or an office building, has a hall, a place where you enter it, and many rooms designed for their specific functions, e.g. living room, bed room, etc. The advantage of a web-site is that upon entrance you can immediately see all the rooms it contains (i.e. through a table of contents), whereas a real home or building would be too spacious to allow that.

Thus when you enter Yahoo, you can see right away its various "rooms" which have inscriptions of subjects that you can find inside them, such as "Health,” "Education,” "Countries,” "Entertainment,” "History,” etc.

Once you decide to go to one of these categories, "entertainment” for instance, you'll see another set of "rooms” leading you to various more specific categories, such as "movies,” "theaters,” "musicals,” etc. If you decide to go to any of these places, you'll again have to decide where to go so that in the end you will find information on a specific topic, e.g. not only “entertainment,” and not only “movies,”  but French movies of 1950s.

Now that you've understood the structure of a web-site, you are ready to explore the web by yourself. But wait, the Internet has invented a tool called Search Engine, which is supposed to make your searching on the Internet much easier and more precise.

Search Engines

Naturally, it is easy to get lost in such a vast amount of information, especially if you are a newcomer and have never used anything similar before. And because it was very natural for people to get lost at the beginning, some smart programmers came up with the idea of a search engine, a program that would allow anyone to search the whole Internet by just asking the program certain questions and getting instantaneous answers. In order not to sound too theoretical, we will give you a short scenario of how the search engine works.

Say, you decided to find some materials about EENAT. You open the Yahoo search engine at www.yahoo.com. You look through the page and see that there is an edit field into which you can type in the text. Type "EENAT" and press ENTER key or click on "search" button, which is next to the edit field. In several seconds the search engine returns you at least 12 pages, all in one way or another relevant to the term "EENAT.” We just tried that and received the number of pages mentioned above. The first one was a web-site of the Slovak Union for the Blind and the second one of Overbrook School for the Blind, both of which contain materials related to the activities of EENAT.

Keep in mind that, even though the search engine seems to be intelligent enough, it will not differentiate EENAT as in Eastern European Network on Access Technology from another EENAT that accidentally happens to carry the same or similar name. So, if you didn't get a response that you expected, try entering another query with more meaningful terms. As you get more advanced with the Internet, you might try using the "advanced search" feature of a search engine, which usually allows you to specify more complex queries involving such expressions as "EENAT but not Eastern European Network."

You probably think, hmmm, how is it possible to search the whole Internet in a couple of seconds? You are right, it is not possible, even with the best advancements in current technology. Search engines do not really peruse the multitude of web-sites on the Internet in order to satisfy your request. Instead, the search engine has a huge database of web pages from various web-sites and simply searches this database, rather than contacting each web-site separately. Now that you know how to search the Internet, you can, in fact, find more information on specific search engines by yourself!

Presently there are more than 10 very extensive search engines available, not considering the local ones that serve only certain communities. In your country there might be a search engine that understands your native language and the interaction won't be possible in any other tongue.

In the era of globalization (economical as well as social), knowledge of the English language is becoming crucial. However, the role of other foreign languages cannot be neglected either. This is why many grand search engines, like Altavista, Yahoo, Lycos and Hotbot, have their counterparts in other countries of the world.

If you asked us which search engine is better and which is worse, we would not be able to answer the question at all. The reason is pretty trivial, but very obvious--it all depends on your taste, access capabilities and needs. Nothing can stop you from using various search engines for various occasions. Quite frequently, search engines introduce new features that enhance their searching capabilities. So, go on searching!

How to Access Internet?

Well, so much for talk about the Internet, but how do you access it? To be able to get on the Internet, you don't really need to know much about computers and how they work, although again, having such knowledge would only benefit you.

The first thing you need to look for is an Internet service provider (ISP), a service in your local area that will provide you with an Internet access and even necessary software. You will be given an Email address and perhaps even a possibility to set up your personal homepage. And, of course, you will need a computer with a modem, a device that will connect your computer with the Internet through the telephone line, and a telephone itself. To read Email, you will need an Email reader, a program that can retrieve and send your Email messages off and to the Internet. You will also need a web browser, such as Netscape or Internet Explorer, to browse the WWW.

There are a few quite popular Email readers that you can choose from. Eudora, a commercial software; Pegasus Mail; Netscape Messenger and Outlook Express, which are parts of Netscape Communicator and Internet Explorer, respectively. Outlook Express proves to be the most accessible service for people with disabilities, and it’s easy to use for people with no disabilities.

What If I Use Access Technology and Want to Use Internet?

In the previous sections of this chapter we were constantly emphasizing the importance of the Internet for people with disabilities.

This is especially true for individuals who have problems reading printed text. Even though a lot was printed in Braille, most of the books are either outdated or are in very small numbers. There is an ongoing attempt to supplement Braille literature with audiotexts, like these recorded on tapes in the libraries of the blind around the world. Even with these methods visually impaired people are usually behind in terms of the current literature or up-to-date information. The Internet has introduced a new way of looking at the reading process for people unable to read print. This not only includes the availability of electronic texts on various topics, electronic magazines and newspapers, but also the flexibility of working with these texts. If you downloaded a book or simply went on the Internet to read a newspaper, you most likely would be given the possibility to search a file in your beloved editor, as in the first case, or search through the articles of the newspaper's issue as well as browsing inside the article itself.

In order to perform these things, one needs several pieces of access technology and a regular computer with an already-existing connection to the Internet. The access technology pieces we have in mind are screen reading software and speech synthesizer. Depending on your resources and the speed of the computer, you will have to decide whether you will be using the Internet in a graphical environment or a text-only environment.

Usually, the graphical interface is available in MS-Windows and text-only interface, either under DOS or Unix. Unfortunately, graphical interfaces of other known operating systems are inaccessible because no screen reading software has been written for these systems. Thus, we will concentrate only on the choices accessible for people with an inability to read print.

The simplest and probably the least challenging is the text-only interface, provided by either DOS or Unix. We will not concentrate much attention on Internet access under DOS because setting such an interface will require more than just a knowledge of DOS, but also a knowledge of scripting languages, the ones that will allow you to automate your connection procedures.

In order to be able to use text-only mode of Unix, you will have to either have a Unix-based system set up at home or your working place or to be able to access your Internet provider's Unix-based machine through your modem. It is the second choice we will want to attract your attention to. Again, a home or work-based Unix system will require an individual with print difficulties to spend some time learning a new operating system before he can even get to the Internet part.

Prior to the use of the Internet on the Unix-based machine, you will have to obtain some information from your Internet service provider, i.e.:

Telephone number to dial;

Your login (user) name;

Your password;

Perhaps some additional related instructions.

Once you dialled in, typed in your username and password, you will be presented with a system prompt, which may look different depending on your ISP's machine configuration. In any case, if you didn't get any error messages, such as "Invalid login" or "System is unavailable", then you should be up and running.

The browser you are going to use - remember? We've talked about them earlier in the chapter - is called "Lynx". Lynx is the browser that will allow you to browse the World Wide Web in a text-only mode, which implies absence of any graphical information as well as audio options. While this might seem not very productive, given the state of modern technological achievements, it will get you started and, most important, introduce you to less frustrations than if you would start with the graphical interface directly. Your Internet Service Provider will be able to provide you with further instructions on Lynx's usage: don't be afraid to bombard them with questions.

If you happen to have a fast computer, a good Windows screen reading software and a fast Internet access (28.8 modem or higher), then you might jump into graphical environment right away. This will save you a lot of time and give you an access to all "bells and whistles" of the Internet, such as audio, video and animation. If you are a low vision person, colorful pictures or large fonts can make your browsing more pleasant and productive. On the other hand, audio can be both attractive and useful for people with print difficulties in general. Of course, make sure that your screen reading software provides you with a satisfactory access to the WWW browser of your choice.

For example, Microsoft introduced a new technology called Microsoft Active Accessibility, recognized by many MS-Windows screen readers nowadays, which allows a visually impaired user to reformat any WWW page into an easy-readable text, where all the controls of the web-page, such as hyperlinks, edit fields, or radio buttons are accessible and reachable with a single keystroke. Please remember that if your screen reading program does not provide good access to the WWW browsers, you'd better be off with the first choice of text-only mode. This will save you a lot of time and hours of frustration.

Caviats
We realize that just by reading this chapter you will not find answers to all the questions you had in your mind. Yet this is one of the reasons we encourage you to start exploring vast capabilities of the Internet. Remember that the first and most important thing is to provide a comfortable and stable connection to the Internet for your child, student or yourself. Once you set up your computer for Internet connection, you can come back to this chapter and start applying the parts of it that you mostly care about, to your Internet experience.

To be logical, you might first want to establish an Email account and exchange several Email messages with your friends or colleagues. Once this is working, then WWW will be ready for you to explore. If you are lost completely, ask your friends by Email or join the discussion group of your interest.

We all started this way some time ago. We made it through, and so can you! It is a high time to begin utilizing what the technology of the 21st century has to offer.
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Module 5: Design of Accessible Web Pages and Access
to WWW Using Internet Explorer with JAWS for Windows

(Martina Kobolková)

Introduction

The material in this chapter is intended as a handbook for trainers of the blind, who are preparing courses on “Designing Accessible Web Pages,” as well as for web designers, who wish to make their pages more accessible to readers – including those who are blind and visually impaired. A basic knowledge of Windows environment with JAWS screen reader is recommended before working in this section.

We begin with a brief introduction to World Wide Web (www) terminology and JAWS screen reader features. If you are interested only in web design, information about JAWS can help you to understand the kinds of needs that visually impaired readers of your web pages may have. Why do we think so? 

It is not easy to talk about accessibility without prior knowledge of the techniques that blind people use to read web pages. A combination of IE (Internet Explorer 5) and JAWS (JAWS for Windows 3.31) can be a good start in gaining this knowledge. Even though using this software improves the readability of web pages, you need to keep in mind the users of text-based browsers. Many HTML elements can be confusing for all groups of readers.

The HTML (HyperText Markup Language 4.0) section follows. We have tried to illustrate the logical structure of HTML documents. This is why we have chosen a combination of selected HTML elements descriptions and corresponding features of WYSIWYG HTML editor Front Page Express (FPE). Although they represent two different techniques, knowledge of both can be an advantage. 

The information offered here is neither a list of HTML tags nor an index of FPE keyboard shortcuts and menu items, which are only abbreviated forms of this material. The content and structure of this chapter was customized after the training course in Bratislava in December 1999. We attempted to update it based on the participants’ reactions. Keyboard shortcuts were moved to an appendix. Material concerning HTML was divided into two parts: browsing section and web design. In discussing the HTML elements of the web design section, we prepared a home page of a virtual creation – Judy (folder Judy).

The chapter consists of the following sections:

1. Basic concepts of www;

2. Brief introduction to JAWS screen reader;

3. Navigating pages in IE (general – text and hyperlinks; detail – frames and forms);

4. The question of accessibility, validation possibilities (this part could be the first one for “designers” or the last one for “surfers”); and

5. HTML elements and FPE with an emphasis on web page accessibility.

Thanks to the guidance of Mr. Branislav Mamojka, Mrs. Ludmila Jašková and Mrs. Zuzana Kubincová, this handbook has become a reality.

I. BASIC CONCEPTS

A. Internet Terminology
WWW

These three letters denote one of the most popular Internet services. The World Wide Web is a collection of HyperText documents called “web pages” or “web sites.” People create their own home pages and place them on the servers for public viewing. The World Wide Web allows users to jump from one document to another through HyperLinks. When the user activates the link within a document, he is presented with a related (linked) document. 

Web Browser

A web browser is an integrated tool that can provide access to HyperText documents, newsgroups, and FTP archives. Some browsers are text-based, and others have graphical interface. The vast majority of documents available through the Web contain embedded graphics and sounds. Some elements on web pages could be ignored by text-based browsers, resulting in the loss of information.

URL

The task of finding the linked document is done behind the scenes, thanks to Uniform Resource Locator (URL). Every Internet resource could be described as “service://server/directory pass.” 

Example: http://www.unss.skError! Reference source not found.
HTML

HyperText Markup Language (HTML) is the predominant language used to create World Wide Web pages. In the release HTML 4.0, several accessibility features were added (e.g.: attribute for long description of tables, images, and frames – “longdesc”). 

HTML Document

A HyperText document is a collection of HTML elements. Usually it consists of text, graphics, sounds, scripts, etc. To create an HTML Document, you can use a special HTML Editor (e.g. Hot Dog Express ), HTML Editor as a part of “WWW ToolKit” (e.g. Netscape Composer), Text Processor with format conversion (e.g. Word), or simple Text Editor (e.g. Notepad). 

Save As in Word

You can simply create a Word document and save it as an HTML file. Go to the Menu bar, open File menu and choose Save As... dialog. Then move to the Save as type: combo box and select Web Page type (HTML Document in Word 97). Then press ENTER.

HyperText Documents could have one of two different extensions: HTM or HTML. The shorter one is dedicated to platforms that don’t support long file names (e.g. DOS). Never mind which one you will prefer, but don’t forget that you can’t mix them.

Example: If the URL is http://www.unss.sk/english/eenat/INDEX.HTML you can’t use

http://www.unss.sk/english/eenat/INDEX.HTM instead. Error message will appear. Reversal is possible in IE 5.

HTTP, Web Server, Client and User Agent

The Hypertext Transfer Protocol (HTTP) is an application-level protocol for distributed, collaborative, hypermedia information systems. Simply put,  HTTP describes the communication between the Web Server and the User Agent. 

User Agent is the client, which initiates a request. These are often browsers or editors.

Web Client is an application program that establishes connections for the purpose of sending requests.

Web Server is an application program that accepts connections in order to process requests by sending back responses.

B. JAWS for Windows 3.3
JAWS for Windows (Job Access with Speech) is a Screen Reader Software operating in Windows NT 4.0, Windows 2000 Professional, Windows 98 and Windows 95. 

JAWS for Windows includes an enhanced "Eloquence for JFW" software speech synthesizer speaking in seven different languages (U.S. English, British English, German, Italian, French, Castilian Spanish and Latin Spanish), as well as the Microsoft text-to-speech engine. It can use your sound card as well as a special synthesizer (e.g. Apollo 2).

JAWS uses standard Windows keyboard commands – standard reading keys, predefined scripts and special modes. 0
PC Cursor and JAWS Cursor

Windows uses several different tools to indicate where on the screen the computer focus is directed. 

The PC Cursor represents the insertion point and the selection cursor. Press the MINUS KEY to activate the JAWS Cursor. JAWS announces, “JAWS Cursor.” This cursor moves when you are typing or using standard reading keys.

The JAWS Cursor represents the mouse pointer. Press the PLUS KEY to activate the PC Cursor. JFW announces, “PC Cursor.” This cursor is not affected when you type.

With JAWS Cursor, you can review the screen in different ways:

Automatically  -- INSERT+DOWN ARROW to read the entire screen from the JAWS Cursor position to the bottom, right-hand corner of the screen;
By element -- press CTRL+RIGHT ARROW and CTRL+LEFT ARROW to move from one element to another;

Line by line -- press the UP and DOWN ARROW keys;

Character by character  -- press RIGHT ARROW or LEFT ARROW.

JFW Settings

Switch to the JAWS window INSERT+J (it is also possible to use ALT+TAB). 

Go to the Menu Bar - Utilities menu - Configuration Manager. In Configuration Manager window open the browseui.jcf file. Then go to the Menu Bar - Set Options menu and choose Advanced settings dialog. 

In this dialog, Use Virtual PC cursor check box should be checked. While this dialog is unchecked, you can browse, as in IE 4.01. It is also recommended that you use the default JFW settings:

Verbosity: Beginner

NumLock: Switch off

For more details, see the JAWS help documentation.

II. INTERNET EXPLORER 5 WITH JAWS 3.3 FOR WINDOWS

A. Recommended Settings
The following settings are recommended for comfortable browsing with JAWS:

Colors
Make sure that “Ignore colors specified on Web pages” is checked. Tools menu - Internet Options dialog - General Tab – Accessibility... dialog. 

You can set color of Text, Background, Visited links, Unvisited links, whether you want to use Windows colors for text and background and hover color for links (when mouse is over). Tools menu - Internet Options dialog - General Tab –Colors... dialog. 

Text Properties

You can select one of five predefined font sizes, which will be used as a base size. Go to the View menu – Text Size submenu. Here you can choose among the following items: Largest, Larger, Medium, Smaller and Smallest.

You can set more accessibility options in Tools menu - Internet Options dialog - General Tab – Accessibility... dialog:
 Ignore font styles specified on Web pages check box

 Ignore font sizes specified on Web pages check box

 Format document using my style sheet check box

Toolbars

If you want to use IE 5 toolbar, you should include text labels on the buttons first. Go to the Menu bar - View menu - Tools submenu and check Text Labels.

Don’t forget that only visible buttons could be used (not all Tool Bar buttons). To add or remove a toolbar or buttons, use View menu – Toolbars submenu. You can select or deselect (ENTER) the following toolbars: Standard buttons, Address bar, Links, Radio. Another way to customize toolbars is to use Customize... dialog.

Advanced Options

Several advanced options should be checked. Go to the Menu bar – Tools menu – Internet Options dialog – Advanced Tab.
Under the Accessibility section the following should be checked:

 Move system caret with focus/selection changes.

 Always expand alt text for images.

Under the Browsing section the following should be unchecked:

 Show channel bar at start-up.

 Show friendly URLs.

 Use smooth scrolling.

 Enable page transitions.

While browsing web pages, you can use JAWS special keystrokes and the following navigation modes:

1. Virtual PC Cursor Mode

2. Conventional Mode

3. Forms Mode (press ENTER or NUM PAD SLASH from virtual PC cursor mode).

JAWS Virtual PC Cursor Mode

This mode is activated automatically when you open IE 5 (default JAWS setting), and JAWS begins speaking the text on the screen as soon as the page downloading is finished. It responds to normal reading keys in the same way as in other applications, but there is no visual indication of the area of the screen currently being read. To bring up text, which is out of screen range,  press INSERT+ESC (refreshing the screen and updating the state of information of the Off Screen Model) or use scroll bars.

CTRL+HOME brings the top of the document into view on the visual screen.

PAGE DOWN (UP) moves down(up) 24 lines.

You can read by characters, words, lines, sentences, and paragraphs as well.

JAWS Conventional Mode 
This mode works like in IE 4.01 with its reformatting options and JAWS cursor and PC Cursor, when the Virtual PC cursor is OFF.

Note: Use INSERT+Z to toggle temporarily between Virtual PC cursor Mode ON and OFF.

Following keystrokes are only available in non-virtual cursor mode:

INSERT+F5

reformat document

CTRL+INSERT+DOWN ARROW
read the body of the page with the JAWS cursor

CTRL+PAGE DOWN

read the next screen

CTRL+PAGE UP

read the prior screen

B. Application Window
Note: We assume that the Virtual PC cursor is ON and you can review the screen with standard reading keys.

IE 5 window is very similar to other application windows. It consists of the:

 Title Bar (INSERT+T), a horizontal bar below the window's top border, between the Control-menu box (ALT+Space) in the top, left-hand corner and the Resize Buttons (INSERT+END) in the top, right-hand corner of the window;

Tip: INSERT+T reads only the Window Title, INSERT+END reads also Resize and Close Buttons.

 Menu Bar (ALT), a horizontal bar below the title bar. It lists all IE 5 menus: File, Edit, View, Favorites, Tools and Help;

Tip: An underlined letter is a short key for activating the menu item.

 Toolbars (INSERT+F8): Standard Buttons, Address Bar, Links, Radio, Customize...;

Tip: Three dots “...”denote that the item is a dialog box.

 Explorer Bar is available from View menu: Search, Favorites, History, Folders, Tip of the day;

 Status Bar (INSERT+PAGE DOWN) is a horizontal bar at the bottom of the application window. It lists status information such as: status of task (connecting to site, opening page, done), URL of focused link, indicator of working offline, etc. 

The remainder of the window belongs to the active document.

Note: Keystrokes containing INSERT+ belong to JAWS

C. Opening Pages
After opening the IE 5 window, the home page is loaded. It is an HTML document and its address (URL) is specified in Tools menu – Internet Options dialog – General Tab.
To open a different page, choose one of the following ways:

Follow the focused link (press Enter when the Virtual PC cursor is over, or PC Cursor is on)

Type its URL into the Open Dialog (CTRL+O) available from File menu and press Enter

Move to the Address bar (ALT+D or INSERT+A twice quickly), type its URL and press Enter

Tip: Press CTRL+DOWN ARROW to open the Address combo box, then select URL and press Enter.

It is also possible to open the current page in a new Window (CTRL+N or File menu – New submenu – Window item). To close it, press CTRL+W or go to the File menu – Close item.

D.  Navigating Pages in General
Moving within the Current Page
When a new page is opened, you can hear a number of links (every digit is read separately).

Virtual PC Cursor mode:

1. You can use standard reading keys to read by characters (left and right arrow), words (Ctrl+left or right arrow),... and you can hear “link” or “visited link,”
 when the current item is a link. 

2. You can press INSERT+F7 to open JAWS Links List Dialog to:

Move to Link or

Activate Link

Display radio buttons group (to customize which type of links will be displayed):

All links

Visited links only

Unvisited links

Sort links radio buttons group (to customize the links order):

In Tab Order

Alphabetically

Conventional mode:

Note: To temporarily toggle between Virtual PC Cursor Mode and Conventional Mode, press INSERT+Z.

3. You can move between links with TAB and SHIFT+TAB (as thoough JAWS were not running).

Tip: Press INSERT+TAB to read selected link once more in Conventional Mode.

Moving between Pages (Documents)

While you are moving between pages, the sequence of links is built. You can move to the previous link or to the next link in this sequence.

Navigation commands are enumerated in View menu: 

Go to submenu: 

Back ALT+LEFT ARROW (go back to the previous link); 

Forward ALT+RIGHT ARROW (go forward to the next link); 

Home page ALT+HOME (go to the Home Page).

Stop ESC (stop downloading);

Refresh F5 (reload active document).

Reading Text in Columns

In Conventional Mode, you can reformat the screen (INSERT+F5), to decolumnize the text. IE columns will be read one after another and the text will be more readable with speech.

E.  Navigating Pages in Detail
Frames

When the page with frames is opened, JAWS announces the frame count. 

You can select the frame from JAWS List of frames dialog. Press INSERT+F9 to open the dialog, move with ARROWS KEYS between items and press ENTER. JAWS begins to read selected frame.

Moving to the next frame with CTRL+TAB or moving to the previous frame with CTRL+SHIFT+ TAB is also possible. 

Note: You can work with a frame in the same way as with the whole page. Creating a shortcut, adding to the Favorites, Source view and some other items are available in Context menu (Application key or SHIFT+F10)

Forms Mode of JAWS 

This special mode is designed for completing forms. It works only in the Virtual PC Cursor Mode. With the Virtual PC cursor positioned on a form field, press ENTER or NUM PAD SLASH to turn Mode ON. As a result: 

if you are on a button, the button is pressed .

if you are on a radio button which is unchecked, the radio button is checked, or the other way around
if you are on an edit box, the PC cursor is placed on the top of the edit field

if you are on the combo box, the first item is selected
Tip: Use CTRL+INSERT+HOME to move to the first input field.

Use NUM PAD PLUS to exit Form Mode and turn the Virtual PC cursor Mode ON.

Using Clipboard

Use standard keyboard shortcuts to select a text in the Virtual PC cursor mode (Example: CTRL+SHIFT+RIGHT ARROW to select a word).

To work with clipboard, use standard application commands. You can find them in the Edit menu. IE 5 Edit menu is very similar to the other Windows applications’ Edit menus. It includes the following items: Cut (CTRL+X), Copy (CTRL+C), Paste (CTRL+V), Select All (CTRL+A) and Find (on This Page) dialog (CTRL+F).

Downloading Files

Even if you can use clipboard for moving selected texts to other applications, sometimes it is useful to download the entire HTML document. Especially for larger files, it is recommended to save them from File menu – Save As dialog. In this dialog, you can select

Save as type:

 Web page, Complete (htm, html -- also images and styles in separate folders); 

 Web Archive for email (mht); 

 Web Page, HTML only (htm, html); 

 Text file (txt-plain text).

Encoding , e.g. Central European (DOS), Central European (Windows),...

Printing Documents

Concerning printing, common features are only mentioned, but special features are described below.

Page Set-up... dialog in File menu - Paper Size, Paper Source, Header, Footer, Orientation, Margins and Printer dialog


Header and Footer:

&w
page title

&u
page address (URL)

&d or &D
date in short (&d) or long format (&D)

&t or &T
time in 12 (&t) or 24 hours format (&T)

&p or &P
current page number (&p) or total number of pages (&P)

&b or &b&b
right-aligned text (&b) or centered text (&b&b) follows (MISTAKE IN IE 5 HELP)

&&
single ampersand

Print...(CTRL+P) - Printer/File, Print range, Copies, Print frames, Print all linked documents, Print table of links)

Tip: Don’t forget that you can print selected text as well (Selection radio button in Print range group).

Printing Linked Documents
This option is useful for printing an entire web site (collection of linked web pages).

File menu - Print... dialog – following checkboxes:

Print all linked documents

Print table of links

Printing Documents with Frames

File menu - Print... dialog – radio buttons group Print frames:

As laid out on screen (the composition of page will be maintained)

Only the selected frame 

All frames individually (frames will be printed as separate documents)

Associated Programs

Tools menu – Internet Options dialog - Programs Tab:
HTML editor, E-mail, Internet call, Calendar, Contact list ... states which programs will be used automatically for additional Internet services (e.g. when the mailto link is activated, corresponding mailing software is opened).

Reset Web Settings... dialog
Internet Explorer should check to see whether it is the default browser check box 

Note: If checked, the IE 5 remains as a default browser, even if you install additional browsing software. If another program is registered as a default browser, it will ask whether you want to restore IE 5 as your default browser.

III. ACCESSIBILITY TO EVERYONE

Developers of web pages need to realize that users with many different perspectives will be using their work (for example, people with vision problems, those who are hard of hearing or deaf, people with motor skill disabilities, and so on.)

What does accessibility mean? “Accessibility means providing flexibility to accommodate the user’s needs and preferences. In an Internet context, accessibility is making computer technology and Internet resources useful to more people than would otherwise be the case.” 0
A. Validation Possibilities
To be sure that our web site is at least readable for disabled people, we can review its accessibility:

With automatic tools:

 Bobby Approved – http://www.cast.org/bobby

 W3C HTML Validator – http://validator.w3.org

 CSS validator, or

With human review:

 on a black-and-white monitor

 with a text only browser (such as Lynx http://lynx.browser.org)

 with a self-voicing browser (IBM Home Page Reader)

 with multiple graphic browsers with images, sounds, scripts, frames and applets turned

    off

 without mouse (using only the keyboard to navigate between pages)

 through yellow foil 

Bobby Approved 3.1

Bobby is an automatic tool for web page validation, based on w3c Accessibility Guidelines. It could be used:

As a web applet http://www.cast.org/bobby

As an application (installation file: installbobby.exe, 6376 KB is available on the CAST Homepage)

Bobby is a free application that will analyze web pages for their accessibility to people with disabilities. It will also find HTML compatibility problems that prevent pages from displaying correctly on different web browsers.

[image: image21.wmf]
You can place the Bobby Icon on your page, in case your page doesn’t convey accessibility errors. 

Starting the Accessibility Analysis

1. When you start Bobby, the input cursor is in the URL field towards the bottom of the screen. Type in a URL (e.g., http://www.unss.sk) to analyze a page on the web. To examine a local file, click the Browse button or type a file URL (e.g., file:/c:/docs/unss/index.html).

2. If you want Bobby to analyze multiple pages automatically, change the item that reads “Don't follow links” to one of the other options. Change the maximum link level if you would like  to limit the depth of links away from the origin.

3. Press the GO button.

Looking at the Results

To see the results of the accessibility analysis, even while Bobby is still analyzing pages:

Select a URL from the list and then press the Bobby Report button to get an accessibility report OR 

When Bobby has finished analyzing the pages for accessibility, press the Summary Report button to get an accessibility summary report for all pages tested during the session. 

Getting Help

For more detailed instructions on using Bobby, see the Bobby Frequently Asked Questions page by choosing “Bobby FAQ” from the Help menu or typing CTRL+H. Additional information is available on the CAST web site (http://www.cast.org/bobby/). 

IV. HTML AND FRONTPAGE EXPRESS WITH JAWS FOR WINDOWS

A. About FrontPage Editor
Front Page Editor version 2 (FPE in following text) allows you to create a web page, even if you don’t know anything about HTML. Using this editor is very similar to using text editor in Microsoft Word 97. This method is called WYSIWYG- What You See Is What You Get. It’s also possible to check HTML source of the Page in View menu - HTML...dialog

Tip: You can always find “selection sensitive” properties... dialog in the Edit menu                                                 (ALT+ENTER). As an example, if no selection is made, Font Properties... dialog is available.

Application Window

FPE’s window consists of a Title bar, Menu bar, Tool bars, Status bar in the bottom of the window and the Desktop as in many other standard Windows applications. 

B. Simple HTML Elements
The simplified version of an HTML Document would look like:

<HTML>

<HEAD>

<TITLE>My first HTML document</TITLE>

</HEAD>

<BODY>

Hello everybody!

</BODY>

</HTML>

The entries inside the < > markers are called “tags” and are the primary HTML markup tool.

<HTML> identifies the file as an HTML document. </HTML> at the bottom of the document, marks the end. A “/” in front of most tags means the end of an element.

After <HTML> is <HEAD> which contains header information that is not displayed in the document window. It is displayed in the application’s Title bar. </HEAD> marks the end of the header information.

Information between <BODY> and </BODY> is displayed in the document’s window.

Container tags

A container tag has an opening <TAG> and a closing </TAG>

Example:

<P> ... </P> 
Paragraph is a container tag.
<HR> 
Horizontal Line is not a container tag.

Comments

Browsers ignore text written in comments, unless it has a special meaning. (e.g.: when defining styles, writing scripts,...)

<!--
beginning of the comment

-->>
end of the comment

Header information

The document’s title should describe its content briefly. The title is used when creating a shortcut to the document, adding a page to Favorites (Favorites – Add to favorites ... dialog in IE), saving a page, etc.

<TITLE> </TITLE>
title of the document will be displayed in the Title bar

Example: <TITLE> July’s Home Page </TITLE>

In FPE: File menu - Page Properties dialog - General Tab - Title: edit field
Body

Parameters: BACKGROUND, BGCOLOR, TEXT, LEFTMARGIN, TOPMARGIN, BGPROPERTIES

<BODY bgcolor=”Maroon”> ... </BODY>

Color Values:

Color Name (Black, Aqua, Blue, Fuchsia, Gray, Green, Lime, Navy, Olive, Purple, Maroon, Red, Silver, Teal, White and Yellow)

Hexadecimal number “#redgreenblue” for example “#008000” is green

In FPE: File menu - Page Properties dialog - Background Tab and Margins Tab

Tip: If you are defining background color, always define both colors – for both text and background. When one of these is missing, it can give birth to black text on a black background. Be careful when choosing color combinations.

Headings
Headings are used to convey a document’s structure. They are put on a separate line. You must indicate the end of the heading.

<Hx> Heading x </Hx> where x is a number from 1 to 6

Parameter: ALIGN 

Value: left (default), right, center, justify

In FPE: Go to the line with text, press CTRL+SHIFT+S to access Style combo box, select “Heading 1” and press ENTER (like in Word). Another possibility is to open Paragraph... dialog from Format menu.
Paragraphs and line breaks

The browser will automatically reformat paragraphs depending on line length settings, so you must indicate line breaks (hard returns) and paragraphs. A paragraph break is typically represented as a blank line while a line break simply moves to a new line.

<BR> 
is a line break 

</P> 
is the end of the paragraph
In FPE: Insert menu – Break... dialog

<NOBR> Unbreakable line. </NOBR> 
<P>This is a paragraph</P>

In FPE: ENTER ends the paragraph and creates the new one with &nbsp; (see part Special Characters)

Parameter: ALIGN

Values: CENTER, LEFT, RIGHT

<DIV> Part of the document <BR> with common alignment </DIV>

<Q> “This is short quotation!” </Q>
<BLOCKQUOTE> ”Quoted text is indented from both left and right margins.” </BLOCKQUOTE>

Font
<FONT> text with defined style follows...</FONT>

Parameters: FACE, SIZE, COLOR

SIZE values: absolute (number of points), relative (to BASEFONT)

<FONT FACE=”Verdana, Arial” SIZE=”12” COLOR=”Fuchsia”> Text </FONT>

<BASEFONT SIZE=n> n could be a number from 1 to 7

<FONT FACE=”Arial” SIZE=+1 COLOR=”Fuchsia”> Text .</FONT>

Related Elements:

<B> bold text </B> and <STRONG></STRONG>

<I> italic text </I> and <EM></EM>

<U> underlined text </U>

<STRIKE> this text has strike through </STRIKE>

<SMALL>like text with SIZE=-1</SMALL>

<BIG> like text with SIZE=+1</BIG>

<SUB>inferior index</SUB>

<SUP> upper index </SUP>

<CODE> text with fixed width, often used to represent computer information. </CODE>

<PRE> Preformatted text is drawn as you type with monospaced font. </PRE>

Note: Be careful when writing tags:

<SUB><I></SUB></I>
Overlapping tags
bad
<SUB><I></I></SUB>
Nested tags
good

In FPE: You can change font properties in Format menu – Font... dialog (ALT+ENTER). Don’t forget to select the text beforehand.
Tip: DON’T USE special styles like BLINK or TYPEWRITER. They have proven to be problematic for many readers.
Horizontal Line

This element is used to separate longer text information and to stress a new idea.

<HR>

Parameters: SIZE, WIDTH, ALIGN, NOSHADE, COLOR

SIZE Values: pixels

WIDTH Values: pixels or percent of the window

<HR SIZE=”5” WIDTH=”80%” COLOR=”#800040”>

In FPE: Available in Insert menu - Horizontal Line item. To change its style, select the HR and open Horizontal Line Properties... dialog in Edit menu (ALT+ENTER).
Lists

HTML supports several types of lists. An "unordered" list typically puts bullets in front of items. An "ordered" list typically uses numbers rather than bullets.

Unordered List

Parameters: TYPE, COMPACT (to display an item without spaces between words)

TYPE Values: SQUARE, DISC, CIRCLE.

<UL TYPE=DISC >


<LI> list item </LI>


<LI> list item </LI>

</UL>

Note: You can use e.g. MENU or DIR instead of UL. 

Ordered List

Properties: TYPE, START (not supported by all browsers)
TYPE Values: A, a, I, i, 1.

<OL TYPE=”a” START=”3”>


<LI> first list item with c. at the beginning </LI>


<LI> second list item with d. at the beginning </LI>

</OL>

Note: It is a good idea to put </LI> at the end of the line, but it is not always required.

In FPE: You can write the text first and change it to a list later, in Format Menu - Bullets and Numbering... dialog. Use CTRL+TAB to move between Bulleted, Numbered and Other pages; TAB to move between their types (JAWS is not speaking here); and ENTER to select one style. Move to the OK button, and press ENTER.

Other Types of Lists

You may have lists within lists (nested lists). Just be careful to end each list in the proper place.

<OL>

<LI>Ordered List Item 1 </LI>

<LI>Ordered List Item 2 

<UL>

<LI>Nested Unordered List Item 1 </LI>

<LI>Nested Unordered List Item 2 </LI>

</UL>

</LI>

<LI>Ordered List Item 3 </LI>

</OL>

Data Tables

Note: When designing tables, we can try different methods. First we can use FPE to design a table, and after each change we can check the HTML source.

In FPE: Table menu, where it is possible to:

Insert Table, then Rows, Columns, Cell, Caption;

Select Cell, Row, Column, Table;

Change properties of Caption, Cell or a whole Table.

Table 1:

<TABLE>

<CAPTION>Capital Cities</CAPTION>

<TR><TH>City:</TH><TH>Country:</TH></TR>

<TR><TD>Bratislava</TD><TD>Slovakia</TD></TR>

<TR><TD>Budapest</TD><TD>Hungary</TD></TR>

<TR><TD>Prague</TD><TD>Czech Republic</TD></TR>

</TABLE>

Possible problems:

While browsing a table, it is difficult to get the corresponding row and column header information associated with a particular data cell.

Tip: Use HTML 4.0 features to connect the cell to corresponding header information. The features are not included in FPE menus, but you can add them in HTML... dialog of View menu. How the properties of this table will be interpreted depends on Web Browser or Screen Reader. 

Table 2:

<TABLE>

<CAPTION>Capital Cities</CAPTION>

<TR>

<TH id="c1">City:</TH>

<TH id="c2">Country:</TH></TR>

<TR>

<TD headers="c1">Bratislava</TD>

<TD headers="c2">Slovakia</TD></TR>

<TR>

<TD headers="c1">Budapest</TD>

<TD headers="c2">Hungary</TD></TR>

<TR>

<TD headers="c1">Prague</TD>

<TD headers="c2">Czech Republic</TD></TR>

</TABLE>

Corresponding to HTML 4.0 specifications, a  logical table structure is stressed. The table could have heads, feet and bodies. 

Table 3:

<TABLE>

<THEAD>

<CAPTION>Capital Cities</CAPTION>

<TR><TH id="c1">City:</TH><TH id="c2">Country:</TH></TR>

</THEAD>

<TFOOT>

<TR><TD>Neither Cities, nor Countries are ordered by the number of inhabitants</TD></TR>

</TFOOT>

<TBODY>

<TR><TD headers="c1">Bratislava</TD><TD headers="c2">Slovakia</TD></TR>

<TR><TD headers="c1">Prague</TD><TD headers="c2">Czech Republic</TD></TR>

<TR><TD headers="c1">Budapest</TD><TD headers="c2">Hungary</TD></TR>

</TBODY>

<TBODY>

<TR><TD headers="c1">Stockholm</TD><TD headers="c2">Sweden</TD></TR>

</TBODY>

</TABLE>

New TD and TH Parameters: COLSPAN, ROWSPAN are used for spanning a data cell over adjacent cells in columns or rows.

Tip: TR, TBODY, THEAD, TFOOT end tags may always be safely omitted.

Table 4:

<TABLE>

<THEAD>

<CAPTION>Capital Cities</CAPTION>

<TR><TH id="c1">City:</TH><TH id="c2">Country:</TH><TH id="c3">Continent:</TH>

<TFOOT>

<TR><TD colspan=”3”>Neither Cities, nor Countries are ordered by the number of inhabitants</TD>

<TBODY>

<TR><TD headers="c1">Bratislava</TD><TD headers="c2">Slovakia</TD>

<TD headers="c3" rowspan=”3”>Europe</TD>

<TR><TD headers="c1">Prague</TD><TD headers="c2">Czech Republic</TD>

<TR><TD headers="c1">Budapest</TD><TD headers="c2">Hungary</TD>

</TABLE>

Note: You are reading an interpretation of HTML Code with Virtual PC cursor, and screen layout with JAWS cursor. Implementation of header information for cells is not as friendly as it should be. You cannot obtain corresponding row and column headings.
Adding HyperLinks

Until now we cannot say that we have created a useful HTML document. The most important part is still missing. The term "Hyper Text" indicates the ability to link one document to another or link to different sections in the same document. This is done by indicating "links" in the document and providing the address or reference to which it links.

Anchor Tag

<A 
indicates the start of a link

HREF 
gives the name of the document and then

> 
indicates the end of the address

 
The txt between tags will be highlighted as a link by the browser

</A> 
indicates the end of the words to be highlighted as a link

Link to another Document in the Same Directory

If the file is in the same directory on the same WWW server, it is enough to write down its name.

<A HREF="hobbies.html"> My hobbies </A>

Link to another Document on the Same Computer

When the document is in a subdirectory below the directory of the document, the link would appear as:

<A HREF="geography/capitals.html"> Capital cities in Europe </A>

Note: In directory path, FORWARD SLASHES are used instead of BACK SLASHES.

A link to a document in a directory above the one containing the current document might appear as:

<A HREF="../literature/novels.html"> My favorite novels </A>

Link to another Document on a Different Computer

If the document is on a totally different server, the entire address must be given:

<A HREF="http://www.unss.sk/english/index_en.htm">Slovak Blind and Partially Sighted Union </A>

Link within Current Document

You can link to a different point (called an "anchor or target") in the same document. 

Go to the anchor point and put in a name for it to find.

<A NAME=”Links”>About My favorite links</A>

When creating a link to this part of your page, put the # (HASH) in front of the anchor name when setting up the link.

<A HREF="#Links">My favorite links</A>

Note: Name is case sensitive.

Including E-mail Address

An e-mail address may be included as a link. If the user's browser is correctly set up, a click on the anchor will start a mail editor and allow mail to be sent to the address. The format of this element is:

<a href="mailto:martina_kobolkova@yahoo.com"> write to my web consultant</a>

Note: You may link to the ftp site by using FTP:// 

In FPE:
Keyboard shortcut CTRL+K opens Create Hyperlink Dialog. Then set the Hyperlink type to “mailto:” and fill the links URL.

Insert menu – Hyperlink... dialog – World Wide web Tab, Open Pages Tab, New Page Tab

Full Syntax:

<A HREF=”” NAME=”” TITLE=”” REL=”” REV=”” URN=”” METHODS=”” TARGET=””> Text for the link </A>

Access Key for the Link

<A ACCESSKEY="c" HREF="geography/capitals.html"> Capital cities in Europe </a>
After pressing “ALT+c”, link ”Capital cities in Europe” will be focused.

Tip: You can set an accesskey in Extended Attributes... dialog of Create Hyperlink dialog window. Press the Add button, write the Name: accesskey and the Value: c.
Background Sound

Note: The following Tag should be used only in the HEAD of the HTML document.

<BGSOUND LOOP=”2” SRC=”welcome.wav” TITLE=”Welcome sound”>

SRC 

is a source file (.wav, .au, .mid,...)

LOOP 
is the number of repetitions (loop=”infinite” corresponds to Forever checkbox in FPE)

TITLE 
is not displayed

In FPE: 

Insert menu – Background Sound... dialog to choose the background sound location (directory path or URL)

File menu – Page Properties... dialog to choose the background sound location (Background Sound Location edit field) and the number of repetitions (Loop edit field and Forever checkbox).

Images and Video

Images

<IMG SRC="approved.GIF" ALT="Bobby Approved Icon" ALIGN="BOTTOM">

<IMG> 
indicates a graphic image is to be displayed.

Parameters: SRC, ALIGN, WIDTH, HEIGHT, ALT, BORDER, HSPACE, VSPACE

SRC 
gives the name of the graphic to display (.gif, .jpg). Path information may be included if necessary.

  ALT 
provides a text description of the graphic (when you have graphics turned off).

  ALIGN 
indicates how the first line of text should align with the image (BOTTOM, TOP.         MIDDLE).

Note: Always expand ALT text for images.

In FPE: Describe Image Source file and Alternative representations – Text in Insert menu – Image... dialog – General Tab.
Image with dynamic source (video)

<IMG DYNSRC="Running_Cat.avi" LOOP=”infinite” CONTROLS ALT="Small Running Cat">

Parameters: DYNSRC, LOOP, CONTROLS, START, ALIGN, WIDTH, HEIGHT, ALT, BORDER, HSPACE, VSPACE

DYNSRC 
is a source file (animated gif, .avi)
LOOP  
is the number of repetitions (“infinite”=-1=all the time, 0=1=once)

CONTROLS
show control buttons for playing video

START
indicates when to start to play the video (on ”mouseover” or on “fileopen” - default setting)
Posting to the Web

It is strongly recommended that you use Web Publishing Wizard (File menu – Save... dialog) for posting your web site to the Web (save it on Web Server). You need to know its URL and password, if required.

Using FTP Client for data transfer between the local and remote computer is another possible way  to publish your Home Page.

C. Advanced HTML Elements
Special Characters

&lt; 
for <

&gt; 
for > 

&amp; 
for & 

&quot; 
for the double quotation mark. 

&nbsp; 
for “hard space”

Note: These entries are followed with a semicolon and are lower case.

Adding Frames

Frames appeared in Web Pages in 1996 and they caused a small revolution in web design. Nowadays they are slowly retreating. 

    Idea

The original idea was to divide one page into independent sub-pages (example: 

 navigation menus and previews of chosen items).

    Advantages

 Cleaner look 

 Easier to navigate with mouse

    Disadvantages

 Frames are not supported by widely used browsers.

 Frames are drawn after loading the whole document, not little by little like simple pages.

 Problems with saving HTML documents with frames.

 Problems with printing HTML documents with frames

     Adding Frames

Frames are defined within the HEAD of the HTML document:

Examples:

<HTML>

<HEAD>

<TITLE>A Master Page</TITLE>

</HEAD>

<FRAMESET COLS=”20%,*”>


<FRAME NAME=”page menu” SRC=”menu.html”>


<FRAME NAME=”page content” SRC=”main.html”>

<NOFRAMES> 

<BODY>Your browser doesn't support frames. But if you wish you can <A HREF="menu.html">take a look around</A> anyway.

</BODY>

<NOFRAMES>

</FRAMESET>

</HTML>

or

<HTML>

<HEAD>

<TITLE>A Master Page</TITLE>

</HEAD>

<FRAMESET ROWS="4*,*">


<FRAMESET COLS="25%,*">


<FRAME NAME="UpperLeft menu bar" SRC="menu.html">


<FRAME NAME="UpperRight main page" SRC="main.html">


</FRAMESET>

<FRAME NORESIZE NAME="Bottom address" SRC="address.html">

</FRAMESET>

</HTML>

FRAMESET Properties: COLS, ROWS.

ROWS Values:

In pixels,

Percentage,

* means whatever is left over,

3* means three times bigger than *.

FRAME Properties: FRAMEBORDER, MARGINHEIGHT MARGINWIDTH, NAME, SCROLLING, NORESIZE, FRAMESPACING, BORDERCOLOR.

SCROLLING Values: No, Yes, Auto as default value.

When adding links from menu.html to other documents, don’t forget to specify target frame in which the described document will be displayed.

<a href="hobbies.html" target="UpperRight main page">hobbies.html</a>

Floating frames

IFRAME eliminates some disadvantages of frames:

 You can define IFRAME anywhere in BODY section

 IFRAME is placed directly to the document at the place of definition (you don’t need FRAMESET)

 In the page it looks like an image with fixed size (usually in pixels)

Example:

<IFRAME HEIGHT=200 WIDTH=300 NORESIZE=RESIZE NAME=”Frame 1”>

IFRAME Parameters: ALIGN, BORDER, BORDERCOLOR, FRAMEBORDER, HEIGHT, WIDTH, NORESIZE, NAME.

Forms on Web Pages

Note: We will use the same method as we used with TABLES. We will begin with FPE.

Insert menu – Form Field submenu – following items:

One-Line Text Box

<INPUT TYPE=text SIZE=30 MAXLENGTH=50 NAME=”Surname”>

<INPUT TYPE=password NAME=”pass”>

Scrolling Text Box

<INPUT TYPE=textarea SIZE=”20,5” NAME=”area1”>

<INPUT TYPE=textarea ROWS=6 COLS=50 NAME=”area2” WRAP=VIRTUAL>

WRAP Values:

WRAP=VIRTUAL means that the text in the box wraps, but it is sent as one long continuous string.

WRAP=PHYSICAL means that the text in the box wraps, and it is sent that way as well.

WRAP=OFF means that the text in the box does not wrap, but it is sent exactly the way it was typed in.

<TEXTAREA NAME="COMMENTS" ROWS=15 COLS=65>

</TEXTAREA>

Note: If you type something between the TEXTAREA tags, it will show up in the window as the default "COMMENT.” It shows up EXACTLY the way you type it!

Check Box

<B>Which cities are not in Slovakia?</B>

<INPUT TYPE=check NAME=”ba” VALUE=”NO”>Bratislava<BR>

<INPUT TYPE=check NAME=”pr” VALUE=”NO”>Prague<BR>

<INPUT TYPE=check NAME=”bu” VALUE=”NO”>Budapest<BR>

Radio Button

Group of radio buttons must have the same name. Only one radio button from the group could be checked.

<B>Which city is the capital of Slovakia?</B>

<INPUT TYPE=radio NAME=”Capital City” VALUE=”bu”>Budapest<BR>

<INPUT TYPE=radio NAME=”Capital City” VALUE=”ba”>Bratislava<BR>

<INPUT TYPE=radio NAME=”Capital City” VALUE=”pr”>Prague<BR>

Drop-Down Menu (scrolling list)

<B>Which city is the biggest one?</B>

<SELECT NAME=biggest SIZE=3>


<OPTION VALUE=”bu”> Budapest


<OPTION VALUE=”ba”> Bratislava


<OPTION VALUE=”pr” SELECTED> Prague


<OPTION VALUE=”lo”> London

</SELECT>

Note: If parameter SELECTED is not used, the default option is the one listed first.

Push Button
<INPUT TYPE=button NAME= TITLE=>

<INPUT TYPE=SUBMIT VALUE="Send it away!"><BR>

<INPUT TYPE=RESET VALUE="Clear the form!"><BR>

Examples of Making Forms Alive

POST Method

<FORM METHOD=POST ACTION=mailto:unss@unss.sk ENCTYPE="application/x-www-form-urlencoded">

...

</FORM>

JavaScript

JavaScript is a scripting language whose development and syntax have been influenced by object-based technology. JavaScript is an interpreted language, meaning that it is not run through a compiler. There are two places you might find JavaScript: 

Client-side -- for example, scripts run from within a browser 

Server-side -- scripts which execute on the server end

Cascading Style Sheets

Style sheets are groups of styles, which in turn are groups of properties that define how an HTML element appears in a Web browser. For instance, green, italic, and Arial. You can define styles either within an HTML document or in an external file attached to the HTML document. As an external file, a single style sheet can affect multiple pages, even a whole site. This makes page-wide or site-wide changes much easier to implement.

Basic style features

CSS could specify the style of all <H3> tags by defining SELECTOR:

h3 { font-family: Arial; font-style: italic; color: green }

Styles within the Head of the Document

<HTML>

<HEAD>

<STYLE type="text/css">

<!--

H3 { font-family: Arial; font-style: italic; color: green }

-->

</STYLE>

</HEAD>

<BODY>

<H3>This is a green, italic, Arial H3 header.</H3>

<P>and

<H3>so is this.</H3>

</P>

</BODY>

</HTML> 

Note: The comment tags nested inside the <STYLE> tags ensure that the styles won't cause errors in older browsers. Any browser that doesn't support the <STYLE> tag will simply ignore the information inside. 

Adding the Style Attribute to the HTML Tag

You can also define styles in the body of the document by adding the style attribute to an HTML tag. For instance, the following HTML code makes the first <H3> text (the one with the style attribute) green, italic, and Arial, but not the second: 

<HTML>

<BODY>

<H3 style="font-family: Arial; font-style: italic; color: green">This is a green, italic, Arial H3 header.</H3>

<P>and

<H3>This is an H3 header, but it's not green, italic, or Arial.</H3>

</P>

</BODY>

</HTML> 

In most cases, this method defeats the purpose of using style sheets as global templates.

Linking to an External Style Sheet

When you want to use the same styles for several pages, create an external style sheet and link to it from your HTML document.

<LINK rel="stylesheet" type="text/css" href="style3.css" title="style3">


File called style3.css contains just this text: 

H3 { font-family: Arial; font-style: italic; color: green }


HTML document style3.htm contains a <LINK> tag that calls the style sheet in the document's head: 

<HTML>

<HEAD>

<LINK rel="stylesheet" type="text/css" href="style3.css" title="style3">

</HEAD> 

The <LINK> tag's attributes tell the browser to find an external style sheet, that the style sheet is a CSS file, and that the name of that file is style3.css. 

The file style3.css defines the styles in style3.htm, so every <H3> tag you use later in the HTML document will have the green, italic, Arial style defined in style3.css.
Importing an External Style Sheet (problems in IE 4.0)

You can also merge an external style sheet into an HTML document with the CSS @import feature: 

<HEAD>

<STYLE type="text/css">

<!--

@import url(style4.css);

-->

</STYLE>

</HEAD> 

The @import command works much like the <LINK> tag, although the syntax is a little different.

Combination of forementioned techniques

A linked style sheet can help you maintain a consistent look and feel throughout your Web site. But if you want a certain page to have additional styles, you can also include styles in the head of that particular HTML document.

Note: More than one style sheet can be used on the same document, with different levels of importance. If you define conflicting styles for the same HTML tag, the innermost definition (the one closest to the tag) wins.

Advanced Style Features

Style definition is a combination of a property and its value, separated by colon. To include multiple properties in the same definition, simply separate them with semicolons:

H3 { font-family: Arial; font-style: italic; color: green }

To define more than one value for a single property, just add them on, separated by commas:

H3 { font-family: Arial, Helvetica, sans-serif;

font-style: italic;

color: green }

Defining New Classes and IDs

CLASS

Any HTML tag can be a selector, but you can define a new class as well, by giving it a name, always preceded by a period. You can use defined class with any HTML tag within the document to apply style, without limiting the tag itself to a particular style.

.bmaroon {font-style: italic; color: maroon}

<STRONG class=”bmaroon”> This is bold italic maroon text. <STRONG>

ID

IDs are used in basically the same way, except that they are preceded by a number sign (#) instead of a period: 

            #bright { font-weight: bolder; color: #00ff00 } 

Add it to an HTML tag like so: 

<P id="bright">This text is hard to read.</P> 

Contextual Selectors

STRONG EM { color: red } 

This kind of selector is called a contextual selector, because text coded with the <EM> tag will be colored red only in the context of the <STRONG> tag; in other words, when nested inside it: 

<STRONG>This is bold text, and <EM> this is bold, italic red </EM></STRONG>

<EM>This text is just italic.</EM>

Grouping Selectors

You can also group selectors that share styles to reduce the size and redundancy of a style sheet. Just separate them with commas:

H1, STRONG EM, TD { font-family: Arial; color: blue; }

Additional Formatting

If you want to give one of the selectors additional formatting, simply define it again:

H1 { font-style: italic }

Shorthand in the Style Definition

You can also use shorthand in the style definition itself; for instance: 

EM {font: 12pt/14pt bolder Arial, Helvetica}

is shorthand for 

EM {font-family: Arial, Helvetica; font-size: 12pt; line-height: 14pt; font-weight: bolder}

Anchor Pseudoclasses
Pseudoclasses can also extend CSS to include properties of tags that are not part of the HTML specification but that are supported by the browsers. For instance, the <ANCHOR> tag does not have link, active, or visited attributes, but the browsers support different colors for links depending on their state. You can define <ANCHOR> pseudoclasses using the color character:

A:unvisited {color: red}

A:visited {color: blue}

A:active {color: maroon} 

This step colors unvisited links red, visited links blue, and active links (those being clicked) maroon.

What Wasn’t Mentioned before?

Structure of the HTML Document

An HTML 4.0 document is composed of three parts:

1. A line containing HTML version information,

 HTML 4.0 specifies three Document Type Definitions (DTD), so authors must include one of the following document type declarations in their documents. The DTDs vary in the elements they support. 0
Strict DTD:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0//EN"

"http://www.w3.org/TR/REC-html40/strict.dtd">

Transitional DTD = strict DTD plus deprecated elements:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN"

"http://www.w3.org/TR/REC-html40/loose.dtd">

Frameset DTD = transitional DTD plus frames:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Frameset//EN"

"http://www.w3.org/TR/REC-html40/frameset.dtd">

2.
A declarative header section (delimited by the HEAD element),

3.
A body, which contains the document's actual content. 


The body may be implemented by the BODY element or the FRAMESET element. 

Header Information

<META> description, keywords, reply-to and other information used by Search Engines

Parameters: NAME, HTTP-EQUIV, CONTENT

User Variables:

<META NAME=AUTHOR CONTENT=”Martina Kobolkova”>

<META NAME=DESCRIPTION CONTENT=”Basic Information about Martina Kobolkova”>

<META NAME=KEYWORDS CONTENT=”Slovakia, Bratislava, support, blind”>

<META NAME=VERSION CONTENT=”15/12/1999”>

System Variables:

<META HTTP-EQUIV="Content-Type" CONTENT="text/html; charset=iso-8859-1”>

<META HTTP-EQUIV=EXPIRES CONTENT=”24/12/2001”>

<META HTTP-EQUIV=REPLY-TO CONTENT=”martina_kobolkova@yahoo.com”>

In FPE: File menu - Page Properties dialog - Custom Tab - System Variables and User Variables
<BASE> describes the basic directory path. Using base tag: 

<BASE href=”http://www.unss.sk/course/martina/”>

<bgsound src=”chimes.wav” loop=”2”>

The directory path for the file “cat.gif” will be interpreted as “http://www.unss.sk/course/martina/chimes.wav”

In FPE: File menu - Page Properties dialog - General Tab - Base Location: edit field
<SCRIPT></SCRIPT>
script definition 

<STYLE></STYLE>
definition of font styles 

Languages

Why describe the languages used on web pages?

Assisting search engines 

Assisting speech synthesizers 

Helping a user agent to select writing variants for high quality typography 

Helping a user agent to choose a set of quotation marks

Helping a user agent to make decisions about hyphenation, ligatures, and spacing 

Assisting spell checkers and grammar checkers

Example:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN"

"http://www.w3.org/TR/html4/strict.dtd">

<HTML lang="en">

<HEAD>


<TITLE>More than one language</TITLE>

</HEAD>

<BODY>

Interpreted as English...
<P lang="es">Interpreted as Spanish...

<P>Interpreted as English again...
<P> English text interrupted by<EM lang="ja">some

Japanese</EM> English begins here again...
</BODY>

</HTML>

Two-letter language codes include fr (French), de (German), it (Italian), nl (Dutch), el (Greek), es (Spanish), pt (Portuguese), ar (Arabic), he (Hebrew), ru (Russian), zh (Chinese), ja (Japanese), hi (Hindi), ur (Urdu), and sa (Sanskrit).

V. APPENDIX

D. JFW 3.3 Keystrokes
Note: You can obtain the same information from  JAWS Help.

The following keystrokes are useful in general:

INSERT+F1
screen sensitive help (Where am I? What can I do now?)

INSERT+H
JAWS hot key help for active application

INSERT+W
standard application keyboard hot keys

NUM PAD 5
read word in context (access keys for menu item)

JAWS commands associated with the IE 5:
INSERT+A 
read the address bar without moving focus

INSERT+A twice quickly 
move the JAWS cursor to the address bar

INSERT+ESC
refresh screen and update the Off Screen Model

INSERT+TAB
state selected link

INSERT+F7
select a link

INSERT+ENTER
move to the next block of non-linked text larger than 50 characters

INSERT+F8
access the list of visible Tool Bar buttons

INSERT+F9
select a frame

INSERT+Z
toggle between the Virtual PC Cursor Mode ON and OFF; when in the web document it toggles between the Conventional mode and the Virtual PC Cursor Mode interface

JAWS commands associated with the FPE:

CTRL+INSERT+DOWN ARROW
read current screen

INSERT+DELETE

state the line

INSERT+F8

access the list of visible Tool Bar buttons

INSERT+TAB

state window prompt and text

Note: The Context menu accessed by the Applications key does not apply to the Virtual cursor.

E. IE 5 Keyboard Shortcuts
It is possible to navigate through web sites by using the keyboard. To do so, you can combine the use of menu bar commands and standard IE 5 shortcut keys.

Note: You can obtain the same information from IE 5 Help. Go to the Menu bar, choose Help menu, Contents and Index submenu, Index Tab. Write the word “short” into the edit field “Type in the keyword to find”… Press TAB key to move to the list box with help index. Select shortcut keys topic and press ENTER or TAB (to move to Display button) followed by ENTER to display selected Help Topic.

TAB

next link

SHIFT+TAB

prior/previous link

ENTER

activate a selected link

CTRL+TAB or F6

next frame

CTRL+SHIFT+TAB

prior/previous frame

ALT+LEFT ARROW or BACKSPACE
go back

ALT+RIGHT ARROW

go forward

ALT+HOME

go to the Home page

F5 or CTRL+R

refresh the current web page

ESC

stop downloading the page

CTRL+O or CTRL+L

go to the new location

CTRL+E

open Search in Explorer bar

CTRL+I

open Favorites in Explorer bar

CTRL+H

open History in Explorer bar

CTRL+F

find

CTRL+S

save the current page

CTRL+P

print the current page

CTRL+N

open a new window

CTRL+W

close the current window

The following keystrokes may be useful while using Address bar:

ALT+D
select the text in the Address bar

F4
display the Address bar history

CTRL+LEFT ARROW
move the cursor left to the next logical break (. or /)

CTRL+RIGHT ARROW
move the cursor right to the next logical break (. or /)

CTRL+ENTER
add “www.” to the beginning and “.com” to the end of the typed text

UP ARROW
move forward through the list of AutoComplete matches

DOWN ARROW
move back through the list of AutoComplete matches

The following keystrokes may be useful while working with Favorites:

CTRL+D
add the current page to the favorites

CTRL+B
open the Organize Favorites dialog box

ALT+UP ARROW
move selected item up in the Favorites list

ALT+DOWN ARROW
move selected item down in the Favorites list

F. FrontPage Keyboard Shortcuts
ALT+ENTER
edit properties of selected item (also available throw Edit menu)

CTRL+K
insert a hyperlink

ALT+O
OK button in the HTML View

ALT+C
Cancel button in the HTML View

ALT+S
Show color coding Check box in the HTML View

ALT+I
Original radio button in the HTML View

CTRL+TAB
to switch between open pages

F6 or SHIFT+F6
to switch between frames

G.  Accessibility Guidelines
Text


Keep layouts and the interface similar from page to page, and make sure all the important navigation elements stay consistent in their placement.


Don't limit the window size of your pages. Many viewers use large monitors or alternative Internet appliances and technologies to improve visibility. 


Large areas of white space and small blocks of text increase readability.

Provide context and orientation information to help users understand complex pages and elements (title each frame, divide large blocks of information,...)


Avoid using several types of fonts mixed together or very narrow or decorative fonts.


Avoid the use of multi-column presentation or tables (several screen access programs are beginning to be able to decolumnize certain properly-coded HTML pages).

Avoid ASCII art; replace it with an image and alternative text.

Avoid italic, underlined text and text written in capitals, as it is difficult for some partially sighted people to read these.

Standard size text is preferable -- not too large or too small because visitors to your site can adjust the text size to suit their needs (by altering their browser settings).

Don't use any coding in HTML that will limit a user's ability to set his or her own font, font size or colors.


If you are using an unordered list, add number of items at the beginning of list.


Don't use HR tag, an image of the line with text is better.


Use LANG attribute


<html lang="fr">


<p lang="es"> ... <em lang="ja"> ... </em> ...</p>


Use ABBR and ACRONYM elements; provide their expansions


<abbr title="Idaho"> ID </abbr>


<acronym title="World Wide Web"> WWW </acronym>


Don't use PRE to create tabular layout of text; use tables.


o create larger text, use Style Sheets; use H1, H2,... H6 headers to convey document structure.


Don't use BLOCKQUOTE element to indent a paragraph that is not a quotation.


Create a logical tab order through links, form controls and objects (TABINDEX attribute).

Tables

Use tables to mark up truly tabular information, so called "data tables,” not to "layout” pages, unless the table makes sense when linearized.


Identify headers for rows and columns (TD and TH).


Where tables have structural divisions beyond those implicit in the rows and columns, use appropriate markup to identify those divisions (THEAD, TFOOT, TBODY; COL, COLGROUP; AXIS, SCOPE HEADER).


Don't use TH element for "non-table header" cell to be displayed centered and in bold


Use abbreviations for header labels (via the "abbr" attribute on TH).


Provide summaries for tables ("summary" attribute) or use the LONGDESC attribute to link to the description or data.


In all tables that lay out text in parallel, word-wrapped columns require a linear text alternative (on the current page or some other).

Links

Include enough words in the link so that it can stand alone (don't use "click here,” "this,” "click this,” "go,”...


Clearly identify the target of each link; choose meaningful words or phrases for links.


Adjacent links should be separated (not only with carriage return, use text or graphic).


Keep links underlined so screen readers can recognize them, and do not underline text that is not a link.


Add keyboard shortcuts to important links (LABEL, A , CAPTION, LEGEND)


<A accesskey="e" href="english.html"> ... </a>


Consider including internal links within longer pages so viewers can jump from section to section with a single click.


Regularly check all the links from your site to make sure they are current.

Auditory and Visual Content

Make all graphical links and buttons large and easy to click on.


Provide text equivalents for non-text content (images, symbols, image map regions, animations, applets, ASCII art, frames, scripts, images used as list bullets, spacers, graphical buttons, sounds, stand-alone audio files, video, ...)


<img ... alt="..." ...>


Use alt="" for visuals that do not convey important information.


Don't rely on color alone.

Using background patterns or floating text over images is distracting and makes the page much more difficult, if not impossible, to read for many viewers.


Ensure that foreground and background color combinations provide sufficient contrast (color combinations such as brown on tan or green on gray are not good choices; avoid combinations of blue and yellow or red and green for viewers with certain types of color blindness).


Ensure that your chosen color scheme may be over-ridden by the browser setting if necessary. 


Ensure that moving, blinking, scrolling and auto-updating objects or pages may be paused or stopped (for some people with cognitive or visual disabilities). 


Provide client-side image maps to provide accessible text for image map hot spots; if you use server-side maps, provide equivalent text links.


Provide captions or transcripts of audio content.


Provide text or audio description of video content.


Use relative units rather than absolute units. 
<hr width="50%">

Frames

Provide a title for each frame so that users can track frames by title.


Don’t suppress frame scrolling; you can’t foresee which resolution, text size, fonts and other options the user will have.

General

Date stamping your pages when content is updated or edited lets viewers know how current your site or information is and increases their confidence in your content.


Setting up a search engine on your site will help users to “jump on” what they are looking for. 


Organize archives in a logical manner, by year or by topic, for example, and allow people to search by key words.

The ideal web site

is not the one which is attractive for a group of people, 

but the site on which everyone can visit 

and obtain the same amount of information.
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Module 6: Resources

(Vitas Purlys)

COMPANIES

1. Access Technology Evaluation Ceter (ATEC)
http://dors.state.il.us/atec/index.html

2. AccessAbility Company 
http://www.4access.com/

3. Ai Squared - Manufacturer of Zoomtext screen magnification software 
http://www.aisquared.com/ai2home.htm 

4. Allied Technologies
http://www.alliedtec.com/

5. ALVA Dutch producer of assistive technology for the blind and visually impaired.
http://www.alva-bv.nl/home-eng.html

6. AmbuTech Canadian producer of canes for the visually impaired.
http://www.ambutech.mb.ca/

7. Arkenstone Homepage OCR - Scanners - Reading Systems
http://www.arkenstone.org/ 

8. Aroga Technologies
http://www.aroga.com/

9. Artic Technologies
http://www.artictech.com

10. Ash Technologies
http://www.ashtech.ie/

11. Bartimeus Group. The mission of Bartimaeus Group is to assess, market, train, and develop products for persons who are blind or visually impaired.
http://www.bartsite.com/

12. Baum Elektronik
http://www.baum.de/

13. Betacom Optics
http://www.betacom.com/optic.htm

14. Blazie Engineering - makers of Braille N Speak, Type N Speak, Braille Blazer, screen reading software and more.
http://blazie.com/ 

15. BLIND-DEV
http://www.cs.tcd.ie/blind-dev/

16. BLINUX Documentation and Development Project
http://leb.net/blinux/

17. Blista Brailletec German producer of assistive technology for the blind
http://www.Brailletec.de/home_en.htm

18. Bosma Industries for the Blind
http://www.bosma.org/

19. Bossert Specialties Magnification Center
http://www.bossertspecialties.com

20. BraiLab Talking Computers
http://www.kfki.hu/~mszkihp/info/RehTech/e_rehact.htm

21. Braille Displays
http://www.Braille.com/index.htm

22. Braille Jymico. Producer of Braille and raised graphics.
http://www.Braillejymico.qc.ca

23. Braille Shop
http://web.mountain.net/~wd8ldy/the_brl_shop/

24. Brea Technical Products. Development of a digital CCTV-system.
http://www.chycor.co.uk/breatech/index.htm

25. BRYTECH Inc 
http://www.brytech.com/

26. Brl Inc. Specialize in products that aid the disabled in educational, vocational and recreational pursuits.
http://www.wyfiwyg.com/

27. Closing The Gap
http://www.closingthegap.com

28. Computer Application Specialties Company
http://www.c-a-s.com

29. Computer Technology
http://www.ceismc.gatech.edu/busyt/comp.html

30. Control Advancement. Developer of a virtual mouse.
http://www.controladv.com

31. Convert-o-Braille Braille producer in Quebec, Canada.
http://www.converto.org/division/cob.htm

32. Currently Available Electronic Travel Aids for the Blind
http://www.noogenesis.com/eta/current.html

33. Custom Eyes Computer Systems
http://www.customeyes.com/

34. DAISY Consortium
http://www.daisy.org

35. Dancing Dots
http://www.netaxs.com/~ddots/

36. Dolphin Computer Access Limited
http://www.dolphinuk.co.uk/

37. Dotmaker's Home Page
http://www.azstarnet.com/~dotmakr/

38. DotsPlus
http://dots.physics.orst.edu/dotsplus.html

39. Duxbury Systems
http://www.duxburysystems.com/

40. Edmark, an IBM company of children's educational software.
http://www.edmark.com/

41. EyeDx Digital Vision Screening Systems
http://www.eyedx.com/index.html

42. Enabling Technologies Comp.
http://www.Brailler.com/

43. Enhanced Vision Systems
http://www.enhancedvision.com/

44. Equal Access to Software and Information (EASI)
http://www.rit.edu/~easi

45. Erica. A writing program for blind pupils.
http://www.pqs.org/provvvi/erica/inf_engl.htm

46. Eurisco Information Systems. Development of a Swiss Electronic Kiosk for the Blind.
http://www.e-link.ch/ic/index_e.html

47. euroBRAILLE
http://www.euroBraille.fr/indexuk.htm

48. Frank Audiodata. German producer of assistive technology.
http://www.audiodata.de/

49. GW Micro. Distributor of software and hardware solutions for the visually impaired.
http://www.gwmicro.com/

50. Henter-Joyce Inc.. JAWS for Windows 
http://www.hj.com

51. Elan Informatique. Multilingual Text-To-Speech, voice processing...
http://www.elan.fr/

52. HumanWare, Inc. specializes in access technology
http://www.humanware.com/Text/E/E.html

53. IBM products
http://www.austin.ibm.com/sns/products.htm

54. IntelliTools Inc. - Accessible Technology for Learning
http://www.intellitools.com/

55. Screen magnifiers homepage 
http://www.plex.nl/~pverhoe/main2.html

56. Sheppard Software - We make learning fun...
http://www.sheppardsoftware.com/?clicktrade=43030

WEB PAGES FOR TEACHERS AND PARENTS

1. Abacus - The Art of Calculation with Beads
http://www.ee.ryerson.ca:8080/~elf/abacus/

2. Action for Blind People
http://www.demon.co.uk/afbp/

3. AcuVision
http://www.acuvision.com/

4. ADA Information Center On-Line, Blind/Visually Impaired
http://www.hr.state.ks.us/dc/

5. Adaptive Technology Consulting
http://www.AdaptiveTech.net/

6. Adaptive Technology Resources
http://www.adaptivetr.com/

7. Alabama Institute for Deaf and Blind
http://www.talladega.com/aidb/aidbtext.html

8. Alliance for Technology Access
http://www.ataccess.org

9. Aloha Vision Technology
http://www.AlohaVision.com/

10. Alva Access Group
http://www.aagi.com

11. American Academy of Ophthalmology - Eyenet
http://www.eyenet.org/

12. American Association of the Deaf-Blind
http://www.tr.wosc.osshe.edu/dblink/aadb.htm

13. American Council for the Blind
http://www.acb.org/

14. American Foundation for the Blind
http://www.afb.org/afb/

15. American Journal of Ophthalmology On-line
http://www.ajo.com

16. American Printing House for the Blind
http://www.aph.org/

17. American Thermoform Corporation ATC. Swell-Form Graphics Machine & Swell-Touch Paper
http://www.atcbrleqp.com/
http://www.atcbrleqp.com/swell.htm

18. Andrew Heiskell Library for the Blind and Physically Handicapped
http://www.nypl.org/branch/central_units/lb/LB.html

19. Arizona Center for the Blind and Visually Impaired
http://www.goodnet.com/~acbvi/

20. Arizona State Schools for the Deaf and the Blind
http://www.azstarnet.com/~asdbhs/index.html

21. Arla Institute
http://www.arlainst.fi/english.htm

22. Art through Touch
http://members.aol.com/ATTouch/

23. ASCRS-ASOA
http://www.ascrs.org/

24. AskERIC is a personalized Internet-based service providing education information.
http://ericir.sunsite.syr.edu/

25. Aspire Consultancy to help visually impaired people
http://www.aspire.mcmail.com/

26. Assistanse is a nationwide Norwegian organization for parents of visually handicapped children.
http://www.assistanse.no/eindex.htm

27. Assistive and Adaptive Technology in Special Education
http://at-advocacy.phillynews.com 

28. Assistive Technology
http://www.viguide.com/techmain.htm

29. Assistive Technology Guide for Children with Learning Difficulties
http://www.schwablearning.org/html/resource/publications/assistive_tech.html 

30. Associated Blind
http://www.tabinc.org

31. Association for Early Intervention Early Intervention Centers
http://ms.anet.cz/~srpcuns/English.htm

32. Association for Education &amp; Rehabilitation of the Blind and Visually Impaired (AER)
http://www.aerbvi.org

33. Association for the Advancement of Assistive Technology in Europe (AAATE)
http://www.fernuni-hagen.de/FTB/AAATE.html

34. Association for the Blind
http://www.aftb.org.au

35. Association for the Blind and Visually Impaired
http://www.grcmc.org/blindser/

36. Baruch College Computer Center for Visually Impaired People
http://www.baruch.cuny.edu/ccvip/

37. Batten Disease Support &amp; Research Association
http://bdsra.org/

38. BC College and Institute Library Services (CILS)
http://www.langara.bc.ca/library/cils.html

39. BC Ministry of Education 
http://www.bced.gov.bc.ca/publications.htm
http://www.bced.gov.bc.ca/specialed/
http://www.bced.gov.bc.ca/specialed/visimpair/toc.htm

40. Beyond Sight
http://henge1.henge.com/~bsistore

41. Better Vision for Children Fondation (BVC)
http://www.webdesigners-sandiego.com/BVCpg.html

42. Bibles for the Blind and Visually Handicapped
http://Braille.indiana.net/Braille/

43. Blind Children's Learning Center
http://www.blindkids.org/

44. Blind Faith WEB Links
http://www.scis.nova.edu/~marston

45. Blind Leading the Blind Foundation
http://www.blb.org/

46. Blind Links
http://seidata.com/~marriage/rblind.html

47. Blind Mobility Research Unit (Nottingham)
http://www.psyc.nott.ac.uk/bmru/home.html

48. Blind Net. USEFUL and FACTUAL information about blindness and related issues. 
http://www.blind.net/blindind.htm

49. Blind Related Links 
http://www.seidata.com/~marriage/rblind.html 

50. Blind-L Archives for "Computer use by and for the blind.
http://www.sfc.keio.ac.jp/~f94303mn/handicap/index.cgi

51. Blindcare
http://www.btinternet.com/~blindcare/

52. Blindness Arena Information about blindness technology.
http://www.rnzfb.org.nz/jmosen/arblind.htm

53. BlindRing Listing
http://www.webring.org/cgi-bin/webring?ring=blind&list

54. Blindspots
http://www.vashti.net/blind/

55. BLIST: The Comprehensive Index of Blindness-Related Emailing Lists
http://www.hicom.net/~oedipus/blist.html

56. Bobby Analyzes web pages for their accessibility to people with disabilities as well as their compatibility with various browsers.
http://www.cast.org/bobby

57. Braille Guide
http://disserv.stu.umn.edu/AltForm/

58. Braille Institute
http://www.Brailleinstitute.org

59. Braille International
http://www.Brailleintl.org/

60. Braille Planet
http://www.Brailleplanet.org/

61. Braille Transcribing by Liz Gray Information about Braille codes and Braille transcription.
http://www.tusc.net:80/~lizgray/

62. BrailleNet "Better access to the WEB for blind and partially sighted people"
http://www.Braillenet.jussieu.fr/

63. Brighton Society for the Blind
http://www.bsblind.co.uk/

64. British Computing Association for the Blind - BCAB 
http://www.rnib.org.uk/bcab/brochure.htm 

65. British Educational Communications and Technology agency (BECTa)
http://www.becta.org.uk

66. British Retinitis Pigmentosa Society
http://www.brps.demon.co.uk/

67. British Telecom Guide for Disabled People
http://www.bt.com/community/aged_and_disabled

68. BRL: Braille through Remote Learning. Distance education about Braille.
http://www.shodor.org/Braille/

69. BrookesTalk
http://www.brookes.ac.uk/schools/cms/research/speech/btalk.htm

70. Bundes-Blindenerziehungsinstitut (Federal Institute for the Education of the Blind)
http://www.bbi.asn-wien.ac.at/bbi/english/

71. Busy Teachers' WebSite K-12
http://www.ceismc.gatech.edu/busyt/

72. California School for the Blind
http://home.earthlink.net/~brianmont/

73. California State University (Northridge) Center on Disabilities (CSUN)
http://www.csun.edu/cod/

74. California Transcribers &amp; Educators of the Visually Handicapped
http://edtech.sdcs.k12.ca.us/epd/ctevhhome.html

75. California's Special Education Assistive Technology Program
http://www.dds.cahwnet.gov/at009.htm 

76. Camera Obscura. About Internet resources on visual impairment.
http://www.hicom.net/~oedipus/index.html

77. Canadian Council of the Blind
http://www2.ebtech.net/~sarwcane/ccb.htm

78. Canadian National Institute for the Blind (CNIB)
http://www.cnib.org/

79. Carroll Center for the Blind
http://www.carroll.org

80. CECIAA
http://www.ceciaa.com/accueil_en.html

81. Center for Information Technology Accommodation (CITA)
http://www.gsa.gov/coca/

82. Cyber Blink. Documents and information on visual impairment.
http://www.realtime.net/~shaffer/cyberblink.html

83. College of Optometrist
http://www.college-optometrists.org

84. Columbia Lighthouse for the Blind
http://www.clb.org/

85. Columbia Visual Health &amp; Surgical Center. Information about eye conditions and diseases.
http://www.web-xpress.com/vhsc/index.html

86. Comenius University Support Centre for Visually Impaired Students (CEZAPP)
http://158.195.24.10/

87. Comfort Connection Family Resource Center
http://www.comfortconnection.org/

88. Connecticut Institute for the Blind/Oak Hill
http://www.ciboakhill.org/

89. COST 219 bis -Telecommunications Access for Disabled People and Elderly
http://www.stakes.fi/cost219/index.html

90. Council for Exceptional Children (CEC)
http://www.cec.sped.org

91. Council of Citizens with Low Vision International
http://www.cclvi.org/

92. Council of Parent Attorneys and Advocates (COPAA)
http://www.copaa.net

93. Council of Schools for the Blind (COSB)
http://www.tsbvi.edu/cosbnews/index.htm

94. CrissCross Technologies. Specialize in learning and training materials for computer users who are visually impaired.
http://www.crisscrosstech.com/

95. CSS Centre for the Blind and Visually Impaired
http://www.css-sl.si/en_index.htm

96. Czech Blind United
http://www.braillnet.cz/menueng.htm

97. Dallas Lighthouse for the Blind
http://dallaslighthouse.org

98. Danish Centre for Technical Aids for Rehabilitation and Education
http://www.hmi.dk/hmitg/profil.html

99. Deafblind Link. A lot of information about deafblindness.
http://www.s55wilma.demon.co.uk/index.html

100. Deafblindness Web Resources
http://www.eng.dmu.ac.uk/~hgs/deafblind/

101. Debbie Day Homepage
Resources for Parents & Teachers of Blind Kids
http://members.home.net/ddays/blindkids.html

102. Dennis Bartlett's Home Page
http://www.visi.com/~bartlett

103. Derbyshire Look Group. Information and links to parents of Visually Impaired Children. 
http://freespace.virgin.net/amanda.gibson/

104. Diabetic Retinopathy Foundation
http://retinopathy.org

105. Dialogue Magazine's Home Page
http://www.teleport.com/~blindskl/

106. Digital Journal of Ophthalmology
http://www.djo.harvard.edu/

107. Disabilities Information Resources
http://www.dinf.org/

108. Disability net - information for all sorts of disabilities.
http://www.disabilitynet.co.uk 

109. Disabled People's International (DPI)
http://www.dpi.org/

110. Distance Education Reference
http://www.russianstory.com/cdrom/icded96/links.htm

111. Do-It at the University of Washington
http://weber.u.washington.edu/~doit/

112. Dorton at a Distance - VITA
http://www.dorton-coll.ac.uk/

113. Dorton House School Access Technology Services
http://www.dorton.demon.co.uk

114. ED's Oasis MasterSearch lesson plan
http://edsoasis.org/Treasure/treasT.html

115. ED's Oasis Teachers' Guild Lesson Plan Library!
http://edsoasis.org/TGuild/Lessons/TGuildTOC.html

116. EdLaw
http://www.edlaw.net 

117. Education Development Center, Inc. 
NCIP Links that provide information, and resources relating to technology and students with disabilities
http://www2.edc.org/NCIP/links.htm

118. Educational Resources Information Center (ERIC)
http://www.aspensys.com/eric/index.html

119. EEI Adaptive
http://www.eeiadaptive.com/

120. Eye Cancer Network
http://www.eyecancer.com/

121. Eye Site
http://www.i-care.net/

122. EyeMax. Information resource for the Eyecare Professional.
http://www.eyemax.com/

123. Electronic Book: Teaching orientation and mobility to blind children
Institute for Innovative Blind Navigation
http://isd.saginaw.k12.mi.us/~mobility/refhome.htm

124. Empowerment Zone, the home page of Jamal Mazrui!
http://www.empowermentzone.com/

125. En-Vision America
http://www.envisionamerica.com/

126. ERIC Clearinghouse on Disabilities and Gifted Education
http://www.cec.sped.org/ericec.htm

127. ERIC Digest. Short reports (1,000 - 1,500 words) on topics of prime current interest in education.
http://www.ed.gov/databases/ERIC_Digests/index/

128. European Agency for Special Education Needs
http://www.european-agency.com

129. European Association for Vision and Eye Research (EVER)
http://www.ever.be

130. European Blind Union (EBU)
http://ourworld.compuserve.com/homepages/EBU_UEA/

131. European Disability Forum
http://www.edf.unicall.be/index.asp

132. European Distance Education Network
http://www.eden.bme.hu/ 

133. Exhall Grange School
http://www.campus.bt.com/CampusWorld/orgs/org9304/

134. Finnish Federation of the Visually Impaired
http://www.nkl.fi/ENGLISH/FFVIINTR.HTM

135. Florida School for the Deaf and the Blind
http://www.fsdb.k12.fl.us/about.index.html

136. Focus on the Visually Impaired
http://www.visuallyimpaired.com/

137. Focus On Vision
http://www.focusonvision.com/

138. Force Foundation
http://145.99.72.69:88/english/Links/links.htm

139. FORTEC Rehabilitation Technology, Vienna University of Technology
http://sun4.iaee.tuwien.ac.at/fortec

140. Foundation for Blind Children
http://the-fbc.org/index.html

141. Fund for the Blind
http://www.brailcom.cz/EN/

142. Games for Blind Children (Fabienne Viallet)
http://www.chez.com/viallet/blind/BLIND_AN.htm

143. Glaucoma Foundation
http://www.glaucoma-foundation.org

144. Global Applied Disability Research and Information Network (GLADNET)
http://www.gladnet.org/

145. Glossary of Ophthalmological Terms (Larry Bickford)
http://www.west.net/~eyecare/glossary.html

146. Guide Dog Foundation for the Blind
http://www.guidedog.org

147. Guide Dogs for the Blind Association (GDBA)
http://www.gdba.org.uk/

148. Hands and Eyes Newsletter 
ART AND LEARNING ACTIVITIES FOR STUDENTS WITH VISION IMPAIRMENTS 
http://home.earthlink.net/~vharris/links.html

149. Dixon, Judy, Favorite Sites. Many links on visual impairment.
http://www.concentric.net/~dixonjm/

150. Indiana School for the Blind
http://isb.butler.edu/school/

151. Information for professionals in visual disabilities
http://www.tiresias.org/

152. International Council for Distance Education
http://www.icde.org/Textindex.htm

153. Internet Resources for Parents
http://www.rit.edu/~easi/ak12/k12/k12parents.html

154. Iowa Department for the Blind, ASSIST With Windows!
http://www.blind.state.ia.us/assist/

155. Jaws for Windows user help group 
http://yoyo.cc.monash.edu.au/~nallan/jfw 

156. KerrLaw
http://www.KERRlaw.com 

157. LDOnline
http://www.ldonline.org 

158. Links on blindness and visual impairment.
http://www.ability.org.uk/blind.html

159. Links on vision and visual impairment. There are more than 900 links
http://home.swipnet.se/macula-lutea/countrylinks.htm

160. Lithuanian web page about Blind and VI
http://lass.osf.lt

161. Multimedia Enabling Technologies at the Open University
http://met.open.ac.uk/METHome.html
http://met.open.ac.uk/dis/indext.htm 

162. On line computing books
http://www.mcp.com 

163. Overbrook School for the Blind
http://www.obs.org/txtindex.htm

164. Queen Alexandra College of Further Education for blind and partially sighted students in Birmingham
http://www.q-a-c.demon.co.uk 

165. Recordings for the Blind and Dyslexic
http://www.rfbd.org 

166. REHACare International
International Trade Fair for Rehabilitation, Equipment and Care for the Disabled
http://www.mdna.com/shows/reha.html

167. RESNA Technical Assistance Project
http://www.resna.org 

168. RNC Related Links
http://www.rncb.ac.uk/links/

169. Rodney Peter page
http://www.dlh.dk/psyc/slu/syn/

170. Royal National Institute for the Blind - RNIB
http://www.rnib.org.uk 

171. Sensory Disabilities Research Unit - University of Hertfordshire 
http://phoenix.herts.ac.uk/SDRU/hmpage.html

172. Simon Ungar home page. Tactile Maps
http://www.lgu.ac.uk/psychology/ungar/
http://www.lgu.ac.uk/psychology/ungar/intact/tmc.html
http://www.lgu.ac.uk/psychology/ungar/intact/intactlinks.html

173. Society for Disability Studies Links
http://www.uic.edu/orgs/sds/links.html#general

174. Special Ed Advocate (WrightsLaw)
http://www.wrightslaw.com 

175. Special Education Technology - British Columbia
http://www.setbc.org/
Technology Guide to Assist Students with Visual Impairments in Meeting Curriculum Goals 
http://www.setbc.org/special/virg/

176. Special Educational Needs (Visually Impaired) 
http://www.dorton-coll.ac.uk/csen_students.html
Links to other sites of related interest.
http://www.dorton-coll.ac.uk/links.html

177. Special Needs and Distance Learning Network 
http://www.ndu.sih.se/public/english/index.htm

178. Special Needs Education Project 
http://www.schoolnet.ca/sne/e/blisites.html

179. SuperKids - The Parent's and Teacher's Guide to Educational Resources
http://www.superkids.com/

180. Tactile Access to Education for Visually Impaired Students
http://www.purdue.edu/odos/TAEVIS/

181. Technology as a Tool for Education and Communication. Aug Comm Website
http://www.lburkhart.com/ 

182. Texas School for the Blind and Visually Impaired
http://www.tsbvi.edu/Education/index.htm

TACTILE GRAPHIC AT APH WEB PAGE

1. http://www.aph.org

2. Basic Tactile Anatomy Atlas
http://www.aph.org/basictac.htm

3. Braille Paper, Binders, Notebooks, Dividers, and Mailers
http://www.aph.org/brlpaper.htm

4. Developmental Guidelines for Infants with Visual Impairment: A Manual for Early Intervention
http://www.aph.org/develgd.htm

5. FOCUS in Mathematics
http://www.aph.org/focusinm.htm

6. Geometry Tactile Graphics Kit
http://www.aph.org/geotact.htm

7. Good Tactile Graphic:
http://www.aph.org/goodtact.htm

8. Graph Sheets
http://www.aph.org/graphshe.htm

9. Map Study Programs I & II
http://www.aph.org/mapstudy.htm

10. Materials in the Bright Sights kit help to develop visual interest and efficiency in young children.
http://www.aph.org/brightsi.htm

11.  O& M Tactile Graphics
http://www.aph.org/o&mbclea.htm

12.  Tactile Graphics Starter Kit
http://www.aph.org/tgskbcle.htm

13.  Tactile Treasures: Math and Language Concepts for Young Children with Visual Impairments
http://www.aph.org/tacttres.htm

14.  The Braille Connection
http://www.aph.org/Braillec.htm

15.  This is a content-rich, adaptable curriculum for teachers, therapists, and parents of 
children from infancy to kindergarten.

http://www.aph.org/movetouc.htm
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